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Preface

This guide is for Oracle service personnel and authorized service partners who 
maintain Oracle’s StorageTek SL500 library. Most of the information pertains to library 
hardware. Refer to your tape drive or software documentation for specific drive 
information or for client-generated software commands and console messages.

Related Documentation 

The following list contains the names and order numbers of publications that provide 
additional information aboutthe SL500. 

The documentation is available online at: 

http://docs.sun.com/app/docs/prod/SL500 

and/or 

http://docs.sfbay.sun.com/app/docs/prod/SL500 

Function Title Part Number

SL500 Hardware Publications 

Installation Installation Manual 96114

Local Operator Panel Guide 96258

Principles of Operation 96156

User’s Guide 96116

Hardware Replaceable Parts Catalog 96120

Safety Regulatory and Safety 
Compliance Guides 

820-5506-xx  
816-7190-12 

http://docs.sun.com/app/docs/prod/SL500 
http://docs.sfbay.sun.com/app/docs/prod/SL500
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Documentation, Support, and Training 

                                          Tape Drive Hardware Publications

Hewlett Packard Ultrium tape 
drive information

Available on HP Web site

International Business Machines 
(IBM) Ultrium tape drive 
information

Available on IBM Web site

Quantum tape drive information Available from Quantum 
Corporation

Software Publications 

Administrator Interface Reference Manual 96122

User User’s Guide 96116

Function URL

Web Site ■ http://www.oracle.com/index.html 

Documentation 
■ Customer:
■ Employee: 
■ Partner: 

■ http://docs.sun.com 
■ http://docs.sfbay.sun.com/ 
■ https://spe.sun.com/spx/control/Login 

Downloads
■ Customer:
■ Employee: 

■ http://www.sun.com/download/index.jsp 
■ https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 

Support ■ http://www.sun.com/support/ 

Training ■ http://www.oracle.com/global/us/education/sun_select_country.html 

Online Account ■ https://reg.sun.com/register 

Function Title Part Number

http://docs.sun.com
http://docs.sfbay.sun.com/ 
https://spe.sun.com/spx/control/Login
http://www.sun.com/download/index.jsp
http://www.sun.com/support/
https://reg.sun.com/register 
http://www.oracle.com/global/us/education/sun_select_country.html 
https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
http://www.oracle.com/index.html 
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Oracle Welcomes Your Comments
Oracle is interested in improving its documentation and welcomes your comments and 
suggestions. Submit your comments by clicking the Feedback[+] link at: 

http://docs.sun.com 

Please include the title and part number of your document with your feedback: 

StorageTek SL500 Modular Library System Diagnostic and Troubleshooting Guide,  
part number 96153.

Additional Information
Listed below are useful Web sites for additional information: 

■ http://crcapplications.central/keyswebapp/

■ http://sunwebcollab.east.sun.com/gm/document-
1.9.5747019/Tool_Crib_Order_Creation_User_Guide_rev1.pdf

■ http://sunsolve.central.sun.com/handbook_internal/FieldTools/support_tools.html

■ http://wwopsrep-web.uk.sun.com:8888/apps/NOPRT/

■ http://docs.sfbay.sun.com/

■ http://docs.sun.com/

■ http://eis.central/

■ http://tape.central.sun.com

■ http://suntape.central.sun.com/main.shtml

■ Field Replaceable Units:

■ KMS: http://sunsolve.central/handbook_internal/Systems/KMS/KMS.html 

■ Main site: http://sunsolve.central/handbook_internal/Systems/index.html

■ SL8500: http://spud.central/Systems/SL8500/components.html 

■ SL3000: http://spud.central/Systems/SL3000/components.html

■ SL500: http://sunsolve.central/handbook_internal/Systems/SL500/SL500

■ http://docs.sun.com/app/docs/prod/stortek.t10ka.tape?l=en&a=view

■ http://docs.sun.com/app/docs/prod/stortek.t10kb.tape?l=en&a=view

■ http://docs.sun.com/app/docs/prod/stortek.t9840.tape?l=en&a=view

■ http://docs.sun.com/app/docs/prod/stortek.t9840d.tape?l=en&a=view

■ http://docs.sun.com/app/docs/prod/tape.device#hic

■ http://www.sun.com/downloads/index.jsp

■ http://www.sun.com/support

■ https://spe.sun.com/spx/control/Login

■ https://reg.sun.com/register

■ https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login

■ https://interop.central.sun.com/interop/interop

■ http://www.sun.com/software/licensingcenter/storage.xml

http://docs.sun.com
http://crcapplications.central/keyswebapp/
http://sunwebcollab.east.sun.com/gm/document-1.9.5747019/Tool_Crib_Order_Creation_User_Guide_rev1.pdf
http://sunsolve.central.sun.com/handbook_internal/FieldTools/support_tools.html
http://wwopsrep-web.uk.sun.com:8888/apps/NOPRT/
http://docs.sfbay.sun.com/
http://docs.sun.com/
http://eis.central/
http://tape.central.sun.com
http://suntape.central.sun.com/main.shtml
http://sunsolve.central/handbook_internal/Systems/KMS/KMS.html 
http://sunsolve.central/handbook_internal/Systems/index.html
http://sunsolve.central/handbook_internal/Systems/index.html
http://spud.central/Systems/SL3000/components.html
http://sunsolve.central/handbook_internal/Systems/SL500/SL500
http://docs.sun.com/app/docs/prod/stortek.t10ka.tape?l=en&a=view
http://docs.sun.com/app/docs/prod/stortek.t10kb.tape?l=en&a=view
http://docs.sun.com/app/docs/prod/stortek.t9840.tape?l=en&a=view
http://docs.sun.com/app/docs/prod/stortek.t9840d.tape?l=en&a=view
http://docs.sun.com/app/docs/prod/tape.device#hic
http://www.sun.com/downloads/index.jsp
http://www.sun.com/support
https://spe.sun.com/spx/control/Login
https://reg.sun.com/register
https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login
https://interop.central.sun.com/interop/interop
http://www.sun.com/software/licensingcenter/storage.xml
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■ http://xmen.east/

■ https://csa-wiki.east.sun.com/display/SDP/Home

http://xmen.east/
https://csa-wiki.east.sun.com/display/SDP/Home
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Personal Safety

This section discusses personal safety.

EN60950-1:2001 Statement
The following statement pertains to products that require a ground connection at the 
wall outlet.

Safety Precautions

Warning – Possible Physical Injury.  On-the-job safety is important; therefore, 
observe the following safety precautions while you engage in any maintenance 
activity. Failing to follow these precautions could result in serious injury. 

■ Remove all conductive jewelry, such as watches and rings, before you service 
powered-on equipment.

■ Avoid electrical shock. Be careful when you work near power connectors and 
supplies.

■ Power-off the equipment that is being serviced before you remove a field 
replaceable unit (FRU) or other component. Remember that dangerous voltages 
could still be present in some areas even though power is off.

■ Ground all test equipment and power tools. 

Norway: 
Apparatet må tilkoples jordet stikkontakt
Finland: 
Laite on liitettävä suojamaadoituskoskettimilla varustettuun pistorasiaan
Sweden: 
Apparaten skall anslutas till jordat uttag
Denmark: 
For tilslutning af de øvrige ledere, se medfølgende installationsvejledning.
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■ Be aware that the product hardware might have sharp edges that could injure 
you. Handle the equipment carefully and wear the appropriate gloves.

■ Lift objects properly; read the information in “Lifting Techniques” on page xviii. 

■ Do not remove, cut, or relocate any floor tiles indiscriminately. Before you 
manipulate floor tiles, be sure that you understand the customer’s environment 
and receive the customer’s approval. Remember, each situation is different.

■ Enforce good housekeeping practices in the equipment area to help prevent fires 
and accidents.

Note – Important things to investigate and to be aware of include the use of Halon® 
gas, under-the-floor smoke detectors, and cables to other equipment installed nearby. 

Lifting Techniques
Lifting, regardless of how much or how little, can create serious back stress. If you 
follow these guidelines, you can reduce the risk of back injury:

■ Do not twist your body to pick up something or to put it down. Twisting puts 
extreme pressure on your back, especially when you lift or carry objects. Instead of 
twisting, make the task two separate moves; first lift, and then use your feet to turn 
your body.

■ Plan the lift; first examine the object and then determine how it should be lifted and 
where it will be placed.

■ Choose the appropriate lifting technique. Examine the weight, size, location, 
frequency, and direction of the lift. Plan to avoid awkward postures, and determine 
if material-handling aids are needed.

■ Place your feet shoulder-width apart, and place one foot a little behind the other. 
Keep your back straight because even light loads can significantly increase pressure 
on your spine when you lean forward.

■ Whenever you can, grip the load with your whole hand, and use two hands.

■ Carry objects at elbow height and close to your body. The farther away you hold an 
object, the more force it puts on your lower back.

■ Lift with your legs instead of your back. Leg muscles are some of the strongest in the 
body. When you squat and lift with your legs, you can lift more weight safely.

■ Alternate lifting tasks with tasks that are less stressful to the same muscles. This 
technique ensures that your muscles have some recovery time.

Shoulder, Elbow, Wrist, and Hand Safety
Follow these guidelines to minimize the possibility of injury to your shoulders, elbows, 
wrists, and hands.

■ Work within your safety zone—the area between shoulder level and knuckle level of 
your lowered hands. You face less chance of injury when you work or lift in this 
area.

■ Keep your elbows bent to keep loads close to your body and to decrease the amount 
of force necessary to do the job. If you use this posture, you will put less weight and 
pressure on your shoulder.
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■ Be sure to keep your wrists straight. Avoid bending, extending, or twisting your 
wrists for long periods of time.

■ Do not use a pinch grip to lift large or heavy loads because the way you lift also can 
affect the tendons in your hand. When you grasp an object between your thumb and 
fingers, you put a lot of tension on hand and wrist tendons. Use both hands—use 
one for a while, and then use the other—to give them rest.

Precauciones de seguridad

Advertencia – Posibles lesiones.  La seguridad laboral es importante. Por 
consiguiente, adopte las siguientes precauciones de seguridad al realizar 
cualquier tarea de mantenimiento. El incumplimiento de dichas precauciones 
puede conllevar graves lesiones. 

■ Antes de realizar cualquier tarea en equipos eléctricos conectados, quítese las 
joyas y accesorios conductores de electricidad, como relojes y anillos.

■ Evite las descargas eléctricas. Tenga cuidado al trabajar en la proximidades de 
conectores y alimentaciones eléctricas.

■ Antes de extraer unidad sustituible in situ u otro componente, apague el equipo y 
desconéctelo de la red eléctrica. Recuerde que, incluso si están apagados, en 
algunas áreas pueden quedar tensiones peligrosas.

■ Ponga a tierra todos los equipos de prueba y herramientas eléctricas. 

■ El producto puede tener bordes afilados, susceptibles de provocar lesiones. 
Manipule el equipo adoptando las precauciones adecuadas, y utilice guantes.

■ Para levantar objetos, consulte la información de “Técnicas de levantamiento de 
objetos” on page xx. 

■ No quite, corte ni cambie de lugar indiscriminadamente las baldosas. Antes de 
manipular baldosas, asegúrese de conocer el entorno del cliente y de recibir su 
autorización. Recuerde que cada situación es diferente.

■ Establezca, y haga cumplir, métodos de orden y limpieza en el área de equipos 
para evitar incendios y accidentes.

Nota – Entre los factores importantes que deben tenerse en cuenta es la presencia de 
gas Halón®, detectores de humo subterráneos y cables conductores a otros equipos 
instalados en las proximidades. 
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Técnicas de levantamiento de objetos
El levantar equipos o componentes, independientemente de su peso o tamaño, puede 
provocar serias lesiones lumbares. Siguiendo estas directrices podrá reducir los riesgos 
de lesiones.

■ No incline el cuerpo para levantar o bajar algo. Esta posición supone una tensión 
extrema para la espalda, en especial al levantar o transportar objetos. En lugar de 
inclinarse, efectúe dos movimientos: primero levante el componente y, a 
continuación, utilice los pies para girar el cuerpo.

■ Estos movimientos deben planificarse. En primer lugar, examine el objeto y 
determine cómo va a levantarlo y dónde va a colocarlo.

■ Seleccione la técnica de levantamiento adecuada. Examine el peso y tamaño del 
objeto, su ubicación y frecuencia y dirección en que vaya a levantarlo. La 
planificación debe hacerse de tal modo que se eviten posturas incómodas. Determine 
si son necesarios accesorios para la manipulación de materiales.

■ Separe bien las piernas y coloque una ligeramente detrás de la otra. Mantenga la 
espalda recta, porque incluso pesos ligeros pueden incrementar significativamente la 
presión sobre la espina dorsal al inclinarse hacia adelante.

■ En la medida de lo posible, sostenga la carga con toda la mano, y utilice ambas 
manos.

■ Transporte los objetos a la altura del codo y próximos a su cuerpo. Cuanto más lejos 
tenga que transportar un objeto, más presión aplicará sobre la zona lumbar.

■ Levante el objeto haciendo fuerza con las piernas, y no con la espalda. Los músculos 
de las piernas se cuentan entre los más fuertes del cuerpo. Al acuclillarse y levantar 
un peso con las piernas, tendrá mayor tolerancia al peso.

■ Alterne estas tareas con otras menos pesadas para los mismos músculos. De este 
modo, los músculos dispondrán de un cierto tiempo de recuperación.

Seguridad de hombros, codos, muñecas y manos
Siga estas instrucciones para reducir al mínimo las posibilidades de lesionarse los 
hombros, codos, muñecas y manos.

■ Trabaje dentro de su zona de seguridad, el área entre el nivel de los hombros y el 
nivel de los nudillos. Trabajando o levantando objetos dentro de esta área se 
expondrá a menos probabilidades de lesiones.

■ Mantenga los codos inclinados para mantener las cargas próximas a su cuerpo y 
reducir la fuerza necesaria para realizar la tarea. Con esta postura, aplicará menos 
peso y presión sobre los hombros.

■ Asegúrese de mantener las muñecas rectas. Evite doblarlas, extenderlas o torcerlas 
durante períodos de tiempo prolongados.

■ No levante cargas grandes o pesadas con el puño cerrado, porque el modo de 
levantarlas también afecta a los tendones de la mano. Al tomar un objeto entre el 
pulgar y los dedos se aplica mucha tensión a las manos y tendones de las muñecas. 
Utilice ambas manos alternativamente, para permitir que descansen.
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Fiber-optic Safety

Warning – Possible Physical Injury.  Eye hazard. Never look directly into a 
fiber-optic cable, a fiber-optic connector, or a laser transceiver module. 
Hazardous conditions might exist from laser power levels that are capable of 
causing injury to your eyes. 
 
Be especially careful when you use optical instruments with this equipment. 
Such instruments might increase the likelihood of injury to your eyes. 
 
Radiation exposure: Use of controls or adjustment or performance of procedures 
other than those specified herein might result in hazardous radiation exposure.

The laser transceivers in fiber-optic equipment can pose dangers to personal safety. 
Ensure that anyone who works with this StorageTek equipment understands these 
dangers and follows safety procedures. Ensure that the optical ports of every laser 
transceiver module are terminated with an optical connector, a dust plug, or a cover. 

Each fiber-optic interface in this StorageTek Fibre Channel equipment contains a laser 
transceiver that is a Class 1 Laser Product. Each laser transceiver has an output of less 
than 70 µW. StorageTek’s Class 1 Laser Products comply with EN60825-1:1994+A1+A2 
and with sections 21 CFR 1040.10 and 1040.11 of the Food and Drug Administration 
(FDA) regulations.

The following translations are for users in Finland and Sweden who wish to identify 
laser safety and classification:

CLASS 1 LASER 
LUOKAN 1 LASERLAITE 
KLASSE 1 LASER APPARAT

Laser Product Label
In accordance with safety regulations, a label on each StorageTek Fibre Channel product 
identifies the laser class of the product and the place and date of the manufacturer. The 
label appears on top of a Fibre Channel tape drive and near the Fibre Channel 
connectors on a Fibre Channel tape library. A copy of the label is shown here: 

CLASS 1 LASER PRODUCT
LASER KLASSE 1

APPAREIL A LASER DE CLASSE 1
COMPLIES WITH 21 CFR 1040.10 AND 1040.11
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Seguridad de fibras ópticas

Advertencia – Posibles lesiones.  Riesgo para la vista. Nunca mire 
directamente el interior de un cable de fibra óptica, un conector de fibra óptica o 
un módulo transceptor de láser. Los niveles de potencia del láser pueden 
conllevar situaciones de riesgo, susceptibles de lesionar la vista.  
 
Tenga especial cuidado al utilizar instrumentos ópticos con estos equipos. 
Dichos instrumentos pueden incrementar las probabilidades de lesiones 
oculares. 
 
Exposición a radiaciones: El uso de mandos, ajustes o procedimientos distintos 
de los aquí especificados puede conllevar un riesgo de exposición a radiaciones.

Los transceptores de láser de los equipos de fibra óptica pueden suponer un peligro 
para la seguridad física. Asegúrese de que toda persona que trabaje con estos equipos 
de StorageTek entienda los peligros y siga los procedimientos de seguridad. Asegúrese 
de que todos los puertos ópticos de los módulos transceptores de láser estén 
terminados con un conector óptico, una cubierta o un tapón de protección contra el 
polvo. 

Todas las interfaces de fibra óptica de estos equipos de canal de fibra de StorageTek 
contienen un transceptor de láser, categorizado como Producto láser de Clase 1. Todos 
los transceptores de láser tienen una potencia de salida inferior a 70 µW. Los productos 
láser Clase 1 de StorageTek cumplen lo dispuesto por la norma EN60825-
1:1994+A1+A2, así como con las secciones 21 CFR 1040.10 y 1040.11 de la Food and 
Drug Administration (FDA) de EE.UU.

Las siguientes traducciones están dirigidas a usuarios de Finlandia y Suecia que deseen 
identificar la categoría y clasificación de seguridad de los dispositivos láser:

LÁSER DE CLASE 1 
LUOKAN 1 LASERLAITE 
KLASSE 1 LASER APPARAT

Etiqueta del producto láser
De conformidad con las normas de seguridad, cada producto de canal de fibra de 
StorageTek lleva una etiqueta que identifica la clase de láser del producto, y el lugar y 
fecha de fabricación. Esta etiqueta aparece sobre la unidad de cinta de canal de fibra, así 
como en las proximidades de los conectores de las bibliotecas de cintas de canal de 
fibra. A continuación puede verse una copia de dicha etiqueta:

PRODUCTO LÁSER CLASE 1
LASER KLASSE 1

APPAREIL A LASER DE CLASSE 1
COMPATIBLE CON LAS SECCIONES 21 CFR 1040.10 Y 1040.11
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Rack Safety 

Warning – Possible Physical Injury.  

■ More than one person might be required to install equipment into the rack or to 
remove equipment from the rack. Make sure you read the information in “Lifting 
Techniques” on page xviii before you begin. 

■ Consider the library’s total weight when you place other equipment into the rack. To 
prevent an unbalanced situation, install the heaviest equipment on the bottom and 
the lightest equipment on the top whenever possible. Failure to do so might cause 
the rack to become unstable and tip over.

■ Take adequate precautions when you move a library that contains rack-installed 
equipment. The weight of some rack equipment might alter the height of the 
library’s center of gravity. This condition might cause the library to tip during a 
move. 

■ If you remove power from the library by using the library’s power switch, the rack-
installed equipment remains powered-on.

■ Ensure that any equipment that you install within the rack is adequately cooled. The 
library’s internal ambient temperature should not exceed the recommended 
operating temperature. Base cooling considerations on the power dissipation within 
the rack space as well as on the ambient room conditions that are external to the 
library. You must provide cooling for moderate power dissipation within the rack 
space.

Component Weight

Base unit with 1 power supply 27.2 kg (60.0 lb)

Drive expansion module with 4 tape drives and 1 power 
supply

41.3 kg (91.0 lb)

Cartridge expansion module 20.1 kg (44.2 lb)

Robotics unit 10.1 kg (22.2 lb)

Power supply 2.3 kg (5.1lb)

The weights of the modular versions differ slightly.
The base module always must be installed above the expansion modules, even though it is 
heavy. However, if not all five modules are installed, the modules can be placed lower in 
the rack for safety and stability reasons. See the following caution.
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Seguridad del bastidor

Advertencia – Posibles lesiones.  

■ Es necesaria más de una persona para instalar o desinstalar equipos en y del bastidor 
de la biblioteca. Antes de poner manos a la obra, asegúrese de seguir las 
instrucciones de la sección “Técnicas de levantamiento de objetos” on page xx. 

■ Al colocar otros equipos en el bastidor, considere también el peso total de la 
biblioteca. Para evitar un desequilibrio de la carga, en la medida de lo posible 
coloque los equipos más pesados abajo y los más ligeros arriba. De lo contrario, el 
bastidor podría desestabilizarse y caerse.

■ Al mover una biblioteca que tenga equipos instalados en el bastidor, adopte las 
precauciones adecuadas. El peso de algunos equipos del bastidor pueden modificar 
la altura del centro de gravedad de la biblioteca. Esta situación puede provocar que 
la biblioteca se vuelque durante un traslado. 

■ Si desconecta la alimentación eléctrica de la biblioteca accionando el interruptor de 
encendido de ésta, el equipo instalado en el bastidor seguirá conectado a la 
alimentación eléctrica.

■ Asegúrese de que cualquier equipo instalado dentro del bastidor disponga de la 
ventilación adecuada. La temperatura ambiente en el interior del bastidor no debe 
ser superior a la temperatura de servicio recomendada. Para la refrigeración de la 
base deben tomarse en consideración tanto la disipación eléctrica dentro del espacio 
del bastidor como las condiciones ambientales externas de la biblioteca. Dentro del 
espacio del bastidor debe ajustarse la refrigeración para una disipación eléctrica 
moderada.

Componente Peso

Base unit with 1 power supply 27.2 kg (60.0 lb)

Drive expansion module with 4 tape drives and 1 power 
supply

41.3 kg (91.0 lb)

Cartridge expansion module 20.1 kg (44.2 lb)

Robotics unit 10.1 kg (22.2 lb)

Power supply 2.3 kg (5.1lb)

The weights of the modular versions differ slightly.
The base module always must be installed above the expansion modules, even though it is 
heavy. However, if not all five modules are installed, the modules can be placed lower in 
the rack for safety and stability reasons. See the following caution.



96153 • Revision NA xxv

Oracle Confidential: Internal and Authorized Service Partner Use Only

Product Precautions

This section discusses product precautions you must observe when working on the 
library.

Electrostatic Discharge (ESD) Damage 
Prevention
Anyone who handles ESD-sensitive components must be aware of the damage that ESD 
can cause to electronic components and must take the proper precautions to prevent it. 
Also, anyone who performs maintenance on StorageTek equipment must complete an 
ESD-basics course. 

Caution – Potential damage to equipment. Handle ESD-sensitive components only under 
ESD-protected conditions. To meet this requirement, always use the Field Service 
Grounding Kit (PN 4711) and always follow these ESD precautions and procedures 
when you are servicing StorageTek equipment or handling ESD-sensitive components.

ESD Precautions
Always take the following general precautions when you work with ESD-sensitive 
components:

■ Wear ESD protection whenever you install, remove, maintain, or repair StorageTek 
equipment.

■ Keep ESD-sensitive printed-circuit components in their ESD-protective packages 
until you have taken all ESD-preventive steps and you are ready to install the 
component.

■ Do not allow anyone to touch or handle an unprotected ESD-sensitive component 
unless that person has taken all ESD precautions.

■ Reinstall all equipment covers and close all equipment doors after you have 
completed the work.
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■ If the grounding-kit work surface has been exposed to temperatures above 66ºC 
(150ºF) or below 4.5ºC (40ºF), acclimate the work surface to room temperature before 
you unroll it.

■ Immediately place any component that you have removed into an ESD-protective 
package.

■ Keep the grounding-kit work surface clean. 

■ To clean the work surface, use a mild detergent and water, and make sure that the 
surface is completely dry before you use it.

■ Periodically check the electrical resistance of the ground cord and the wrist-strap coil 
cord. 

Note – The ground cord should measure less than 1.2 MΩ, and the coil cord should 
measure between 0.8 and 1.2 MΩ. Repair or replace the cords if they no longer meet 
these requirements.

ESD-Protection Procedure
Remember that each customer environment is different. Address all the customer’s 
concerns before you work on any equipment. 

Prepare the Work Area

1. Before you service the equipment, unfold the grounding-kit work surface completely 
and place it on a convenient surface.

2. Attach one end of the ground cord to the work surface; secure the snap fastener. 

3. You will attach the free end in a later step.

4. Slip on an ESD wrist strap. Make sure that the strap is comfortable and makes 
contact with the entire circumference of your wrist.

5. Snap one end of the coil cord to the wrist band.

Access the Equipment
1. Carefully open the doors to the equipment or remove the covers from the 

equipment. Do not touch any internal components.

Caution – Potential damage to equipment. Be sure that you are properly grounded before 
you touch any internal components. 

2. Attach the free end of the coil cord to the most appropriate place:

a. If you are working on components from a small piece of equipment, attach the 
free end of the coil cord to the grounding-kit work surface. In addition, be sure 
that you touch an unpainted metal surface on the equipment before you touch an 
internal component.
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b. If you are working on components from a large piece of equipment, attach the free 
end of the coil cord to a grounding jack or to an unpainted metal surface inside 
the equipment.

Replace Components

1. Remove the defective component and place it on the work surface.

2. Remove the replacement component from its ESD-protective package, and install the 
component in the equipment.

3. Place the defective component in the ESD-protective package.

Clean Up

1. Disconnect the ground cords from the equipment.

2. Reinstall all equipment covers and close all equipment doors.

3. Disconnect the coil cord from your wrist, and, if necessary, disconnect the ground 
cord from the work surface.

4. Properly store the work surface and the other Field Service Grounding Kit items.

Fiber-optic Cable Installation
Follow these guidelines when you install fiber-optic cables:

1. Cable routing:

■ Raised floor: You may install fiber-optic cables under a raised floor. Route them 
away from any obstruction, such as existing cables or other equipment.

■ Cable tray or raceway: Place the cables in position; do not pull them through the 
cable tray. Route the cables away from sharp corners, ceiling hangers, pipes, and 
construction activity. 

■ Vertical rise length: Leave the cables on the shipping spool, and lower them from 
above; do not pull the cables up from below. Use proper cable ties to secure the 
cable.

■ General: Do not install fiber-optic cables on top of smoke detectors.

2. Cable management: 

■ Leave at least 4.6 m (15 ft) of cable at each end for future growth.

■ Use strain reliefs to prevent the weight of the cable from damaging the connector.

■ Review all information in this manual and in any related manuals about safely 
handling fiber-optic cables.

3. Connector protection: 

■ Insert connectors carefully to prevent damage to the connector or fiber.

■ Leave the connector’s protective cover in place until you are ready to make 
connections. 
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■ Replace the connector’s protective cover when the connector is disconnected.

■ Clean the connector before making a connection. Make sure that there are no 
obstructions and that keyways are aligned. 

Fiber-optic Cable Handling
Observe these precautions when you handle fiber-optic cables:

■ Do not coil the cable to less than 96 mm (3.75 in.) in diameter.

■ Do not bend the cable to less than 12 mm (0.5 in.) in radius. StorageTek recommends 
that a cable’s bend radius be no less than 20 times the diameter of the cable.

■ Do not pull on the cables; carefully place them into position.

■ Do not grasp the cables with pliers, grippers, or side cutters; do not attach pulling 
devices to the cables or connectors.

■ Keep cables away from sharp edges or sharp protrusions that could cut or wear 
through the cable; make sure that cutouts in the equipment have protective edging.

■ Protect the cable from extreme temperature conditions.

■ Install the connector’s protective cover whenever the connector is not connected.

Rack Precautions

Caution – Observe the following safety precautions when you install equipment into 
the library rack: 

■ Install the equipment from the bottom of the rack to the top of the rack; 
StorageTek recommends that you place the heaviest items near the bottom of the 
rack whenever possible.

■ Ensure that the equipment has UL listing (listing by Underwriters’ Laboratories), 
CSA certification (certification by the Canadian Standards Association), and CE 
compliance (compliance with the European Council’s directives and standards).

■ Ensure that the combination of the library with other equipment in the rack does 
not create an overcurrent condition, whether the equipment is connected directly 
to the branch circuit or to a power distribution strip.

■ Ensure that all equipment in the rack has reliable earth ground, whether the 
equipment is connected directly to the branch circuit or to a power distribution 
strip.

■ Follow the manufacturer’s guidelines to position, to support, and to fasten the 
equipment in the rack.

■ Ensure that any equipment that you install within the rack is adequately cooled. 
The library’s internal ambient temperature should not exceed the recommended 
operating temperature. Base cooling considerations on the power dissipation 
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within the rack space as well as on the ambient room conditions that are external 
to the library. You must provide cooling for moderate power dissipation within 
the rack space.

■ Locate the equipment so that it does not block or hinder any ventilation openings 
in the library’s rack area. For example, do not block library or drive exhaust areas, 
the electronic module exhaust area, perforated metal, or other similar ventilation.

■ If the rack has front or rear doors, do not allow the doors to interfere with the 
library’s ventilation. 

■ Locate the equipment so that the library doors adequately clear the equipment 
when you close them. 



Oracle Confidential: Internal and Authorized Service Partner Use Only

xxx SL500 Diagnostic/Troubleshooting Guide • May 2010 Revision NA • 96153



96153 • Revision NA 1

Oracle Confidential: Internal and Authorized Service Partner Use Only

CHAPTER 1

Troubleshooting

This chapter provides trouble isolation procedures (TIPs) to help you isolate problems 
associated with Oracle’s StorageTek SL500 Library. The START TIP is the beginning 
point for all other TIPs.

After the TIPs is a table describing how to use StorageTek Library Console to resolve a 
problem. The last part of the chapter contains descriptions of buttons and indicators.

Note – Some of the problems identified by result codes are described in Chapters 6 
through 11.

TIP 0000: START

Symptom Explanation Conditions That Could Cause This Symptom

A failure is detected, but no event is 
displayed.

■ Defective AC power component
■ Defective or incorrect SCSI or fiber cable
■ Defective RLC card
■ Defective tape drive

1. Do you have an AC power problem? Yes: Go to “TIP 1000: Power” on page 2.

No: Go to the next step.

2. Is the client system unable to access the 
library?

Yes: Go to “TIP 2000: Library SCSI Interface” on page 4 or 
“TIP 3000: Library Fibre Channel Interface” on page 5.

No: Go to the next step.

3. Do you have a tape drive problem? Yes: Go to “TIP 4000: Tape Drives” on page 6.

No: Go to the next step.

4. Do you have a StorageTek Library Console 
problem?

Yes: Go to “TIP 5000 StorageTek Library Console” on 
page 7.

No: Go to the next step.
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Caution – System problems: Make sure that the operator has quiesced the library and 
tape drive activities before you troubleshoot library faults.

TIP 1000: Power
Use this TIP to troubleshoot AC power problems.

Caution – Follow the safety precautions in “Personal Safety” and “Product 
Precautions”.

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector 
into the CLI port. A potential power surge could cause a fire or damage to the 
RLC card.

5. If you are uncertain, run diagnostic tests 
on the library.

Use the command line interface (CLI).

Symptom Explanation Conditions That Could Cause This Symptom

The power supply breaker trips. ■ Defective power supply
■ Defective power cable
■ Incorrect power source from wall
■ Defective tape drive

1. Look at the back of the rack.

2. Is the power cord seated properly? Yes: Go to Step 3.

No: Reset the power cord.

3. Make sure that all the tape drives are seated 
properly.

4. Does the breaker trip?

Yes:  Go to Step 5. 

5. Remove each tape drive in turn. Does the breaker 
trip?

Yes: Power on the tape drives, one at a time, to 
see which one causes the breaker to trip. 
Replace the defective one.

No: Go to the next step.
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6. Disconnect the power cable from the customer 
receptacle. At the male pins on the power connector, 
use an volt/ohmmeter (set to ohms) to check between 
the following male pins on the power cable:

■ 1 phase pin to GND = open
■ 2nd phase pin to GND = open
■ 1 phase pin to 2nd phase pin = <1 Mohm
■ GND pin to frame = short 

Are the measurements correct?

Yes: Go to Step 7.

No: Go to Step 8.

7. Use an ohmmeter to check the continuity of all three 
wires in the power cable.

Is there continuity?

Yes: Go to Step 8.

No: Replace the cable.

8. Plug the power cord back into the customer’s outlet. 
Leave the library end of the cord unplugged.

Warning – Possible Physical Injury.  Electrocution hazard: Take the 
necessary safety measures when measuring line voltage in the next 
procedure. 

Warning – Possible Physical Injury.  Lebensgefährliche Spannung: Bevor 
Sie die Netzspannung wie nachstehend beschrieben messen, treffen Sie 
die entsprechenden Sicherheitsmaßnahmen.

Warning – Possible Physical Injury.  Danger d'électrocution: Avant de 
mesurer la tension de secteur à l'étape suivante, prendre les mesures de 
sécurité requises.

Warning – Possible Physical Injury.  Peligro de electrocución: Al realizar 
la medición de la tensión de la línea, procedimiento que se describe a 
continuación, adopte las medidas de seguridad necesarias.

9. Switch your volt/ohmmeter to AC volts and measure 
the line voltage at the cable. Nominal voltage for 
North America is 100–120 VAC. Nominal voltage for 
international is 200–240 VAC. 

Is the line voltage correct?

Yes:  Go to Step 10. 

No: Notify the customer.

10.Plug the cable into the power supply. Does the 
breaker still trip?

Yes:  Replace the power supply. 
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TIP 2000: Library SCSI Interface
Use this TIP if the client system does not recognize the library. Before you start, make 
sure that the SCSI cables are the correct type and length for your operation. 

Symptom Explanation Conditions That Could Cause This Symptom

The library cannot be accessed by the 
client system.

■ System not working or incorrectly configured
■ Incorrect library configuration
■ Loose or incorrect cable connection at the system or at the 

library
■ Defective RLC card

1. Have the customer quiesce the library and tape drive 
activities.

2. Look at the back of the rack. Is the library the only 
client system component not operating correctly?

Yes: Go to Step 3.

No: Notify the system administrator.

3. Make sure that the library configuration matches the 
system requirements. This can be checked in the 
StorageTek Library Console configuration menus. Is 
the library correctly configured?

Yes: Go to Step 4.

No: Correctly configure the library.

4. Check the host-to-library cable connection at the 
MPW/RLW card. Is the cable the correct type and is 
the connection good?

Yes: Go to Step 5.

No: Reseat the cable connector or use the correct 
cable.

5. If the control path is SCSI, is a SCSI terminator 
attached?

Yes: Go to Step 6.

No: Apply the correct terminator:

6. Check the cable connection at the host.
Is the cable the correct type and is the connection 
good?

Yes: Go to Step 7.

No: Reseat the cable connector or use the correct 
cable type.

7. Check the SCSI terminator at the client.
Is the terminator turned on?

Yes: Go to Step 8.

No: Turn it on.

8. Is the length of the SCSI bus correct for its operation 
type?

Yes: Go to Step 9.

No: Connect the correct length of SCSI cable.

9. Does the SCSI bus have more than the maximum 
number of devices allowed?

Yes: Check with the system administrator to 
correct the number of devices on this bus.

10.Is there host connectivity to the library? No: Either:
■ Connect the cable to your PC and run the 

SCSI/Fiber tool box diagnostics (until Tools has 
a SL500 option, use of L700 has worked for basic 
function testing).

■ Connect to the host server, have the customer 
install the ISV application software, and try to 
run using the application program
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TIP 3000: Library Fibre Channel Interface
Use this TIP if the client system does not recognize the library.

Before you start, make sure that the Fibre Channel cables are the correct type and 
length for your operation. 

Symptom Explanation Conditions That Could Cause This Symptom

The library cannot be accessed by the 
client system.

■ System not working or incorrectly configured
■ Incorrect library configuration
■ Loose or incorrect cable connection at the system or at the 

library
■ Defective RLC card

1. Have the customer quiesce the library and tape drive 
activities.

2. Look at the back of the rack. Is the library the only 
client system component not operating correctly?

Yes: Go to Step 3.

No: Notify the system administrator.

3. Make sure that the library configuration matches the 
system requirements. This can be checked in the 
StorageTek Library Console configuration menus. Is 
the library correctly configured?

Yes: Go to Step 4.

No: Correctly configure the library.

4. Check the host-to-library cable connection at the 
MPU2 card. Is the cable the correct type and is the 
connection good?

Yes: Go to Step 5.

No: Reseat the cable connector or use the correct 
cable type.

5. Check the cable connection at the host.
Is the cable the correct type and is the connection 
good?

Yes: Check with the system administrator.

No: Reseat the cable connector or use the correct 
cable.

6. Is there host connectivity to the library? No: Connect to the host server, have the 
customer install the ISV application 
software, and try to run using the 
application program.
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TIP 4000: Tape Drives
Use this TIP to troubleshoot tape drive problems.

Symptom Explanation Conditions That Could Cause This Symptom

The client system:
■ Cannot access a tape drive
■ Marks the tape drive as unavailable
■ Detects an unrecoverable error in the 

tape drive

■ Power switch in the OFF position
■ Unplugged library power cord
■ Tape drive with no power
■ Poor or missing SCSI/fiber bus connection
■ Defective SCSI/fiber cable
■ Damaged tape
■ Faulty tape drive

1. Have the customer quiesce the tape drive activities.

2. Look at the back of the rack. Is the power switch in 
the OFF position?

Yes: Place the switch in the ON position.

No: Go to Step 3.

3. Is the library power cord unplugged? Yes: Plug in the cord.

No: Go to Step 4.

4. Use the StorageTek Library Console to check the tape 
drive’s status. Is the status “not communicating?”

Yes: Go to Step 5.

No: Go to Step 5.

5. Is the tape drive firmly seated into its connector? Yes: Go to Step 6.

No: Firmly seat the tape drive into the 
connector. 

6. Use the StorageTek Library Console to check the 
status. Is the status “Unknown drive?”

Yes: Use the configuration menu to check the 
type to make sure it matches the system 
requirements.

No: Go to Step 7.

7. If possible, obtain the tape that was mounted on the 
tape drive when the error occurred.

8. Have the operator take another tape drive offline 
and use a system diagnostic test with this tape on 
that tape drive.

Was an error encountered?

Yes: Have the operator remove the tape from the 
system pool.

No: Refer to the replaceable parts catalog, PN 
96120, and replace the tape drive.

9. Is there host connectivity to the tape drive? No: Test tape drive connectivity by using one of 
these methods: 
Toolbox 
OEM Vendor Diagnostic program 
ISV backup application.
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TIP 5000 StorageTek Library Console
Use this TIP to troubleshoot StorageTek Library Console problems.

 

Symptom Action

The StorageTek Library Console 
cannot communicate with the 
library.

The version of StorageTek Library Console code is not compatible with 
the library controller code.
1. Download a different version of StorageTek Library Console code.
2. Restart the StorageTek Library Console.
3. Log on to the StorageTek Library Console.

The StorageTek Library Console 
does not display modified data or 
information remains static.

1. Use the Refresh button to update the screen.
2. Check the StorageTek Library Console heartbeat monitor icon on the 

status line:
■ The normal icon is a check mark in a circle that flashes periodically. 

This indicates that the library and server are communicating.
■ A warning icon is an explanation point in a triangle. This indicates 

that the StorageTek Library Console is not communicating with the 
library.

■ After 30 to 60 seconds, the warning icon becomes an error icon. This 
icon is an X. The system displays “Heartbeat message not received 
from the server.” 

3. Select Problem Details to obtain possible causes and suggested 
actions.

4. After a communication error occurs, you MUST log off and then log 
on to StorageTek Library Console to restore communication between 
the StorageTek Library Console and the library.

For more information, access the StorageTek Library Console online 
help.
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Using StorageTek Library Console

Note – If you have not yet received an activation password and installed StorageTek 
Library Console, see “Requesting the Activation Password” on page 9 through 
“Logging On to StorageTek Library Console” on page 19.

Use the following procedures to resolve some problems.
■ “Reviewing System Detail Information” on page 20
■ “Generating and Saving Reports” on page 26
■ “Monitoring Events” on page 30
■ “Auditing the Library” on page 34
■ “Configuring the Library for Auto Clean” on page 36
■ “Viewing the List of Cleaning Cartridges” on page 37
■ “Importing Cleaning Cartridges Through the CAP” on page 38
■ “Exporting Cleaning Cartridges Through the CAP” on page 39
■ “Cleaning Tape Drives” on page 37
■ “Transferring Files From the RLC Card” on page 40
■ “Performing Self Tests” on page 41

For related StorageTek Library Console functions, see:

■ Chapter 3 “Performing a Diagnostic Move” on page 65 and “Performing a Recovery 
Move” on page 73.

■ Chapter 4 “Using Library Console to Download Firmware” on page 78 

■ Appendix A for SNMP information.

 

Symptom Action

Service Required LED is 
constantly lit.

Check the health of the library and the attached devices:
1. Open and log on to StorageTek Library Console. See “Logging On to 

StorageTek Library Console” on page 19.
2. Access the Tools > System Details.
3. Check the device tree for the following indicators:
Device Healthy 
Device Error

The device tree on the left pane provides a list of devices attached to the 
library.

The Status and Statistics options tabs provide more information on the 
health of the library and devices. For more information, see the online 
help documentation accessible through the StorageTek Library Console 
application.
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Requesting the Activation Password

Note – You will request two passwords: an admin password that you will give to the 
customer administrator for StorageTek Library Console usage and a service password for 
yourself. After you have received one password, select the Request Activation 
Password button and repeat the procedure for the second role of password. 

To request an activation password: 

1. Go to http://crcapplications.central/keyswebapp/ 

http://crcapplications.central/keyswebapp/
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2. Log in to http://crcapplications.central/keyswebapp/ using your user ID and 
password, then select the Login button.

Note – If you are not authorized to log on, click the request a password link and 
follow the instructions.

http://crcapplications.central/keyswebapp/
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3. Select Tools & Services from the left pane.
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4. Select Activation Password Request.
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5. Type the information into the fields. Use the click here link in the paragraph above 
the fields for an explanation about the fields. 

The system validates your input and retrieves an activation password for the library.

Note – The activation password is case sensitive. You must type this password exactly 
as it was issued to you by the Activation Password application.

6. Repeat these steps for the second password.
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Installing StorageTek Library Console
StorageTek Library Console software can be downloaded from https://dlrequest-zn-
dlapps1.sfbay.sun.com/usr/login . Load this software to your personal computer (and 
optional local operator panel, if your library has one). 

When downloading the application, select the remote option.

Some notes about installing the StorageTek Library Console software:

■ For Windows, go to the Windows START Menu, select Run, then type D:\
SLConsoleWindows (where “D” is the letter for your CD-ROM drive) and click OK.

■ For Solaris, type /cdrom/cdrom0/SLConsoleSolaris.bin and follow the installer 
instructions. 

Note – The following screens show what information you would type or which 
buttons you would click. Follow the instructions on the screens.

1. Install the StorageTek Library Console to your PC.

https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
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2. Select the I accept... button, then continue to follow the information on the screens, 
including clicking on the Next button.
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3. Type in the location on your PC where you would like to install the file and create 
the icon. The screens show possible locations.
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4. Select the Install button.
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5. Select the Done button.
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Logging On to StorageTek Library Console
1. Type service for your User ID, the password you received, and the IP address of the 

library you want to monitor.

2. Select the Log on button.

Note – When you are finished using StorageTek Library Console, you will return to 
this screen and select the Exit button.
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Reviewing System Detail Information
The System Detail individual screens provide status and information for the:
■ Library
■ CAPs
■ Drives
■ Robot

1. Select Tools > System Details. 
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This screen shows the library status as operational and the access door is closed.
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2. Select the folders on the left to display more information. This screen shows one 
CAP, one drive, a robot, and their locations within the library.
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3. Select Library on the left and the Properties and General tabs to display even more 
information.
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4. Select the highlighted tabs to see the library firmware version.
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5. Select the highlighted tabs to see the contents of each module in the rack.

As you select different components and tabs, the information changes.

6. If you are finished and do not want to generate and save any reports, select Tools > 
Log Off.
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Generating and Saving Reports
The reports from StorageTek Library Console provide static information on the library 
and the associated devices (for example, tape drives and CAPs), events, and cartridges. 

Permanent reports are useful when you can quickly select an existing report template 
to generate relevant data to view, e-mail, print or save to a file. This activity can help 
you diagnose a problem. 

To generate permanent reports:

1. Open the StorageTek Library Console application. (If you have a shortcut icon on 
your PC, select it or go to the location on your PC where you placed the file.)

2. Log on. See “Logging On to StorageTek Library Console” on page 19.

3. Select Tools > Reports.
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4. From the Reports tree, expand the Permanent Reports folder.
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5. Select the desired report. For this example, Drive Details is selected.

6. Select the Display tab.

7. Use the scroll bar on the right to navigate through the report.

8. Select Update from the top options bar to update the screen with current data from 
the RLC card.

9. Save the report data to a file:

a. Select Save from the top options bar.

b. Select a Save in folder and then type a file name.

c. Select the appropriate file format (HTML, Text, or XML).

d. Select Save.
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10. When you are finished, select Tools > Log Off.
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Monitoring Events
Event monitors are set up to collect information about the library and the associated 
devices when specific events occur. 

To display an event monitor:

1. Open the StorageTek Library Console application. (If you have a shortcut icon on 
your PC, select it or go to the location on your PC where you placed the file.)

2. Log on. See “Logging On to StorageTek Library Console” on page 19.

3. Select Tools > Monitors.
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4. From the Monitors tree, expand the Permanent Monitors folder.
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5. Highlight an event from the left side. For this example, Error Events is selected.

6. Select Open from the top options bar.

7. Use these options to manage the information displayed on the screen for the selected 
event.

8. To close a monitor, click X in the upper right corner.

9. To spool the event data to a file:

a. Select Spool File > Start Spooling.

b. Select a Save in folder and then type a file name.

c. Select Save.

To stop spooling, select Spool File > Stop Spooling.

To Select

Pause the continuous display Monitor > Pause

Resume displaying the events Monitor > Resume

Permanently stop the continuous display Monitor > Stop

Delete the event Monitor > Clear
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10. When you are finished, select Tools > Log Off.
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Auditing the Library
An audit is the process of reading and cataloging every cartridge within a library or 
verifying the locations of cartridges.

An audit occurs when you:
■ Power-on the library
■ Open and close the library front door
■ Make a request from the Library Console

The library maintains a database that contains the following information for all the 
cartridges in the library:
■ Volume serial numbers (VOLID) 
■ Slot location 
■ Verified status (True or False)

You can use Library Console for three types of audits:
■ Physical 
■ Verified 
■ Virtual

Physical Audit
During a physical audit, the robot moves to the cartridge locations in the library, 
verifies the VOLID, and updates the cartridge database. This audit changes the Verified 
status of the cartridge locations to “True.”

Entire Library Audit from Library Console

The robot moves to all the slots, catalogs the VOLIDs and locations, and updates the 
cartridge database. This audit is a background process and does not interrupt online 
library operations.

To perform an entire library audit:

1. Select Tools > Diagnostics.

2. Select the Audit tab.

3. From the Audit Type pull-down list select Physical Audit. 

4. Select Entire Library Audit

5. Select the Audit button in the upper right hand corner.

6. Select Yes to perform the audit as a background process or No to cancel the audit.

The Cartridge Summary report will contain the latest cartridge locations and VOLIDs a 
few hours after the audit is complete.
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Specific Range Audit from Library Console

The robot moves to a specific range of slots and updates the cartridge database.

To perform a specific range audit:

1. Select Tools > Diagnostics.

2. Select the Audit tab.

3. From the Audit Type pull-down list select Physical Audit.

4. Without selecting the Entire Library Audit, set the Start and End Address:

a. Select Type (of device) from the pull-down menu. 

b. Select the Module, Row, and Column address from the pull-down menus.

5. Select the Audit button in the upper right hand corner.

After completing the audit, the Audit Console section displays the VOLIDs of the 
audited locations.

Verified Audit
A verified audit validates the status of a specific cartridge location or a range of 
locations (including CAPs and tape drives) in the cartridge database. If a cartridge 
address has a verified status of “False”, then a physical audit of that location is 
performed and the cartridge database is updated.

To perform a verified audit:

1. Select Tools > Diagnostics.

2. Select the Audit tab.

3. From the Audit Type pull-down list, select Verified Audit. 

4. To set the Start and End Address:

a. Select Type (of device) from the pull-down menu. 

b. Select the Module, Row and Column address from the pull-down menus. 

5. Select the Audit button in the upper right hand corner.

After completing the audit, the Audit Console section displays the VOLIDs of the 
audited locations.
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Virtual Audit
In a virtual audit, the library reads the contents of the cartridge database and displays 
a report.

To perform a virtual audit:

1. Select Tools > Diagnostics.

2. Select the Audit tab.

3. From the Audit Type pull-down list, select Virtual Audit. 

4. To set the Start and End Address:

a. Select Type (of device) from the pull-down menu. 

b. Select the Module, Row and Column address from the pull-down menus. 

5. Select the Audit button in the upper right hand corner.

After completing the audit, the Audit Console section reports the contents of the 
cartridge database.

Configuring the Library for Auto Clean

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00) and 
then upgrade the library firmware to the SL500 code level 1092.

When a tape drive requires cleaning and Auto Clean is enabled, the robot hand 
retrieves a cleaning cartridge for the specific type of tape drive, mounts the cartridge 
onto the tape drive, and returns the cartridge to the storage slot after cleaning is 
complete.

To configure the library for Auto Clean:

1. Select Tools > Systems Details.

2. Select the Library folder from the device tree. 

3. Select Auto Clean > Configure.

4. From the Auto Clean pull-down menu, select Enable.

The Warning Threshold is the number of times a cleaning cartridge can be used before 
a warning message appears.

To configure the threshold for each cartridge type:

1. Select a number for the threshold from the pull-down of the appropriate cartridge 
type.

2. Select the Apply button from the top right corner of the screen.

3. Select Refresh to view the modified configuration.
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Viewing the List of Cleaning Cartridges

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00) and 
then upgrade the library firmware to the SL500 code level 1092.

You can view a list of cleaning cartridges to determine information such as:

■ Cartridge location 

■ VOLID 

■ Usage count 

■ Cartridge type (for example, LTO, SDLT)

■ Status (OK, warning, expired)

To view a list of cleaning cartridges in the library:

1. Select Tools > Systems Details.

2. Select the Library folder from the device tree. 

3. Select Auto Clean > Cleaning Cartridges.

Cleaning Tape Drives

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00) and 
then upgrade the library firmware to the SL500 code level 1092.

If Auto Clean is disabled, you can manually clean the tape drives when they need to be 
cleaned. Even if Auto Clean is enabled, you might want to manually clean a tape drive.

To verify if a tape drive needs to be cleaned:

1. Select Tools > Systems Details.

2. Select + to expand the Drive Folder.

3. Select the required tape drive and verify the status of the Drive needs cleaning. If 
this status is “True”, then initiate a manual clean. 

Caution – Possible damage to tape drive: Your library could contain more than one type 
of tape drive. Make sure that the library slots have the appropriate cleaning cartridges. 
Generate a cartridge summary and drive details report before initiating a manual clean.

TABLE 1-1 Cleaning Cartridge Status

Status Description

OK The cartridge is still within the threshold

Warning The cartridge has reached the threshold

Expired The cartridge has exceeded the threshold
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To manually clean a tape drive:

1. Select Tools > Diagnostics.

2. Select + to expand the Drive Folder.

3. Select the tape drive that requires cleaning

4. Select the Clean tab.

5. Select the Start Clean tab at the top right corner of the screen.

The Drive Clean Status Console displays the status of the cleaning operation.

Importing Cleaning Cartridges Through the CAP

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00) and 
then upgrade the library firmware to the SL500 code level 1092.

Use the CAP to place new cleaning cartridges in the library reserved slots.

Before importing cleaning cartridges through the CAP, verify the following:

■ The required number of reserved slots is empty.

■ The CAP slots are empty.

■ The cleaning cartridges match the tape drive type.

■ The CAP Prevent/Allow state is set to Allow,. Refer to your SCSI reference manual 
for syntax.

To import cleaning cartridges through the CAP:

1. Press the Open CAP button on the keypad.

The robot opens the CAP door and the Open CAP LED is turned on.

2. Grip the handle of the magazine and slide it out of the CAP and onto the door rails.

Note – Do not remove the magazine from the door. Leave the magazine on the door 
rails. This allows the magazine to slide easier into the CAP.

Caution – Possible damage to components. You must enter the cartridges properly, or else 
you might damage the robot or the tape drive or cause the library to stop operating. 
Use only cartridges designed for your type of tape drive.

3. Place a cartridge into one of the magazine slots, making sure that the VOLID label is 
visible and the hub of the cartridge is down.

4. Grip the handle and slide the magazine back into the CAP.

5. Close the CAP door, making sure that the door is securely latched.

6. From the Library Console, select Tools > Diagnostics.

7. Select + to expand the CAP folder.

8. Highlight the CAP.
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9. Select the Import/Export tab.

10. Select Import Cleaning/Diagnostic cartridges. 

11. Select the Start button from the upper right corner of the screen.

12. Monitor the Import/Export Console to verify the status of the import operation.

13. Generate a cartridge summary report to verify the location of the cleaning cartridges. 
See “Generating and Saving Reports” on page 26.

Note – If you want to import the cleaning cartridges into the library slots one cartridge 
at a time, use the Recovery Move diagnostic utility. See “Performing a Recovery Move” 
on page 73.

Exporting Cleaning Cartridges Through the CAP

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00 or 
higher) and then upgrade the library firmware to the SL500 code level 1092 or higher.

When one or more cleaning cartridges have expired, export them from the library slots 
to the CAP.

Before you export cleaning cartridges through the CAP, make sure that the CAP slots are empty.

To export the expired cleaning cartridges:

1. From the Library Console, select Tools > Diagnostics.

2. Select + to expand the CAP folder

3. Highlight the CAP

4. Select the Import/Export tab.

5. Do one of the following:

■ To export only the expired cleaning cartridges, select the Export expired cleaning 
cartridges option.

■ To export all the cleaning and diagnostic cartridges, select the Export all 
cleaning/diagnostic cartridges option.

6. Select the Start button from the upper right corner of the screen.

The robot places all the expired cleaning cartridges into the CAP slots.

7. Press the Open CAP button on the keypad.

The robot opens the CAPs and the Open CAP LED turns on.

The Import/Export Console displays the status of the export operation. 

8. With the CAP open, remove the exported cartridges. 

You can remove the cartridges from the magazine inside the CAP. Or, you can remove 
the magazine from the CAP, press the red release button, and take the cartridges from 
the magazine.

9. If you removed the magazine from the CAP, place the magazine onto the door rails 
and slide it back inside the CAP.
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10. Close the CAP doors.

Note – If you want to export the cleaning or diagnostic cartridges from the library slots 
one at a time, use the Recovery Move diagnostic utility. See “Performing a Recovery 
Move” on page 73.

Transferring Files From the RLC Card
You can use the Transfer File utility to copy the Management Information Base (MIB) 
text file from the RLC card to a folder on your personal computer. A MIB text file 
contains a collection of information stored in a database that includes configuration and 
statistical information for a managed device. A copy of the MIB is loaded with 
firmware and stored on the RLC card.

The MIB is a viewable document that contains descriptions about the characteristics for 
a managed device. These characteristics are the functional elements for that device 
which can be monitored using Simple Network Management Protocol (SNMP) 
software. SNMP allows systems administrators to query the library for configuration, 
operation, and statistical information. SNMP also allows the library to inform the 
systems administrator of potential problems.

Note – The library must support SNMP for the Library Console to access and copy the 
MIB text file from the RLC card.

To copy the MIB file:

1. Select Tools > Diagnostics. 

2. Select the TransferFile tab. 

3. Copy the MIB text file to your PC:

a. Select the Transfer button next to the file 
STREAMLINE_TAPE_LIBRARY_MIB_TEXT.txt.

b. From the Save dialog box, select a Save in folder, and then type a file name.

c. Select Save.

If the file exists, the system prompts you to verify replacing the existing file.
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Performing Self Tests

Note – This feature requires that you install SLConsole code FRS 3.10 (2.33.00) and 
then upgrade the library firmware to the SL500 code level 1092.

The self test diagnostic utility can be run as a minimal-functional test when the library 
is installed and later periodically to help diagnose basic problems with library 
operations. The routines are non-disruptive.

You can perform a self test for the entire library or for each device separately.

The library self test does the following:

■ Checks the communication path between the RLC card, tape drives, and robot

■ Performs get and put operations to check the health of the robot and CAP, including 
operations from a reserved slot to a random:

■ Storage slot

■ CAP 

■ Corner slot

■ Performs an audit of the library

■ Mounts and dismounts diagnostics cartridges into tape drives

Before running a self test, make sure that a diagnostic cartridge is placed in a 
reserved slot for each type of tape drive. The self test is repeated for each type of tape 
drive.

Note – A diagnostic cartridge is a blank data cartridge that has the code DG in the 
volume label (for example, DG0001L3).

Library Self Tests
To perform a library self test 

1. Select Tools > Diagnostics.

2. From the device tree, highlight the Library folder 

3. Select the SelfTest tab.

Note – The self-test screen displays a Mode field with two options: disruptive and 
non-disruptive. At present, choosing either option performs the self-test routines 
described above.

4. Select the Run tab from the top right corner of the screen.
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Device Self Tests
The device self test is available for the tape drives.

To perform a device self test 

1. Select Tools > Diagnostics.

2. From the device tree, highlight the specific device folder.

3. Expand the device folder.

4. Select the specific device based on the location.

5. Select the SelfTest tab.

6. Select the Run tab from the top right corner of the screen.

Note – At present, the drive self test performs the same routines as the library self test.

CLI Reports and Monitors
The CLI provides reports and monitors to help diagnose a problem with the library and 
the attached devices. To use the StorageTek Library Console for reports and monitors, 
see “Generating and Saving Reports” on page 26 and “Monitoring Events” on page 30.

To capture logs using the CLI "print log all" command:

print log  <all> | <error> | <warning> | <info> | <trace> | <diag>

Print one or all of the library's diagnostic logs. To create a text file of the log using 
HyperTerminal, enable text capture to a local file before printing the desired log.

Example:

> print log all

           log_error:     

2004-09-20T19:21:45.636,      0.0.0.0.0, 3200, interface-manager, (null), error, 3000, 
3312, "(request id = Diagnostic/0x100b0878) IfmMove::commonMoveCommand(): 
FETCH request failed:" 
2004-09-20T19:21:45.644,     0.0.0.0.0, 3670,  diag, (null),  error, 3683, 3312, "(request id 
= Service/0x1009f6e8) DiagGetPut()Diagnostic Get/Put  ...completionCode==1 " 
2004-09-21T10:57:11.902,     0.0.0.0.0, 3670,  diag, (null),  error, 3683, 3302, "(request id 
= Service/0x100a02c8) DiagGetPut()Diagnostic Get/Put  ...completionCode==1 "
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Controls and Indicators

Note – For tape drive controls and indicators, refer to the vendor publications and Web 
sites.

The following tables and figure list and describe the controls and indicators.

TABLE 1-2 RLC Card Indicators

Indicator Description

EJECT OK Indicator 
Unused.

FAULT Indicator 
LED flashes red when the controller has detected a problem.

STANDBY Indicator 
Unused.

ACTIVE Indicator 
LED is solid green when the RLC card is the active card.

TABLE 1-3 Drive Tray LED

Activity Meaning Action

On solid The drive fan failed, the temperature is too 
high.

Replace the fan.

TABLE 1-4 Power Supply LED

Activity Meaning Action

On Power supply is active. Nothing, this is normal.

Off The power supply failed. Replace the power supply.

The power supply is not receiving power. Check the connections and AC voltage. 
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Under normal conditions, at power-on, all keypad LEDs are solidly lit. Once library 
applications begin:

1. All keypad LEDs turn off.

2. The Library Active LED flashes until the audit is complete, then turns off.

3. The Library Active LED turns on at the start of each command, then turns off when 
each command is completed.

4. The Library Active LED flashes when the library is active.

TABLE 1-5 provides a basic description of the keypad buttons and indicators. TABLE 1-6 
provide more details for troubleshooting. 

FIGURE 1-1 Keypad

1. Open Door button 5. Service Required indicator 

2. Open Door indicator 6. Library Active indicator

3. Open CAP button 7. Service Robot indicator 

4. Open CAP indicator

1 32 4

57

6

L204_231
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TABLE 1-5 Keypad Buttons and Indicators

Buttons/Indicator Description

Service Robot Indicator
LED is lit when the robot is not functioning. 
Check the log_error file for the result code. Use the code to determine 
the appropriate action.

Library Active Indicator
LED is active when the library is active.

Service Required 
See TABLE 1-6 for details.

Indicator
■ LED is normally not lit.
■ LED is lit when the library experiences a failure or is in a non-ready 

state. 

Open Door Indicator
■ LED flashes amber when the Open Door button is pressed.
■ LED is solid amber when the robot is parked in the robotics unit.
■ LED flashes during initialization and audit.
■ LED is not lit when the library is ready for customer use.
Button 
When pressed:
1. Software allows the current job to complete. This could take a while.
2. Software retracts the robot into the robotics unit so that it will not be 

damaged when you open the door with the key.

Open CAP Indicator 
■ LED is amber when any CAP doors are open.
■ LED is not lit when all CAP doors are shut.
Button 
Button is used to open all CAP doors in a rack.

TABLE 1-6 Keypad Service Required LED

Activity Meaning Action

Flashing Component failure. Replace the failed component, such as power 
supply, tape drive, or fan. Use the StorageTek 
Library Console or command line interface 
to check the log_error file for the result code.

Diagnostics are running. Nothing, this is normal.

Diagnostics failed. Check the log_error file for the result code. 
Use the code to determine the appropriate 
action.

Door is open. Close and lock the door.

On solid The library has stopped operating Check the log_error and log_warning files to 
determine which component failed. Replace 
the failed component.
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CHAPTER 2

Fault Isolation Considerations

This chapter contains questions, answers, and actions to help isolate and resolve 
problems with the library and FRUs. Some of the problems identified by result codes 
are described in Chapters 6 through 11.

Determine Library Faults
To determine if the library is at fault:

1. Is the library communicating through the operator panel or CLI?

No: The library is likely at fault. Restart the system to establish an operator panel or 
CLI session.

Yes: Continue...

2. Does the library log have error entries?

No: The site configuration, host, or network is likely at fault. Check the library and host 
logs for configuration activity. Run site network and connectivity tests.

Note – StorageTek Library Console error log entries indicate an unrecoverable fault. 
This means that the job that the host requested could not be completed, resulting in an 
error log entry. Other faults, such as retry operations due to mechanism errors, are 
logged at a warning severity.

Yes: Continue...

3. Does the library log have error entries associated with the host fault?

No: The site configuration, host, or network is likely at fault.

Yes: The library is at fault. Determine which library FRU is at fault.
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Determine Library FRU Faults
After the library has been established as the source of a fault, identify the 
nonfunctioning FRU.

Locating the FRU problems in the logs involves:

1. Finding the first error log entry associated with the FRU and the fault.

2. Getting the activity and result information from the log entry.

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector into the 
CLI port. A potential power surge could cause a fire or damage to the RLC card.

To determine the current operational state of the FRU using the operator panel or CLI:

■ If the current state is “online,” then the fault was transient and the FRU is still 
functioning in the library.

■ If the current state is anything else, then the FRU requires operator intervention for 
fault resolution.

Determine Why the FRU Failed
To determine why the FRU failed:

1. Did a power problem occur?

Power faults are recorded in the library log.

2. Did a configuration problem occur?

Configuration activity is recorded in the library log. FRUs indicate errors if invalid 
or inappropriate configuration activity was performed.

3. Did a transient mechanism failure occur?

Mechanism failures are recorded in the library log. The mechanism FRU is “online” 
after a transient failure, but the history of the failure is recorded.

4. Did a permanent mechanism failure occur?

The mechanism FRU is not “online” after a permanent failure and the mechanism 
fails further diagnostics or attempts to make the FRU operational.

5. Did a logical fault occur?

Logical faults can be present when the library or a FRU is commanded to perform a 
perceived impossible activity. Such faults also can be present due to internal 
firmware errors.

Resolution activity following logical faults may be the most significant challenge 
facing service representatives. This activity requires use of the Oracle-provided 
resolution activity database and associated documents.
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Resolve the Problem
Now that you have isolated the problem, query the Oracle service database or 
documentation to resolve it.

Make sure that you know:
■ The system's serial number
■ The activity and result code from the pertinent log entries
■ The FRU type

Further information queries that all operators and administrators can perform are:

Caution – Possible equipment damage: The library, tape drive, and StorageTek Library 
Console firmware must be at compatible levels. Refer to the firmware information on 
the Web sites supplied in “Documentation, Support, and Training” on page xiv.

■ Firmware version
■ Tape drive firmware and hardware version
■ Tape drive types and configuration
■ Host interface types and configuration

Likely resolution activities include:
■ Run diagnostic tests to verify faults and/or reset the FRU.
■ Update firmware (library or tape drive).
■ Replace the FRU when directed by service representatives.
■ Verify the FRU initialization and “online” state.
■ Run diagnostic tests to verify normal operation.

Key diagnostic tests that operators and administrators can perform are:
■ Communication to the FRU
■ Physical audit of a location
■ Basic health check
■ Mechanism motion

Gather Configuration Information
Knowing how the system is configured is often essential to diagnosing a problem:

Capture the output text from the following commands and place it in a file named 
xxxxxxxxxxxx.txt. The name is the 12-digit SL500 serial number from the label on the 
back of the library.

version print 
lib getconfig 
drive x,x,x,x getconfig 
libstate 
frameinfo print 
drive x,x,x,x state (for each drive present
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Send Information to Headquarters
If you need to escalate the problem to headquarters, send logs and configuration 
information to Tier-3:

         E-Mail: LSV Tier3 Tape

         Attention: HQ T-3 OS Tape Support 

Include your clarify case number(s) for installation.

Log Severity Levels
Each event posted to the system's event log includes a severity level:

Error (1)
A fault has occurred that prevented a request (host or diagnostic) from completing 
successfully. Error data is saved to non-volatile resources and accumulates across 
machine power cycles.

Warning (2)
A fault has occurred, but it has not stopped the machine's ability to complete requests 
(host or diagnostic). Warning data is saved to non-volatile resources and accumulates 
across machine power cycles.

Information (3)
Event data can normally be ignored, but might be important to establish a history of 
activity around a error or warning event. Information data is not stored in non-volatile 
resources. This severity level does not address or include the issue of engineering trace 
data.

Configuration (4)
The machine's configuration has changed. This includes the addition and removal of 
tape drives, robots, controllers, or interface cards. This also includes changes to 
software configuration. Configuration data is saved to non-volatile resources and 
accumulates across machine power cycles.
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Diagnostic (5)
Normal diagnostic activity tracing is done. The tracing is separated from debug/trace 
activity in the event that the diagnostic activity affects the availability of tape drives or 
other machine hardware to host operations. Diagnostic data is not stored in non-
volatile resources.
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CHAPTER 3

Diagnostic Tests

This chapter describes the tests used to check the functionality of the library 
components and lists the CLI service commands.

Primary Robotic Functions
Four primary robotic functions are tested:
■ Get—Retrieve a cartridge from a storage slot, CAP, or tape drive.
■ Put—Insert a cartridge into a storage slot, CAP, or tape drive.
■ Read Targets—Read the targets at representative slot locations.
■ Read Label—Read the cartridge bar-code label at representative locations.

Those four functions are tested at the applicable locations:
■ Storage slots
■ Tape drives
■ CAP

Unless specified otherwise, you can invoke the diagnostic tests by using the:
■ Command line interface (CLI)
■ Local operator panel
■ Remote operator panel
■ SCSI Send Diagnostics command

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector into the 
RESERVED or CLI ports. A potential power surge could cause a fire or damage to the 
RLC card.
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Accessing the Command Line Interface

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector into the 
CLI port. A potential power surge could cause a fire or damage to the RLC card.

1. Attach your PC’s serial cable to the connector marked CLI on the RLC card at the rear 
of the library.

For UNIX users:

2. Add the following line to the /etc/remote file:

L500:\ 
:dv=/dev/term/b:br#38400:el=^C^S^Q^U^D:ie=%$:oe=^D:

3. Connect to Port b on the UNIX server.

Note – You could also type term/a: and connect to Port a.

4. Type tip L500.

5. Continue to Step 6 under For HyperTerminal and UNIX users:

For Hyperterminal users:

1. Open a Hyperterminal session:

■ For older PCs, click Start>Programs>Accessories>Hyperterminal, and open a 
Hyperterminal session.

■ For WIN2000 PCs, select Start>Programs>Accessories 
Communications>Hyperterminal, and open a Hyperterminal session.

2. New sessions prompt you for a name and icon. Choose any name and any icon.

A connection window appears.

3. Select COM1 from the Connect using the pull down menu.
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4. Enter the following port settings:

5. Once configured, click OK and press Enter.
The command line interface (CLI) prompt appears. (If it does not, disconnect then 
connect from the Call tab for new settings to become effective.)

For Hyperterminal and UNIX users:

6. At the logon prompt, type service.

7. Type Yes at the prompt that asks Are you sure you want to continue? 

The password prompt appears.

8. Enter your password.

TABLE 3-1 Hyperterminal Connection:

Older PCs WIN2000 PCs

Baud rate = 38,400 Baud rate = 38,400

Data bits = 8 Data bits = 8

Parity bit = None Parity bit = None

Stop bit = 1 Stop bit = 1

Direct to comm flow = none Hardware flow control = xon/xoff
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Primary Diagnostic Commands
The following sections describe some of the primary diagnostic commands. See 
TABLE 3-3 on page 59 for more commands and the latest verbiage.

Make sure that a diagnostic cartridge with DG on the label is in a reserved slot, such as slot 
0,1,1,1. The command to create the reserved slot location is:

reserved <number of cells> | <print>

diagdemo
<diagdemo> <count> <mode>

This command moves any cartridge from a random source to a random destination.

The two mode values are silent and nonsilent.

■ Silent mode returns only the ending status.

■ Non-silent mode returns the current (loop) count value.

Example: diagdemo 200 nonsilent

diaggetput
<diaggetput> <diag type> <source addr> <destination addr> <count> <mode>

This command moves the diagnostic cartridge from the specified or random source to a 
specified or random destination.

The two diagnostic types for this command are:

■ cellToCell

cellToCell uses either a specified or random diagnostic cartridge as long as the 
cartridge is in a reserved location. The diagnostic cartridge is moved to an empty 
storage or CAP slot and then back to its original starting location.

Example: diaggetput cellToCell 0,1,2,1 0,1,3,3 10 silent

Example: diaggetput cellToCell random random 5 nonsilent

■ cellToDrive

cellToDrive uses a specified diagnostic cartridge from a reserved location. The 
destination can be all drives or one specific drive. The drive location will always 
have an ending column address of nine. 

Example: diaggetput cellToDrive 0,1,2,1 0,1,2,9 5 nonsilent

Example: diaggetput cellToDrive 0,1,3,2 all 5 silent
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diagquery
<diagquery> <diag type> <count> <mode>

This command performs a basic health check of the library.

Example: diagquery basicHealth 10 silent

Example: diagquery basicHealth 10 nonsilent

diagselftest
<diagselftest> <src address> <loop count> <mode>

This command:

■ Performs the library basic health diagnostic

■ Performs get/put operations from the src address to random empty slots in the 
library

■ Performs mounts from the src address to all tape drives attached to the library

Example: diagselftest 0,1,1,1 2 silent

Example: diagselftest 0,2,1,1 3 nonsilent 

Silent mode returns only the ending status. Non-silent mode returns the current 
(loop) count value, in this case for three loops

diagstop
<diagstop>

This command stops the diagnostic in progress at the start of the next iteration, if more 
than one was specified.

Example: diagstop

diagdoor
<diagdoor>

This interactive command is used to determine if the door sensor and LED are 
functioning.

Example: diagdoor

Note – When this diagnostic is finished, the library performs an audit to ensure the 
locations of cartridges.
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CLI Commands

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector into the 
RESERVED or CLI ports. A potential power surge could cause a fire or damage to the 
RLC card.

This table lists service commands that are input from the command line interface (CLI). 
You can also type help all for a list of all available commands. Make sure that you have 
the latest firmware loaded onto your library. 

TABLE 3-2 CLI Commands for Library Configuration  

allowpartitions <print|on|off>

See note ------------------------------------->

Enables/disables the partitioning feature.

Note – This applies only to downlevel 
firmware version 1230. This command 
is not used with version 1300 or later.

activation Activates a feature for the library.

activation reset <sequence number> Delete the hardware activation key as specified by the 
sequence number under activation print

autoclean print Shows the library's current setting

autoclean <on|off> Sets the auto clean option on or off. On causes tape drives to 
be automatically cleaned when needed. Off disables 
automatic cleaning. If the host software is handling tape drive 
cleaning, set the option to off.

cap <module#> <io|storage> Configures the specific module’s CAP as input/output or 
storage

cartridge print Shows the location, volume serial number, and media type for 
all cartridges

cartridge print reserved Shows the location, volume serial number, and media type for 
reserved cartridges

clearcartcount print Shows the library's current list of cleaning cartridges and 
cleaning counts

clearcartcount <label> count Sets the number of times a particular cleaning cartridge can 
be used. The cartridge must be in the cleaning list. The 
cleaning list is not complete until the audit is finished.

cleanwarnthreshold print Shows the library's current warning threshold count for 
cleaning cartridges

cleanwarnthreshold <count> <drivetype> Sets a warning threshold count for the number of cleans a 
cartridge can perform for a given tape drive type before a 
warning is issued.  <drivetype> is “lto” or “dlt”. If the value 
is set to 0, no warning is issued.

lib getconfig Shows the library configuration
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lib setconfig Sets the specified library's Fibre Channel or SCSI 
configuration

orientlabel <host|oppanel> 
<all|left8|left7|left6|right6|right7|right8> 
<partition>See Note at Right

Sets the host orientlabel parameter. This option causes the 
bar-code label on the cartridge to be presented to the host 
interface as all or fewer characters, selected from the left or 
right of the physical label.
Note: For partitioned libraries, you must enter the label 
orientation for each partition (the “<partition>” field has been 
added for this feature.

resetactivation Removes a previously activated feature from the library.

upsidedowndetect <on|off> Sets the upsidedowndetect option. On is the default setting 
and allows the library to detect upside down SDLT cartridges 
in mixed-media libraries. Off disables the checking function.

TABLE 3-3 CLI Service Commands 

Command Description

autoclean print Shows the library's current autoclean setting.

autoclean <on|off> Sets the auto clean option on or off. On causes tape drives 
to be automatically cleaned when needed. Off disables 
automatic cleaning. If the host software is handling tape 
drive cleaning, set the option to off.

cap <module#> <io|storage> Configures the specific module’s CAP as input/output or 
storage.

cartridge print Shows the location, volume serial number, and media type 
for all cartridges.

cartridge print reserved Shows the location, volume serial number, and media type 
for reserved cartridges.

cleancartcount print Shows the library's current list of cleaning cartridges and 
cleaning counts.

cleancartcount <label> count Sets the number of times a particular cleaning cartridge can 
be used. The cartridge must be in the cleaning list. The 
cleaning list is not complete until the audit is finished.

cleanwarnthreshold print Shows the library's current warning threshold count for 
cleaning cartridges.

cleanwarnthreshold <count> <drivetype> Sets a warning threshold count for the number of cleans a 
cartridge can perform for a given tape drive type before a 
warning is issued.  <drivetype> is “lto” or “dlt”. If the 
value is set to 0, no warning is issued.

codeload filename Loads in a new code image.

date <print> | <mm/dd/yyyy> Prints or sets the library calendar date. Takes the library off 
network time if set.

diagcaps Diagnoses the CAPs.

diagdemo <diagdemo> <count> <mode> Moves any cartridge from a random source to a random 
destination.

diagdoor Diagnoses the front door functionality.

TABLE 3-2 CLI Commands for Library Configuration  (Continued)
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diaggetput <diaggetput> <diag type> <source 
addr|random> <destination addr|random|all> 
<count> <mode>

Moves a diagnostic cartridge from a specified or random 
source to a specified or random destination. The “all” 
parameter refers to all the tape drives.

diagquery <diagquery> <diag type> <count> 
<mode>

Performs a library basic health diagnostic test.

diagselftest <src address> <loop count> <mode> Performs a library basic health diagnostic.
Does get/put operations from src address to random empty 
slots in library.
Performs mounts from the src address to all tape drives 
attached to library.
Note: The test requires at least one cartridge and its 
compatible tape drive.

diagstop Stops the “diag” operation.

drive all Shows information for all tape drives.

drive <addr> clean Cleans the specified tape drive. A label may be specified 
when prompted.

drive <addr> getconfig Shows a specified tape drive's Fibre Channel or SCSI 
configuration.

drive <addr> gettime Shows a specified tape drive's time of day (TOD) clock 
setting.

drive <addr> info Shows a specified tape drive’s information.

drive <addr> setconfig Sets a specified tape drive's Fibre Channel or SCSI 
configuration.

drive <addr> settime Sets a specified tape drive's time of day (TOD) clock.

drive <addr> state Shows a specified tape drive’s operational state.

entereject <entereject> <type> When <type> is “enter”, the CAP door opens for you to 
enter the diagnostic and cleaning cartridges.
When <type> is “eject”, you are prompted to enter the 
cartridges to be ejected.
The CAP door opens if any cartridges are moved to the 
CAP magazine.
Examples: "entereject enter" or "entereject eject".

fastload print Shows the library’s current fastload setting.

fastload <on|off) Sets the fastload on/off option.
This option controls whether or not the library performs a 
fastload when loading tape drives.
Setting the option to “off” causes normal tape drive loads. 
This is the default.
Setting the option to “on” causes fastloads to be used.
Note: Fastloads do not wait for the tape drive to be ready 
after the load command has been issued.

frameinfo print Shows the library's frame information (frame serial number, 
World Wide Name (WWN)) and vendor.

help all | name_of_command Shows the command syntax.

lib getconfig Shows the library’s Fibre Channel or SCSI configuration.

TABLE 3-3 CLI Service Commands (Continued)

Command Description
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lib setconfig Sets the specified library's Fibre Channel or SCSI 
configuration.

libstate print Shows the state and location of all mechanisms, for 
example:
Library State: READY
CAP Status: CAP Media Removal: ALLOWED
CAP Access State: CLOSED
CAP Door Sensors: Module 1: CLOSED

log clear all Clears the contents of all logs (such as error, warning, info, 
trace).

log clear log_scsi_ck Caution: Removes the log_scsi-ck file.

move <source addr> <dest addr> Moves the cartridge from a specified source to a specified 
destination. This also can be used to verify that the robot 
can reach the lowest cell in the library before turning the 
library over to the customer.

network gateway <IP address | none> Sets the gateway address to the specified IP address.

network ip <IP address> Sets the library’s IP address to the specified IP address.

network mask <IP address> Sets the library’s subnet mask to the specified IP address.

network name <machine network name> Sets the library’s machine name to a specified host ID.

network print Shows all network information and configuration.

network restart Restarts the library's network interface.
Configure all network parameters before issuing this 
command.

orientlabel print Prints the library’s current host and operator panel setting 
of the orientlabel variables.

orientlabel <host|oppanel> 
<all|left8pre|left8|left7|left6|right6|right7 
|right8>

Ask the customers how they want the VOLID to 
be reported over SCSI. Once the format is chosen, 
it can’t usually be changed, as downstream 
applications depend on this format.

For right and left options, on the physical label, 
the two right-most characters must be the Oracle 
Storagetek standard Media Domain and Media 
Type for 8-character labels, or the right- most 
character be the media type for 7-character labels.

Sets either the host (Oracle StorageTek) or operator panel 
orientlabel parameter. This option causes the bar-code label 
on the cartridge to be presented to a specified interface 
( host or operator panel ) as fewer character and justified 
left or right.
The orientation setting “all” presents the entire label. When 
this setting is in effect, it is assumed there are no domain 
and type fields, and none are returned or checked for 
compatibility.
The orientation setting “left” starts using barcode characters 
from the left and proceeding to the number specified. 
The orientation setting “right” starts using barcode 
characters from the right and proceeding to the number 
specified. 
The setting left8pre prefixes the label with the last two 
characters.
Example: For barcode ABCDEFGH:
setting left7 shows ABCDEFG
setting all shows ABCDEFGH
setting left8pre shows GHABCDEF
setting right6 shows CDEFGH

TABLE 3-3 CLI Service Commands (Continued)

Command Description
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park Parks the robot in the home position inside the robotics unit 
so the robot can be removed. You must reboot the library to return 
it to active status by either power cycling the library or by 
issuing a CLI reboot command.
Caution: The robotics unit MUST be removed with the 
power off. If you change your mind after issuing the park 
command and do not replace the robotics unit, you still 
must power cycle the library or issue a CLI reboot 
command. Do not open and close the door to reboot the library.

print log <all> | <error> | <warning> | <info> | 
<trace.0>| <trace> | diag | <config>| <scsi> | 
<scsi_ck> | <syslog> | <snmpd>

Prints the specified logs to the console. If desired, the 
console can be captured to a file for transfer. To create a text 
file of the log using HyperTerminal, enable text capture to a 
local file before printing the desired log.

put <dest addr> Places the cartridge from the robot hand into the specified 
address.

range <track | z | wrist | reach | grip> Shows the range in motion of the mechanism in tachometer 
counts.

reboot Restarts the operating system and initialization.

recalibrate <address> Recalibrates a single specified address.

recalibrate <start address> <end address> Recalibrates a range of addresses.

recalibrate all Recalibrates the entire library.

reserved <number of cells> Sets the maximum number of slots for diagnostic and 
cleaning cartridges in the library.

reserved <print> Prints the current number of reserved slots.

resetdefaults Resets the library defaults. For example: 
admin password unset, CAPs=I/O, barcode is 6 characters 
(left6) left aligned for host,
barcode is 8 characters (left8) left aligned for oppanel, 
reserved slots=0, inventory load labels required, service 
inventory off

resetpw <admin> | <oem> | <service> | 
<oppanel> | <all> | <all>

Places the specified login password back to the “needs 
activated” state when the password is forgotten. The CSE 
obtains another activation password for the login, and, 
when asked, enters a new custom password. 

scanaudit print Shows the library’s current scanaudit option setting

scanaudit <on|off> Sets the scanaudit option. The on setting makes hard-to-
read labels more difficult to read, but the process is faster 
than reading each individual location.The default is on for 
mixed-media libraries and off for LTO-only libraries.

shutdown Causes an orderly shutdown of the library before replacing 
the RLM card. You must power-cycle the library after the 
card is replaced.

TABLE 3-3 CLI Service Commands (Continued)

Command Description
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snmp addTrapRecipient
    trapLevel <trapLevelString> 
    host <hostName | hostAddr> 
    version <v2c community <communityString>
        | 
       v3 name <trapUserName>
       auth <MD5 | SHA>
       authPass <authPassPhrase>
       [priv <DES | AES>
       privPass <privPassPhrase>]
       engineId <engineIdString>> 

Adds an SNMP trap recipient.
trapLevelString is a single digit or a comma separated list 
of digits 1,2,3,4,... 
hostName | hostAddr need to be fully qualified.
The engine ID is a string of at most 31 hex characters, 
preceded with 0x.

snmp addUser
   version <v2c community <communityString>
       | 
       v3 name <trapUserName>
       auth <MD5 | SHA>
       authPass <authPassPhrase>
       [priv <DES | AES>
       privPass <privPassPhrase>]

Adds an SNMP user.

snmp deleteTrapRecipient
    <id <index>
       | 
       host <hostName | hostAddr>
       version <v2c community <communityString>
       | 
       v3 name <trapUserName> > >

Deletes an SNMP trap recipient.

The <hostName | hostAddr> need to be fully qualified.

snmp deleteUser
    <id <index>
       |
       version <v2c community <communityString>
       |
       v3 name <userName> > >

Deletes an SNMP user.

snmp disable port<portID> Disables SNMP for the specified port.

snmp enable port<portID> Enables SNMP for the specified port.
Note: port1B is the public interface

Port 1A, 2A, and 2B are currently unavailable on this 
library.

snmp listTrapRecipients Lists all the trap recipients.

snmp listUsers Lists all SNMP users.

statistics <reset | print> Shows or resets the total number of get/put operations and 
retries.

TABLE 3-3 CLI Service Commands (Continued)

Command Description
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time <print> | <network> | <hh:mm:ss> | 
<hh:mm>

Prints or sets the library's time value. Takes the library off 
of
network time if set. 
The network option re-enables network time.
Depending on the network, it may take several minutes to 
revert back to network time.

trace <trace type> on/off
Example: trace tti-dbg-01 on
Example: trace tti-dbg-18 off
Example: trace interface manager-debug on

Turns tti debug log trace on for drive id 1
Turns tti debug log trace off for drive id 18
Turns IFM debug log trace on
List of Trace Type Strings That Can Be Used With Trace:
    tti-dbg-xx ( xx is the drive id )
    drive-tti-xx ( xx is the drive id )
    scsi
    scsi-engine
    scsi-server
    interface-manager
    interface-manager-debug
    diag
    event-manager
    OpPanel
    service-interface
    VMonitor
    object-data-store
    access-manager
    sensor-manager
    opel-server
    move-sequence
    lms

upsidedowndetect print Shows the library’s current upsidedowndetect setting.

upsidedowndetect <on|off> Sets the upsidedowndetect option. On is the default setting 
and allows the mixed-media library to detect upside down 
SDLT cartridges. Off disables the checking function.
Note: LTO cartridges can not be placed upside down into a 
library slot.

version print Shows all of the library version information

TABLE 3-3 CLI Service Commands (Continued)

Command Description



96153 • Revision NA Chapter 3  65 
Oracle Confidential: Internal and Authorized Service Partner Use Only

This table lists operations and information that are not diagnostics but are useful in the 
servicing of the library.

StorageTek Library Console Move 
Utilities
This section describes how to perform a diagnostic move and a recovery move. For 
more information about StorageTek Library Console, see “Using StorageTek Library 
Console” on page 8 through “Installing StorageTek Library Console” on page 14.

Performing a Diagnostic Move
This utility moves a cartridge from one location to another, then returns it to its original 
location. This activity can help you diagnose a problem with the robot. 

Note – The utility can be run within a cartridge. The get/put operations are not 
performed. The robot just positions itself at the target and source addresses.

Before moving any cartridge, generate a cartridge summary report that shows the 
contents of slots in the library. This report will help you determine which slots are 
available for use and which cartridges may have to be moved to obtain their slot. See 
“Generating and Saving Reports” on page 26.

The target address range defines the location parameters in a library within which the 
diagnostic move performs the get operation. The two types of access orders for a target 
address are: 
■ Sequential access order

■ Random access order

TABLE 3-4 Non-diagnostic Operations and Information

Type Description

General Status Provides the states and status for the library, front door, CAP, and tape drives

Environmentals Status Provides the status of all power supplies, fans, and temperature for the library 
and tape drives

Reboot Reboots the library or specific tape drive

Media error table Reports on the media errors
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Sequential Access Order
In a sequential access order, the robot performs a get operation starting with the first 
location in the target address ranges and then continues moving to the locations 
sequentially through the range until it completes the requested number of moves.

Robot visits a
full location in 

the pool
address range

and gets a 
cartridge 

Is this 
location
Empty

?

Robot visits the 1st
location in the target

address range

Robot visits the
empty location it
accessed in the
target address
range and puts
the cartridge in

that target
address

Robot gets the
cartridge and
returns the

cartridge to its
original location in

pool address
range

Robot gets the
cartridge and
puts it in an

empty location in
the pool address

range

Robot returns the
cartridge in its

original location
in the target

address range

Is
move count
complete

?

End

Robot visits the
next sequential
location in the 
target address

range
L203_866

Yes

No

Yes

No

Sequential Access Order
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Random Access Order
In a random access order, the robot randomly picks a location in the target address 
range to get a cartridge. The robot might also move to the same location in the target 
address range multiple times to get a cartridge. The tool ends this random access 
routine after the requested number of moves is complete.

Robot visits a full location in 
the pool address range

and gets a cartridge 

Is this 
location
Empty

?

Robot visits a random location 
in the targetaddress range

Robot visits the 
empty  location it 
accessed in the

target address range 
and puts the cartridge 
inthat  target address

Robot gets the 
cartridge and returns 

the cartridge to its 
original location in pool 

address range

Robot gets the cartridge
 and puts it in an empty

location in the pool
address range

Is
move count

complete
?

End

Robot returns the 
cartridge to its original 
location in the target 

address range

L203_867

Yes

No

Yes

No

Random Access Order
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Defining a Diagnostic Move
Multiple diagnostic move routines can be set up and run simultaneously as long as the 
target and source address ranges do not overlap.

To define a diagnostic move:

1. Select Tools > Diagnostics. 
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2. Select the DiagMove tab. 

3. Select Add from the Defined Sequence section.
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4. Select the appropriate mode and target addresses.

5. Select Next to proceed further or Previous to modify the target address range.
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6. Select the appropriate mode and source addresses.

7. Select Next to proceed further or Previous to modify the source address range.
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8. Define the following:
■ Name of the diagnostic move
■ Move Count (specify a number between 1 and 5000)
■ Access order (Sequential or Random)
■ Move Type (Robot & Cartridge or Robot Only) 

9. Select Previous to go back one screen and modify the target or source address range 
or Finish to complete the setup.
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Performing a Recovery Move
This utility moves a cartridge from a source location (CAP, cartridge slot, or tape drive) 
to a destination (CAP or storage cell only). For example, if you want to replace a 
cleaning cartridge that has expired:

1. Move the cartridge to a CAP slot and then perform an eject.

2. Enter the new cleaning cartridge into a CAP slot.

3. Move the cartridge from the CAP slot to a reserved slot.

Before moving any cartridge, generate a cartridge summary report that shows the 
contents of slots in the library. This report will help you determine which slots are 
available for use and which cartridges may have to be moved to obtain their slot. See 
“Generating and Saving Reports” on page 26.

To move a cartridge:

1. Select Tools > Diagnostics. 
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2. Select the RcvrMove tab. 

3. Define the source location parameters by first selecting the Mode (Location or 
Volume ID).

To move a cartridge by the slot address:

a. Select the Mode as location.

b. Select Type (CAP, Cell, or Drive) from the pull-down menu. 

c. Select the Library, Module, Row, and Column address from the pull-down menus. 

To move the cartridge by volume ID:

a. Select the Mode as VOLID.

b. Type the volume IDHID_VOLID of the cartridge to move. 

4. Select the destination location parameters:

a. Select Type (CAP or Storage Cell) from the pull-down menu. 

b. Select the Library, Module, Row, and Column address from the pull-down menus. 

5. Select the Start tab from the top right corner of the screen.

6. If the system cannot successfully move the cartridge, select Problem Details to see a 
list of possible causes and suggested actions to correct the error. 
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7. If the move is successful, the system displays the Successfully moved screen. Select 
OK. 
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CHAPTER 4

Firmware Download

Some problems can be resolved by downloading the correct version of firmware for the 
components. This chapter describes how to download library firmware, also called 
code.

The initial library firmware for all new libraries is installed in the factory and resides on 
the RLC card.

You can upgrade your library by installing new firmware obtained from the 
https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login Web site.

Caution – Possible equipment damage: The library, tape drive, and StorageTek Library 
Console firmware must be at compatible levels. Refer to the links supplied in 
“Documentation, Support, and Training” on page xiv.

Caution – System problems: Always quiesce or stop the tape management software 
before you start the upgrade procedure.

Caution – Hardware damage: Do not manually cycle power during the upgrade 
procedure, or you will damage the RLC card and will need to order a new card.

Before you perform the following procedure, make sure that you:

1. Close the front door

2. Initialize the library

You can download firmware by using either:
■ StorageTek Library Console
■ putty and pscp

https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
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Using Library Console to Download 
Firmware 
This application requires Library Console firmware level 2.20 or above and SL500 
library firmware level 1022 or above. If your firmware is not at this level, use putty and 
pscp to download that level firmware.

The SL500 code does not contain the upgrades for the different drive types.

Note – In this section, firmware is also referred to as “code.”

The initial library code is factory-installed on all libraries and resides within a flash 
memory on the RLC card. 

Before launching the code load utility, download the firmware upgrade package (.IMG 
file) from https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login to a folder on your 
PC.

Note – The SL500 library firmware package is a .IMG (image) file.

Loading code is a three-step process:

1. Downloading the firmware package containing the code from the source location on 
your PC (the folder to which you downloaded the code file from https://dlrequest-
zn-dlapps1.sfbay.sun.com/usr/login to the RLC card. This process also unpacks the 
packages after downloading to make it ready for activation.

2. Activating the downloaded firmware in the RLC card.

3. Rebooting the library to make the firmware operational

https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
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Loading Firmware to the RLC Card
To download the firmware to the RLC card:

1. Open the StorageTek Library Console application.

2. Log on. See “Logging On to StorageTek Library Console” on page 19.

3. Select Tools > Diagnostics.
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4. Select the Load Code tab.

5. Use the Browse button to locate, select, and open the firmware folder and file name 
(.IMG file) on your PC.

6. Select the Load button from the top options bar to load the code to the RLC card.

7. Select OK to confirm downloading the code.

Note – The process can take approximately 5 minutes. When the IMG file is 
downloaded, the system unpacks the package.
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Activating the Firmware
To activate the firmware:

1. Select the Activate Code tab.

Note – The Available Versions window lists the newly downloaded code and the 
currently activated code.

2. Select the Target (file with the asterisk (*) from the pull-down menu.

Caution – Potential internal file corruption: In the next step, do not reboot any devices or 
execute any operations on the library while the code is being activated. The process can 
take approximately 10 minutes. 

3. Select the Activate button in the top options bar.

4. Select OK to continue.
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Rebooting the Library
To reboot the library:

1. When the Activate Code process is complete, you are prompted to reboot the library. 
Select OK.

2. Select OK to end the StorageTek Library Console session.

3. In the logon screen, select Exit to close the application.

Note – Wait for the library to complete initialization before you log on to the 
StorageTek Library Console again to restore communication with the library.
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Using putty and pscp to Download 
Firmware
Use the following sections for the putty and pscp method. 

Before beginning, make sure that you have:

■ An activation password for the service, admin, or oem login for this library serial 
number (available from https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login )

■ The dnld login password (available from your technical specialist or the call center)

Downloading putty and pscp to Your PC
To download the files to your PC:

1. Go to http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html.

2. Select putty and pscp versions 0.55 or higher and download them to your PC.

Loading Firmware to the RLC Card
To load the verde.tgz file to the RLC card:

1. Open a Windows command prompt window.

2. From the directory that contains the pscp file, type:

pscp –scp \path\verde.tgz dnld@library_name:

Note – Remember to type a colon after name.

“\path” is the path to the code file

"library_name" is either a valid network DNS name or an IP address

Example:

If the pscp executable file is in C:\Program Files\putty and the verde.tgz file is in C:\
sl500, type: 

C:\Program Files\putty>pscp -scp C:\sl500\verde.tgz dnld@green23: 

3. At the prompt, type the dnld login password.

When the file begins transferring, the display shows:

verde.tg | 8268 kB | 306.2 kB/s | ETA: 00:00:00 | 100% 

https://dlrequest-zn-dlapps1.sfbay.sun.com/usr/login 
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Installing the verde.tgz file
1. After the download is complete, run the putty.exe. 

2. From the putty window, login by typing:

putty dnld@library_name

3. At Password:, type the dnld password obtained from the technical excellence center 
specialist earlier.

If “Loading Firmware to the RLC Card” on page 83 was executed properly, the display 
shows:

File download/install utility 
/usr/local/share/verde.tgz has been found instead  
Do you want to install this image? (y, yes, y, no)

Note – If, instead, the display shows:

File download/install utility  
Do you want to download files? (y, yes, n, no) 

then type no and repeat “Loading Firmware to the RLC Card” on page 83.

4. Type y. The display shows something like (version numbers are examples only):

Extracting files ...  
The following files were extracted ...  
1.01.1 (5.35.00) 
disk.rlc.pImage 3.23.29 
green.cramfs 5.34.07 
kernel.pImage 3.15.08 
libs.cramfs 5.34.05 
lop.cramfs 5.34.07  
ppcboot.bin 3.21.03

Installing...  
Update disk.rlc.pImage ...  
Update green.cramfs ...  
Update kernel.pImage ... 
Update libs.cramfs ...  
Update lop.cramfs ...  
ppcboot.bin same 
cleanup 
Connection closed by remote host.

Caution – Disruption of customer activity: Before rebooting the library, make sure that all 
customer activity has been stopped. Rebooting the library will cause any jobs in process 
to be halted.
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5. Reboot the library to start using the code:

If you have physical access to the library, power cycle the library 

If you are installing code remotely:

a. Call headquarters and obtain an activation password for the service login. 

b. Login as service by typing: 

putty service@library_name 

The display shows: (pw is one-time activation password from 
http://crcapplications.central/keyswebapp/:

Password (activation): use activation pw here  
Warning: Your password has expired, please change it now 
Enter new UNIX password: make up a pw you can remember 
Retype new UNIX password: 

SERVICE>> 

c. Type reboot to restart the library using the new code. 

Example:

SERVICE>> reboot 
Broadcast message from root Wed Sep 15 19:11:59 2004...  
The system is going down for reboot NOW !!  
cause: (5)==COMMAND FAILURE 
SERVICE>> Terminated 

6. When the library has initialized, either:

■ Type version print from the service login to verify that the code is loaded correctly.

■ Use the StorageTek Library Console to verify that the firmware version is correct.

http://crcapplications.central/keyswebapp/
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CHAPTER 5

Event Logs and Codes

This chapter describes the contents of the event logs and lists the action code numbers 
and meanings. For the result codes, more information and procedures are included in 
the chapters listed in TABLE 5-3.

Event Logs
Library operations are continually monitored by the RLC card. All events associated 
with the operations are logged by the card and can be retrieved by operators and 
service representatives for examination.

Library events are accessible from either:

■ StorageTek Library Console Ethernet:

Tools>Reports>Event Log 

■ Command line interface:

print log  <all> | <error> | <warning> | <info> | <trace> | <diag>

Caution – Fire hazard/circuit card damage: Do not insert a telephone connector into the 
RESERVED or CLI ports. A potential power surge could cause a fire or damage to the 
RLC card.

Fault symptom codes have been replaced by:

■ Action Codes (what command was issued, such as load drive)

■ Result Codes (what was the result of the action requested)

■ Known Service Plan (KSP) diagnosis (what mechanism or component is responsible for 
the task or fault). 

Events are stored under three headings:

■ Communication events (host-to-library, library-to-library, and library-to-tape drive). 
Data for these events include:
■ Date/time stamp
■ Library identifier
■ Tape drive identifier
■ Requestor
■ Interface protocol
■ Communication type

■ Error events, which include:
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■ Date/time stamp
■ Tape drive identifier
■ Operation type
■ Four-digit (hexadecimal) action code
■ Interrupt level (hardware or software generated)
■ VOLID for media-related events

■ Warning events, which indicate a loss of performance or events that might indicate 
future fatal errors. The data for these are the same as in error events described 
previously.

Note – There is not an option for a service representative to clear the event log.

Fault Isolation Log Entry Specifics
Each event posted to the system's event log contains specific information and format:

■ The date and time of the entry in UTC standard format per ISO 1086-2000 with a 
millisecond field; for example, 2004-02-19T15:54:55.464

■ The device address of the component associated with the log entry (field width of 
two characters)

■ The user name identifying the access level that originated the activity (field width of 
eight characters)

■ A name representing the interface that was used to request the activity (field width 
of eight characters)

■ A short text name representing the activity being performed (field width of 20 
characters)

■ A request identifier/trace tag that is an alphanumeric string (field width of eight 
characters)

■ The log severity (field width of six characters)

■ The result code (field width of five characters)

■ A free-form text string encapsulated in double quote characters and terminated by 
the '\n' end of line character; the text cannot contain XML format directives

The free-form text contains a human-readable description of the activity, the result 
(or fault), and descriptive information, such as library or host addresses and 
cartridge volume labels.

Example 1:

2004-02-26T22:49:08.767, 1.1.0.1.0, acsls1, default, move, 385983, trace, 3828, “Move 
Started”, cartridge=000010 2004-02-26T22:49:08.779, 1.1.0.1.0, root, default, move, 
385983, trace, 3834, “Cartridge Fetch Started”, cartridge=000010 

address=1,1,-27,1,11
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Example 2:

2004-02-26T22:49:11.053, 1.1.0.1.0, root, default, move, 385983, error, 3955, “Error from 
device”, Data=”response sequence=”484635” final=
”true”>”command>fetchCartridge”/command>”result identifier=
”1”>”resultStatus>”resultSeverity>error”/resultSeverity>”resultCode>5607”/resultCo
de>”resultText>”!|CDATA|End of 
Text||>”/resultText>”operationalState>505”/operationalState>”/resultStatus>”addres
s>1,1,-27,1,11”/address>”/result>”/response>

Action Codes
This table lists the code numbering ranges and the types of activities. Each action code, 
also called activity code, follows the table.

TABLE 5-1 Action Code Range and Activity

Code Range Activity

0000 No activity; used for time stamps not associated with system events

0100 to 0199 Common/shared activity (across devices and controller)

0200 to 0299 Common/shared activity (across devices)

0400 to 0499 Common/shared configuration activity

1000 to 1999 Host interface activity

2000 to 2999 Management interface activity

3000 to 3999 Internal server/library activity

5000 to 5999 Robot activity

6000 to 6999 Tape drive activity

7000 to 7999 CAP activity

TABLE 5-2 Action Codes and Activities 

Code Activity

0000  No action

0100 Application start

0101 Application shutdown

0102 Application task start

0103 Application task exit

0200 Set log criteria in device

0201 Get log criteria from device

0202 Event listener registered with device

0203 Firmware download
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0204 File download

0205 File upload

0206 Get version information

0400 Configuration download

0401 Get library number from device

0402 Set library number in device

0403 Get local date and time

0404 Set local date and time

1100 FC/SCSI inquiry

1101 FC/SCSI test unit ready

1102 FC/SCSI mode sense

1103 FC/SCSI mode select

1104 FC/SCSI move medium

1105 FC/SCSI init element status

1106 FC/SCSI persistent reserve in

1107 FC/SCSI init element status with range

1108 FC/SCSI log sense

1109 FC/SCSI persistent reserve out

1110 FC/SCSI position to element

1111 FC/SCSI prevent/allow medium removal

1112 FC/SCSI release

1113 FC/SCSI request sense

1114 FC/SCSI request volume element address

1115 FC/SCSI send diagnostic

1116 FC/SCSI send volume tag

1117 FC/SCSI test unit ready

1118 FC/SCSI write buffer

1200 Initializing SCSI 

1201 Activating SCSI port

1202 Processing command event

1203 Processing task management event

1204 Processing ioctl status event

1205 Processing configuration change event

3000 Cartridge move

3001 Get tape drive configuration

3002 Get tape drive time of day

3003 Get tape drive information

TABLE 5-2 Action Codes and Activities (Continued)
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3004 Tape drive initialization

3005 Load tape drive

3006 Park tape drive

3007 Prepare to load tape drive

3008 Reset tape drive

3009 Reset tape drive fast load

3010 Reset tape drive holdoff load

3011 Rewind unload tape drive

3012 Set tape drive configuration

3013 Set tape drive fast load

3014 Set tape drive holdoff load

3015 Set tape drive time of day

3016 Get tape drive state

5000 Robot device announce

5001 Robot state query

5002 Robot initialize

5003 Robot audit

5004 Robot fetch cartridge

5005 Robot put cartridge

5006 Robot move to position

5007 Robot move until stall

5008 Robot move and push

5009 Robot prepare for push

5010 Robot get statistics

5011 Robot set statistics

5300 Robot state change

6000 Tape drive device announce

6001 Tape drive state query

6002 Tape drive control power

6003 Tape drive request to put

6004 Tape drive put complete

6005 Tape drive load

6006 Tape drive rewind and unload

6007 Tape drive request to fetch

6008 Tape drive fetch complete

6009 Tape drive get statistics

TABLE 5-2 Action Codes and Activities (Continued)
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Result Codes
The following table lists the code numbering ranges and the chapters that contain the 
specific codes and activities. Refer to the chapter for the description for each code and 
the isolation procedure.

See “CLI Commands” on page 58 for descriptions of the service CLI commands. 

When FRUs or spares are listed in the description, refer to the Replaceable Parts Catalog 
to replace them.

6010 Tape drive set statistics

6300 Tape drive state change

6500 Tape drive controller announce

TABLE 5-3 Result Code Numbering and Chapter

Code Numbering Chapter

0000 No activity; used for time stamps not associated 
with system events

11XXX Chapter 6, “SCSI Errors”

33XX Chapter 7, “IFM Errors”

35XX Chapter 8, “Diagnostic Errors”

37XX Chapter 9, “Library Miscellaneous Errors”

38XX Chapter 10, “SNMP Errors”

39XX Chapter 11, “Service Errors”

5XXX Chapter 12, “Robot Errors”

64XX Chapter 13, “Tape Drive Errors”

80XX Chapter 14, “Sensor Errors”

TABLE 5-2 Action Codes and Activities (Continued)
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CHAPTER 6

SCSI Errors

This chapter describes how to use the SCSI error result codes to isolate problems.

1101=SCSI_FAILED

Requested action failed.

Fibre Suspect FRU List:1) software 2) MPU2 card  
LVD Suspect FRU List:1) software 2) MPW/RLW card 

Isolation Procedure:

Fibre:

1. Issue the LUN reset task management function from the host.

2. Reset the transport layer from the host, and retry the operation.

3. Unplug and plug in the Fibre cable.

4. Reboot the library.

5. If the problem persists, replace the MPU2 card.

LVD:

1. Issue the LUN reset task management function from the host.

2. Reset the transport layer from the host, and retry the operation.

3. Reboot the library.

4. If the problem persists, replace the MPW/RLW card.
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1102=SCSI_DRIVER_ERROR

Error executing driver request.

Fibre Suspect FRU List: 1) software 2) MPU2 
LVD Suspect FRU List: 1) software 2) MPW/RLW 

Isolation Procedure:

Fibre:

1. Reset the transport layer from the host, and retry the operation.

2. Unplug and plug in the Fibre cable.

3. Reboot the library.

4. If the problem persists, replace the MPU2 card.

LVD:

1. Reset the transport layer from the host, and retry the operation.

2. Reboot the library.

3. If the problem persists, replace the MPW/RLW card.

1103=SCSI_SYSTEM_ERROR

System error occurred: application, hardware configuration, or operating system.

Suspect FRU List: 1) hardware configuration 2) hardware 3) software

Isolation Procedure:

1. Check for heterogeneous hardware.

An invalid configuration would be Fibre and SCSI together.

No cards exist.

2. Verify all cards are seated.

3. If the problem persists, replace the MPU2 or MPW/RLW card.

1104=SCSI_PROGRAM_ERROR

Encountered a situation which should never occur.

Suspect FRU List: software 

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Create an incident report.
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1105=SCSI_TASK_ABORTED

Task was aborted

Suspect FRU List: None

Isolation Procedure: None

1106=SCSI_REJECTED

Requested action from host rejected.

Suspect FRU List: Host software

Isolation Procedure: None for the library. Host software is attempting an unsupported 
task management function.

1107=SCSI_RESTART_INTERFACE

Interface needs to be restarted.

Suspect FRU List: 1) software 2) MPU2 or MPW/RLW card 

Isolation Procedure:

1. Collect the logs (including kernel logs): print log <all>.

2. Reboot the library.

3. If the problem persists after reboot, the hardware is at fault.

4. Replace the MPU2, MPW or RLW card.

1108=SCSI_TASK_COMPLETED

Task completed.

Suspect FRU List: None

Isolation Procedure: None, normal operation.

1109=SCSI_NOT ALLOWED

Requested action not allowed.

Suspect FRU List: None

Isolation Procedure: None, normal operation.
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CHAPTER 7

IFM Errors

This chapter describes how to use the IFM error result codes to isolate problems.

3300=IFM_UNKNOWN

Unexpected error

Suspect FRU List: firmware

Isolation Procedure:

1. Collect the logs: print log <all>

2. Reboot the library.

3301=IFM_RESOURCE_FAIL

User command could not be sent.

Suspect FRU List: 1) robotics unit 2) firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Reboot the library.

3302=IFM_CONTENT_FAIL

Content failure for a request or function call

Suspect FRU List: None, check media

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Reboot the library.

3303=IFM_NON_EXISTENT_SOURCE_DRIVE

Source tape drive requested is not configured.

Suspect FRU List: None, check source tape drive address

Isolation Procedure: See result code 3304 for procedure.
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3304=IFM_NON_EXISTENT_DEST_DRIVE

Destination tape drive requested is not configured.

Suspect FRU List: None, check destination tape drive address

Isolation Procedure: 

1. Check address of the tape drive; if correct, continue.

2. Visually check for the tape drive; if present, continue.

3. Visually check that the tape drive bezel is still in place; if present, continue.

4. Initialize the tape drive:

If a Hewlett-Packard tape drive, reset the drive: drive <addr> reset.

If not HP tape drive, pull tape drive out, wait 10 seconds, put it back in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

5. Issue the drive state command: drive <addr> state.

If the problem persists, continue.

6. Insert a different tape drive.

7. Issue the drive state command: drive <addr> state.

8. If the problem goes away, replace the bad tape drive.

9. If the problem persists, replace the robotics unit.

3305=IFM_INOP

Encountered inop condition

Suspect FRU List: 1) robotics unit 2) firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Scan for error IFM_INOP.

3. Once the error is found, look back in time for the INOP indication.

4. Once the INOP condition is found, determine the source of the INOP condition and 
attempt to clear it.

5. Reboot the library.
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3307=IFM_USER_RESPONSE_FAIL

User command response returned failure.

Suspect FRU List: firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Reboot the library.

3308=IFM_MOVE_NON_EXISTENT_SOURCE

Source address does not exist.

Suspect FRU List: none 

Isolation Procedure: 

1. Check the source address.

Note – If a SCSI address, addresses are shifted by number of reserved slots.

2. If the address is correct, collect traces and reboot.

3309=IFM_MOVE_SOURCE_EMPTY

Source location is empty.

Suspect FRU List: none

Isolation Procedure:

1. Check the source address.

Note – If a SCSI address, addresses are shifted by number of reserved slots.

2. If the address is correct, collect traces and reboot.

3310=IFM_MOVE_NON_EXISTENT_DESTINATION

Destination address does not exist

Suspect FRU List: none

Isolation Procedure:

1. Check the destination address.

Note – If a SCSI address, addresses are shifted by number of reserved slots.

2. If the address is correct, collect traces and reboot.
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3311=IFM_MOVE_DESTINATION_FULL

Destination address is occupied

Suspect FRU List: none

Isolation Procedure:

1. Check the destination address.

Note – If a SCSI address, addresses are shifted by number of reserved slots.

2. If the address is correct, collect the traces and reboot.

3312=IFM_MOVE_GET_FAIL

Get failed.

Suspect FRU List: Unknown

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Find the result code IFM_MOVE_GET_FAIL in the logs and get the failing address.

3. Turn on the diagnostic traces: trace diag on.

4. Issue diaggetput using the address retrieved from the logs in the source address of 
the diagnostic command:

diaggetput cellToCell <source addr> <destination addr> 5 nonsilent

5. If the diagnostic test passes, collect the logs: print log <all> and write an 
incident report. 

If the diagnostic test fails, use the diagnostic error code to continue the investigation: 
print log <all>.

3313=IFM_MOVE_PUT_FAIL

Put failed.

Suspect FRU List: Unknown

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Find the result code IFM_MOVE_PUT_FAIL in the logs and get the failing address.

3. Turn on the diagnostic traces: trace diag on.

4. Issue diaggetput using the address retrieved from the logs in the source address of 
the diagnostic command:

diaggetput cellToCell <source addr> <destination addr> 5 nonsilent
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5. If the diagnostic test passes, collect the logs: print log <all> and write an 
incident report. 

If the diagnostic test fails, use the diagnostic error code to continue the investigation: 
print log <all>.

3314=IFM_MOVE_LOAD_FAIL

Drive load failed.

Suspect FRU List: 1) tape drive   2) firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Find the result code IFM_MOVE_LOAD_FAIL in the logs and get the failing 
address.

3. Turn on the diagnostic traces: trace diag on.

4. Issue diaggetput using the address retrieved from the logs in the source address of 
the diagnostic command:

diaggetput cellToCell <source addr> <destination addr> 5 nonsilent

5. If the diagnostic test passes, collect the logs: print log <all> and write an 
incident report. 

If the diagnostic test fails, use the diagnostic error code to continue the investigation: 
print log <all>.

3315=IFM_MOVE_UNLOAD_FAIL

Drive unload failed.

Suspect FRU List: 1) tape drive 2) firmware

Isolation Procedure: 

1. Visually check the cartridge. Did the cartridge eject past the cartridge present sensor?

a. If it did, try pushing the cartridge back into tape drive.

b. Issue the get status command and check that the cartridge is seated and present.

2. If the cartridge is not seated and present, replace the tape drive.

3316=IFM_MOVE_DRIVE_NOT_PRESENT

Drive not present.

Suspect FRU List: 1) tape drive 2) RLC card 3) firmware

Isolation Procedure: 

1. Check the address of the tape drive; if correct, continue.

2. Visually check for the tape drive; if present, continue.

3. Visually check that the tape drive bezel is still in place; if present, continue.
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4. Activate traces for the tape drive in question:

trace drive-tti-xx on (xx is the tape drive id)

trace tti-dbg-xx on (xx is the tape drive id)

5. Initialize the tape drive:

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, and then 
put it back in.

Note – In a fully populated library, the wait could be up to 20 seconds.

6. Issue the command to get tape drive state: drive <addr> state.

7. If the command fails, insert a different tape drive.

8. Issue the command to get tape drive state: drive <addr> state.

If the problem goes away, replace the bad tape drive.

9. If the problem persists, replace the RLC card.

3317=IFM_MOVE_BAD_DRIVE_STATE

Bad drive state for move

Suspect FRU List: 1) tape drive 2) firmware

Isolation Procedure:

1. Activate traces for the tape drive in question:

trace drive-tti-xx on (xx is the tape drive id)

trace tti-dbg-xx on (xx is the tape drive id)

2. Initialize the tape drive:

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, and then 
put it back in.

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue the command to get tape drive state: drive <addr> state.

4. If the command fails, replace the tape drive.
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3318=IFM_MOVE_MEDIA_ERROR

Media error

Suspect FRU List: 1) media   2) tape drive   3) firmware

Isolation Procedure:

1. Move the cartridge to another tape drive:

move <source addr> <dest addr>

2. If the problem persists, replace the cartridge; else, continue.

3. Issue the command for drive get status and check to see if the tape drive needs 
cleaning: drive <addr> state.

4. Clean the tape drive if indicated.

5. Try another cartridge in the original tape drive.

6. If the problem persists, replace the tape drive.

3319=IFM_MOVE_SOURCE_CAP_OPEN

Source location CAP open

Suspect FRU List: 1) none–close the CAP door   2) CAP sensor

Isolation Procedure: 

1. Visually check the CAP doors for an open door.

2. Close any CAP doors and retry the operation.

3. Press each CAP door:

■ If you hear a click, the door was not closed. Retry the operation.

■ If you don’t hear a click, continue to the next step.

4. Run the CAP diagnostic test: diagcaps.

■ If the diagnostic test fails, replace the CAP sensor indicated.

■ If the diagnostic test does not fail, collect the logs and write an incident report.

3320=IFM_MOVE_DESTINATION_CAP_OPEN

Destination location CAP open

Suspect FRU List: 1) none–close CAP door   2) CAP sensor

Isolation Procedure: 

1. Visually check the CAP doors for an open door.

2. Close any CAP doors and retry the operation.

3. Press each CAP door:

■ If you hear a click, the door was not closed. Retry the operation.

■ If you don’t hear a click, continue to the next step.

4. Run the CAP diagnostic test: diagcaps.

■ If the diagnostic test fails, replace the CAP sensor indicated.
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■ If the diagnostic test does not fail, collect the logs: print log <all> and write an 
incident report.

3321=IFM_MOVE_RESERVE_FAIL

Failure during reservation

Suspect FRU List: firmware

Isolation Procedure:

1. Check the address.

2. Visually verify that a conflict exists.

If a conflict exists, continue to the next step.

If no conflict exists, recheck the address. Remember to take the reserved slots into 
account for a SCSI address.

If still no conflict exists, collect traces and continue.

3. Reboot the library.

3322=IFM_MOVE_CART_IN_HAND

Cartridge in hand

Suspect FRU List: 1) robotics unit 2) firmware

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Scan for error IFM_MOVE_CART_IN_HAND.

3. Once the error is found, look back in time for the INOP indication.

4. Once the INOP condition is found, determine the source of the INOP condition and 
attempt to clear it.

3323=IFM_MOVE_SOURCE_CAP_MAGAZINE_MISSING

Source location CAP magazine missing

Suspect FRU List: CAP magazine 

Isolation Procedure: 

1. Open all the CAP doors configured as I/O.

2. Visually verify that all CAP magazines are present:

■ If all are present, replace the CAP magazine indicated as missing.

■ If one or more CAP magazines are missing, insert the missing magazines.
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3324=IFM_MOVE_DESTINATION_CAP_MAGAZINE_MISSING

Destination location CAP magazine missing

Suspect FRU List: CAP magazine

Isolation Procedure: 

1. Open all the CAP doors configured as I/O.

2. Visually verify that all CAP magazines are present:

■ If all are present, replace the CAP magazine indicated as missing.

■ If one or more CAP magazines are missing, insert missing magazines.

3325=IFM_SOURCE_DRIVE_NOT_AVAILABLE

Source drive requested is not available.

Suspect FRU List: 1) tape drive 2) robotics unit (serial port)

Isolation Procedure: See result code 3326 for the procedure:

3326=IFM_DEST_DRIVE_NOT_AVAILABLE

Destination drive requested is not available.

Suspect FRU List: 1) tape drive 2) robotics unit (serial port)

Isolation Procedure:

1. Activate traces for the tape drive in question:

trace drive-tti-xx on (xx is the tape drive id)

trace tti-dbg-xx on   (xx is the tape drive id)

2. Initialize the tape drive:

■ If a Hewlett-Packard tape drive, issue: drive <addr> reset.

■ If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, and 
then put it back in.

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue the command to get the tape drive state: drive <addr> state.

4. If the command fails, replace the tape drive.

5. Issue the command to get the tape drive information: drive <addr> info.

6. If the command fails, replace the tape drive.

7. Issue the command to get the tape drive configuration: drive <addr> getconfig.

8. If the command fails, replace the tape drive.

9. Issue the command to set the tape drive configuration: drive <addr> setconfig.

10. If the command fails, replace the tape drive.

11. Issue the command to load the tape drive: move <source addr> <dest addr>.
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12. If the command fails, replace the tape drive.

13. Deactivate traces for the tape drive in question:

trace drive-tti-xx off (xx is the tape drive id)

trace tti-dbg-xx off   (xx is the tape drive id)

14. If the problem persists, replace the robotics unit.

3327=IFM_DIAG__NO_CARTRIDGE_AVAILABLE

No cartridge available for diagnostic use

Suspect FRU List: 1) cartridge    2) firmware

Isolation Procedure: 

1. Check for a cartridge.

2. Issue the cartridge print command: cartridge print.

3. If the cartridge list is empty, insert a cartridge.

4. Reissue the diagnostic command.

5. If the error recurs, firmware is at fault.

6. Collect the logs: print log <all> and write an incident report.

3328=IFM_DIAG__NO_DIAGNOSTIC_CARTRIDGE_AVAILABLE

No diagnostic cartridge available or not in reserved slot location

Suspect FRU List: 1) cartridge    2) firmware

Isolation Procedure: 

1. Check for a cartridge with a diagnostic label.

2. Issue the cartridge print command: cartridge print.

3. Verify the diagnostic cartridge is present:

■ If not present, enter the diagnostic cartridge and retry the diagnostic test.

■ If present, continue to the next step.

4. Issue the reserved print command to show library’s current reserved slot count: 
reserved print.

5. Verify the diagnostic cartridge is in the reserved slot location:

■ If the diagnostic cartridge is not in a reserved slot, move it to an empty reserved slot 
and retry the diagnostic test.

■ If the diagnostic cartridge is in a reserved slot, collect the logs: print log <all> 
and write an incident report.
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3329=IFM_DIAG__CARTRIDGE_IS_NOT_DIAGNOSTIC_CARTRIDGE

Not a diagnostic cartridge or not in reserved slot location

Suspect FRU List: 1) cartridge   2) firmware

Isolation Procedure: 

1. Check for a cartridge with a diagnostic label.

2. Issue: cartridge print.

3. Verify the diagnostic cartridge is present:

■ If not present, enter the diagnostic cartridge and retry the diagnostic test.

■ If present, continue to the next step.

4. Issue the reserved print command to show the library’s current reserved slot count: 
reserved print.

5. Verify a diagnostic cartridge is in the reserved slot location:

■ If the diagnostic cartridge is not in a reserved slot, move it to an empty reserved slot 
and retry the diagnostic test.

■ If the diagnostic cartridge is in a reserved slot, collect the logs: print log <all> 
and write an incident report.

3330=IFM_DIAG__NO_CARTRIDGE_AT_THIS_LOCATION

No cartridge at this location

Suspect FRU List: 1) cartridge   2) firmware

Isolation Procedure: 

1. Check for a cartridge at the location specified in the diagnostic command.

2. Issue the cartridge print command: cartridge print.

3. Verify a cartridge is present at the location specified:

■ If not present, choose another cartridge from the cartridge list generated in the 
previous step.

■ If present, collect the logs: print log <all> and write an incident report.

3331=IFM_DIAG__CARTRIDGE_IS_NOT_CORRECT_TYPE (HP only)

Cartridge is not correct type.

Suspect FRU List: 1) cartridge   2) firmware

Isolation Procedure: 

1. Verify the cartridge selected in not a cleaning cartridge.

2. Issue: cartridge print.

■ If the cartridge is a cleaning cartridge, select another.

■ If the cartridge selected is not a cleaning cartridge, collect the logs:  
print log <all> and write an incident report.
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3332=IFM_DIAG__NO_EMPTY_DESTINATION_CELL_FOUND

No empty destination slot found

Suspect FRU List: 1) no empty slot available   2) firmware

Isolation Procedure:

1. Remove a cartridge from the library.

2. Retry the diagnostic test. If the error persists, collect the logs: print log <all> 
and write an incident report.

3333=IFM_DRIVE_GET_CONFIG_FAILED

Get Drive Configuration Failed

Suspect FRU List: 1) tape drive 2) firmware

Isolation Procedure: 

1. Activate traces for the tape drive in question: 

■ trace drive-tti-xx (xx is the tape drive id)

■ trace tti-dbg-xx  (xx is the tape drive id)

2. Issue: drive <addr> state.

3. If the drive state command fails, issue: drive <addr> reset.

4. Once reset, issue: drive <addr> state.

5. If the drive state command fails, pull the tape drive out and put it back into the 
library.

6. Issue: drive <addr> state.

7. If the command fails, replace the tape drive.

3334=IFM_INCOMPATIBLE_CART_FOR_DRIVE

Source cartridge is incompatible with destination drive

Suspect FRU List: None

Isolation Procedure: Verify cartridge and tape drive type.

3335=IFM_DRIVE_CLEANING

This drive is currently executing a drive clean

Suspect FRU List: None

Isolation Procedure: Wait for the cleaning to complete and retry the operation.
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3336=IFM_INCOMPATIBLE_CART_FOR_MOVE

Cartridge move is restricted for this cartridge type

Suspect FRU List: None

Isolation Procedure: 

1. Check the cartridge type.

2. If the type is correct for the desired move, collect traces and escalate.

3. If the type is not correct, use a different cartridge.

3337=IFM_NO_COMPATIBLE_CLEAN_CARTRIDGE

No compatible cleaning cartridge for this drive type

Suspect FRU List: None

Isolation Procedure: Add a compatible cleaning cartridge to the library for the selected 
tape drive type.

3338=IFM_CLEAN_CARTRIDGE_EXPIRED

Cleaning cartridge has expired

Suspect FRU List: cleaning cartridge

Isolation Procedure: Replace the cleaning cartridge with one for the desired tape drive 
type.

3339=IFM_EMPTY_CAP_CELL NOT_FOUND

No empty CAP cells remain

Suspect FRU List: None

Isolation Procedure: Remove cartridges from the CAP magazines.

3340=IFM_CART_IS_NOT_CLN_OR_DIAG

Selected cartridge is not a cleaning or diagnostic cartridge

Suspect FRU List: None

Isolation Procedure: 

1. Select a cleaning or diagnostic cartridge.

2. Retry the command.
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3341=IFM_DIAG__ONE_OR_MORE_CORNERS_SKIPPED

Corners Test Failed One Or More Corners Occupied

Suspect FRU List: None

Isolation Procedure: No action required. The diagnostic passed but is indicating that 
one or more corners contain a cartridge and the diagnostic cartridge cannot be moved 
to the occupied corners. 

3342=IFM_DIAG__CAP_CELL_SKIPPED

All CAP Cells Occupied, Skipped Test

Suspect FRU List: None

Isolation Procedure: No action required. The diagnostic passed but is indicating that it 
could not move a diagnostic cartridge to a CAP location.

3343=IFM_DIAG__ONE_OR_MORE_DRIVES_SKIPPED

All Drives Test Failed One Or More Drives Occupied

Suspect FRU List: None

Isolation Procedure:  No action required. The diagnostic passed but is indicating that 
one or more of the drives contain a cartridge and cannot participate in the test.
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CHAPTER 8

Diagnostic Errors

This chapter describes how to use the diagnostic test error result codes to isolate 
problems. Any diagnostic test failure will leave the library in the maintenance mode. 
Only a successful diagnostic test completion (from any diagnostic test) will clear the 
maintenance mode library state.

3500=DIAGNOSTIC_FAILED

Unexpected error

Suspect FRU List: firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic tests:
■ If the diagnostic tests fail as before, reboot the library.

■ If the diagnostic tests pass, a transient error condition exists.

3501=DIAGNOSTIC_ODS_INVALID_INSTANTIATION

Diagnostic InProgress object invalid

Suspect FRU List: firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic tests:
■ If the diagnostic tests fail as before, reboot the library.
■ If the diagnostic tests pass, a transient error condition exists.
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3502=DIAGNOSTIC_ALREADY_INPROGRESS

Diagnostic already in progress

Suspect FRU List: firmware if condition persists

Isolation Procedure: 

1. Diagnostic test may already be in progress from another login.

2. Issue the diagstop command if you suspect another diagnostic test is in progress, or 
wait 20 to 30 minutes before re-issuing the diagnostic test command. 

Note – The diagstop command only terminates a diagnostic test at the end of a 
diagnostic test iteration. The diagnostic self test may take a long time to finish a 
diagnostic test iteration as all tape drives are tested.

3. If the error persists, collect the logs and reboot the library.

3503=DIAGNOSTIC_UNABLE_TO_GET_OBJECT

Unable to get diagnostic InProgress object

Suspect FRU List: firmware

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic tests:
■ If the diagnostic tests fail as before, reboot the library.
■ If the diagnostic tests pass, a transient error condition exists.

3504=DIAGNOSTIC_UNABLE_TO_CHANGE_LIBRARY_STATE

Unable to put library into maintenance mode

Suspect FRU List: Unknown

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic tests:
■ If the diagnostic tests fail as before, reboot the library.
■ If the diagnostic tests pass, a transient error condition exists.
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3505=DIAGNOSTIC_THREAD_CREATION_FAILED

Diagnostic thread creation failed

Suspect FRU List: firmware 

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Reboot the library.

3506=DIAGNOSTIC_PROC_FILE_OPEN_FAILURE

Unable to open file in proc filesystem

Suspect FRU List: 1) power supply 2) RLC card 3) firmware

Isolation Procedure: See result code 3512.

3510=DIAGNOSTIC_PROC_RTC_FAILED

Proc file indicates real time clock battery failure

Suspect FRU List: 1) battery   2) firmware

Isolation Procedure: 

1. Replace the battery.

2. Issue: diagquery basicHealth 1 nonsilent:

■ If the diagnostic test fails with the same result code, proceed to the next step.

■ If the diagnostic test fails with a different result code, go to the Isolation Procedure 
for that result code. 

■ If the diagnostic test passes, the problem is resolved.

3. Collect the traces. 

4. Reboot the library.

5. Issue: diagquery basicHealth 1 nonsilent:
■ If the problem persists, try another battery.
■ If the diagnostic test passes, the problem is resolved.
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3512=DIAGNOSTIC_PROC_FILE_EMPTY

Reading the proc file returned a NULL

Suspect FRU List: 1) power supply 2) RLC card 3) firmware

Isolation Procedure: 

1. Verify all the library modules have power.

Note – All modules must have power at boot up. 

2. If one or more modules do not have power, replace any failed power supplies.

3. Reboot the library.

4. Rerun the diagnostic test:
■ If the problem persists, go to the next step.
■ If the diagnostic test passes, the problem is resolved.

5. Replace the RLC card.

6. Reboot the library.

7. Rerun the diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.

3513=DIAGNOSTIC_PROC_FILE_TOKEN_MISSING

NULL returned when token was expected

Suspect FRU List: firmware

Isolation Procedure: 

1. Collect traces.

2. Rerun the diagnostic tests:
■ If the problem persists, reboot the library.
■ If the diagnostic tests pass, an intermittent problem was encountered. 

3. Reboot the library.

4. Rerun the diagnostic tests:
■ If the problem persists, escalate.
■ If the diagnostic tests pass, an intermittent problem was encountered. 
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3514=DIAGNOSTIC_SYSTEM_MODULE_NOT_PRESENT

System module not found

Suspect FRU List: 1) firmware 2) RLM card 3) RLC card

Isolation Procedure:

1. Retry the diagnostic test:
■ If the diagnostic test passes, a transient failure has occurred.
■ if the diagnostic test fails, continue.

2. Reboot the library.

3. Retry the diagnostic test.

4. If the failure persists, replace the RLC card.

5. Reboot the library.

6. Retry the diagnostic test.

7. If the failure persists, replace the RLM card.

3515=DIAGNOSTIC_ROBOT_NOT_PRESENT

Robot not present

Suspect FRU List: 1) robotics unit   2) RLC card 3) firmware 

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Visually check for the robotics unit presence.

3. If the robotics unit is missing, replace it.

4. If the robotics unit is there, replace the RLC card.

5. Reboot the library.

6. Rerun the diagnostic test:
■ If the diagnostic test fails, collect traces and escalate.
■ If the diagnostic test passes, the problem is resolved.
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3516=DIAGNOSTIC_IDCARD_NOT_PRESENT

IDCARD not present

Suspect FRU List: 1) IDCARD   2) RLC card 3) firmware

Isolation Procedure:

1. Visually check for the IDCARD: 

■ If the IDCARD is missing, replace it.

■ If the IDCARD is there, replace the RLC card.

2. Reboot the library.

3. Rerun the diagnostic test:

■ If the diagnostic test fails, collect traces and escalate.

■ If the diagnostic test passes, the problem is resolved.

3517=DIAGNOSTIC_RLC_MASTER_ENABLE_ERROR

RLC master enable error detected

Suspect FRU List: 1) RLC card 2) firmware

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Reboot the library.

3. Rerun the diagnostic test:
■ If the diagnostic test fails, collect traces and replace the RLC card.
■ If the diagnostic test passes, the problem is resolved.

4. Reboot the library.

5. Rerun the diagnostic test:
■ If the diagnostic test fails, escalate.
■ If the diagnostic test passes, the problem is resolved.

3518=DIAGNOSTIC_BRAKE_FAULT_DETECTED

Control Status: brake fault detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3519=DIAGNOSTIC_12V_POWER_NOT_OK

Control Status: 12v Power not ok

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.
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3520=DIAGNOSTIC_SERVO_VOLTAGE_LOW

Control Status: servo voltage low

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3521=DIAGNOSTIC_CABLE_SLACK

Control Status: cable slack

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543. 

3522=DIAGNOSTIC_REACH_SAFE

Control Status: reach safe error

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543. 

3523=DIAGNOSTIC_PROX_DETECT

Control Status: proc detect error

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3524=DIAGNOSTIC_GRIP_FAULT

Grip fault detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3525=DIAGNOSTIC_GRIP_PHASE_ERROR

Grip phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3526=DIAGNOSTIC_GRIP_HALL_ERROR

Grip phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3527=DIAGNOSTIC_GRIP_AMP_ENABLE_ERROR
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Grip amp enable error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3528=DIAGNOSTIC_WRIST_FAULT

Wrist fault detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card 

Isolation Procedure: See result code 3543.

3529=DIAGNOSTIC_WRIST_PHASE_ERROR

Wrist phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3530=DIAGNOSTIC_WRIST_HALL_ERROR

Wrist phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3531=DIAGNOSTIC_WRIST_AMP_ENABLE_ERROR

Wrist amp enable error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3532=DIAGNOSTIC_REACH_FAULT

Reach fault detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card 

Isolation Procedure: See result code 3543.

3533=DIAGNOSTIC_REACH_PHASE_ERROR

Reach phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3534=DIAGNOSTIC_REACH_HALL_ERROR

Reach phase error detected
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Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3535=DIAGNOSTIC_REACH_AMP_ENABLE_ERROR

Reach amp enable error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3536=DIAGNOSTIC_TRACK_FAULT

Track fault detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3537=DIAGNOSTIC_TRACK_PHASE_ERROR

Track phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3538=DIAGNOSTIC_TRACK_HALL_ERROR

Track phase error detected

Suspect FRU List: 1) RLC card 2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3539=DIAGNOSTIC_TRACK_AMP_ENABLE_ERROR

Track amp enable error detected

Suspect FRU List: 1) RLC card   2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3540=DIAGNOSTIC_Z_FAULT

Z fault detected

Suspect FRU List: 1) RLC card   2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3541=DIAGNOSTIC_Z_PHASE_ERROR

Z phase error detected

Suspect FRU List: 1) RLC card   2) robotics unit   3) RLM card
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Isolation Procedure: See result code 3543.

3542=DIAGNOSTIC_Z_HALL_ERROR

Z phase error detected

Suspect FRU List: 1) RLC card   2) robotics unit   3) RLM card

Isolation Procedure: See result code 3543.

3543=DIAGNOSTIC_Z_AMP_ENABLE_ERROR

Z amp enable error detected

Suspect FRU List: 1) RLC card   2) robotics unit   3) RLM card

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Locate the result code in the Log Error file.

3. Scan backward in the log, looking for a 5XXX result code:
■ If a 5XXX code is found, use the 5XXX isolation procedure.
■ If no 5XXX code is found, continue with the next step. 

4. Rerun the diagnostic test:
■ If the diagnostic test passes, an intermittent problem exists.
■ If the diagnostic test fails, go to the next step.

5. Reboot the library.

6. Rerun the diagnostic test:
■ If the diagnostic test fails, replace the RLC card.
■ If the diagnostic test passes, the problem is resolved.

7. Reboot the library.

8. Rerun the diagnostic test:
■ If the diagnostic test fails, put the original RLC card into the library and replace the 

robotics unit.
■ If the diagnostic test passes, the problem is resolved.

9. Reboot the library.

10. Rerun the diagnostic test:

■ If the diagnostic test fails, put the original robotics unit into the library and replace 
the RLM card.

■ If the diagnostic test passes, the problem is resolved.

11. Reboot the library.

12. Rerun the diagnostic test:
■ If the diagnostic test fails, escalate.
■ If the diagnostic test passes, the problem is resolved.

3544=DIAGNOSTIC_DRIVE_NOT_PRESENT

Drive not present
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Suspect FRU List: 1) tape drive 2) RLC card   3) RLM card

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Visually verify the tape drive is present:
■ If the tape drive is present, reboot the library.
■ If the tape drive is missing, replace the tape drive and reboot the library.

3. Rerun the diagnostic test:

■ If the problem persists, put the original tape drive into the library and replace the 
RLC card.

■ If the diagnostic test passes, the problem is resolved.

4. Reboot the library.

5. Rerun the diagnostic test:

■ If the problem persists, put the original RLC card into the library and replace the 
RLM card.

■ If the diagnostic test passes, the problem is resolved.

6. Reboot the library.

7. Rerun the diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.
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3545=DIAGNOSTIC_DRIVE_FAN_FAILURE

Drive fan failure detected

Suspect FRU List: 1) tape drive 2) RLC card   3) RLM card

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Visible verify the fan has failed.

3. If the fan has stopped, replace the tape drive.

Note – The fan may be running below threshold.

4. If the fan is running, rerun the diagnostic test:
■ If the problem persists, replace the tape drive.
■ If the diagnostic tests pass, the problem is resolved.

5. Reboot the library.

6. Rerun the diagnostic tests:

■ If the problem persists, put the original tape drive into the library and replace the 
RLC card.

■ If the diagnostic tests pass, the problem is resolved.

7. Reboot the library.

8. Rerun the diagnostic tests:
■ If the problem persists, put the original RLC card into the library and replace the 

RLM card.
■ If the diagnostic tests pass, the problem is resolved.

9. Reboot the library.

10. Rerun the diagnostic tests:
■ If the problem persists, escalate.
■ If the diagnostic tests pass, the problem is resolved.

11. Collect the logs: print log <all>.

3546=DIAGNOSTIC_DRIVE_FAULT_LED_ACTIVE

Drive fault LED active

Suspect FRU List: 1) tape drive 2) RLC card   3) firmware

Isolation Procedure:

1. Verify the tape drive fault LED is active:
■ If the LED is active, replace the tape drive.
■ If the LED is not active, continue.

2. Issue the drive <addr> state command:
■ If the state indicates a fault or not present condition, replace the tape drive.
■ If the state is online, continue.

3. Reboot the library.

4. Verify the tape drive fault LED is off:
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■ If the fault LED is on, replace the tape drive.
■ If the fault LED is off, rerun the diagnostic test.
■ If the diagnostic test fails, escalate.

3547=DIAGNOSTIC_NO_FUNCTIONAL_DRIVE_FOUND

No functional drive found

Suspect FRU List: 1) tape drive   2) firmware

Isolation Procedure:

1. Visually verify that all tape drives have their fault LEDs lit.

If one or more tape drives do not have their fault LEDs lit, continue to Step 2.

If all tape drives have their fault LEDs lit, replace the tape drives and continue.

2. Reboot the library.

3. Rerun the diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.

3548=DIAGNOSTIC_DOOR_SENSOR_FAILURE_DOOR_OPEN

Door sensor failure: Door open

Suspect FRU List: 1) door sensor 2) RLC card 3) firmware

Isolation Procedure: 

1. Verify if the door is open or closed:
■ If closed, replace the door sensor.
■ If open, close the door and wait for the audit to complete.

2. Rerun the diagnostic test; the diagdoor diagnostic test may have timed out while 
waiting for the door to be closed:
■ If the problem persists, replace the RLC card.
■ If the diagnostic test passes, the problem is resolved.

3549=DIAGNOSTIC_DOOR_SENSOR_FAILURE_DOOR_CLOSED

Door sensor failure: Door closed

Suspect FRU List: 1) door sensor 2) RLC card 3) firmware

Isolation Procedure: 

1. Verify if the door is open or closed:
■ If open, replace the door sensor.
■ If closed, rerun the diagnostic test; the diagdoor diagnostic test may have timed out 

waiting for the door to be opened.

2. Rerun the diagnostic test:
■ If the problem persists, replace RLC card.
■ If the diagnostic test passes, the problem is resolved.

3550=DIAGNOSTIC_DOOR_OPEN_LED_FAILURE_LED_SHOULD_BE_ 
ON
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Door Open LED Failure: LED should be on

Suspect FRU List: 1) door LED 2) RLC card 3) firmware

Isolation Procedure: See result code 3553.

3551=DIAGNOSTIC_DOOR_OPEN_LED_FAILURE_LED_SHOULD_BE_ 
OFF

Door Open LED Failure: LED should be off

Suspect FRU List: 1) RLC card 2) firmware

Isolation Procedure: 

1. Rerun the diagnostic test:
■ If the problem persists, go to Step 2.
■ If the diagnostic test passes, the problem is resolved. The diagnostic test may have 

timed out on the original run.

2. Reboot the library.

3. Rerun the diagnostic test:
■ If the problem persists, replace the RLC card and go to Step 4.
■ If the diagnostic test passes, the problem is resolved.

4. Reboot the library.

5. Rerun the diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.

3552=DIAGNOSTIC_DOOR_OPEN_LED_FAILURE_LED_NOT_ON_OR_ 
FLASHING

Door Open LED Failure: LED should be on or flashing

Suspect FRU List: 1) door LED 2) RLC card 3) firmware

Isolation Procedure: See result code 3553.
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3553=DIAGNOSTIC_DOOR_OPEN_LED_FAILURE_LED_NOT_FLASHING

Door Open LED Failure: LED should be flashing

Suspect FRU List: 1) door LED 2) RLC card 3) firmware

Isolation Procedure: 

1. Rerun the diagnostic test:

■ If the problem persists, replace the door LED.

■ If the diagnostic test passes, the problem is resolved. The diagnostic test may have 
timed out on the original run.

2. Reboot the library.

3. Rerun the diagnostic test:
■ If the problem persists, replace the RLC card.
■ If the diagnostic test passes, the problem is resolved.

4. Reboot the library.

5. Rerun the diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.

3554=DIAGNOSTIC_UNABLE_TO_RETURN_LIBRARY_TO_READY

Unable to return library to ready state

Suspect FRU List: firmware

Isolation Procedure: 

1. Collect the log: print log <all>.

2. Reboot the library.

3. Rerun any diagnostic test:

■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.

3555=DIAGNOSTIC_UNABLE_TO_CLEAR_DIAG_IN_PROGRESS_FLAG

Unable to clear the diagnostic in progress flag.

Suspect FRU List: firmware

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Reboot the library.

3. Rerun any diagnostic test:
■ If the problem persists, escalate.
■ If the diagnostic test passes, the problem is resolved.
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3559=DIAGNOSTIC_CAP_OPEN_LED_FAILURE_LED_SHOULD_BE_ON

CAP Open LED Failure: LED should be on

Suspect FRU List: 1) CAP sensors, 2) CAP latch, 3) RLC card

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic test.

3. If the diagnostic tests fail, verify that at least one CAP is configured for I/O:

■ If no CAPs are configured for I/O, configure at least CAP for I/O and retry the 
diagnostic test.

■ If at least one CAP is configured for I/O, watch the robotics unit open the CAP. Does 
it open? If not, check the latch. If it opens, replace the RLC card.

3560=DIAGNOSTIC_CAP_OPEN_LED_FAILURE_LED_SHOULD_BE_OFF

CAP Open LED Failure: LED should be off

Suspect FRU List: 1) CAP sensors, 2) RLC card

Isolation Procedure: 

1. Verify all CAPs are closed:

■ If one or more CAPs are not closed, close them and rerun the diagnostic test.

■ If all CAPs are closed, continue.

2. Rerun the diagnostic tests.

If the diagnostic tests fail as before, replace the CAP sensor.

3. Rerun the diagnostic tests.

If the error persists, replace the RLC card.

3561=DIAGNOSTIC_CAP_OPEN_LED_FAILURE_LED_NOT_ON_OR_ 
FLASHING

CAP Open LED Failure: LED should be on or flashing

Suspect FRU List: 1) CAP sensors, 2) LED, 3) RLC card

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic test.

3. If the diagnostic tests fail, verify that at least one CAP is configured for I/O:

■ If no CAPs are configured for I/O, configure at least one CAP for I/O, and retry the 
diagnostic test.

■ If at least one CAP is configured for I/O, watch the robotics unit open the CAP. Does 
it open? If not, check the latch. If the latch opens, replace the RLC card.
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3562=DIAGNOSTIC_CAP_OPEN_LED_FAILURE_LED_NOT_FLASHING

CAP Open LED Failure: LED should be flashing

Suspect FRU List: 1) CAP Sensor, 2) LED, 3) RLC card

Isolation Procedure:

1. Collect the logs: print log <all>.

2. Rerun the diagnostic test:

■ If the diagnostic test fails, verify that at least CAP is configured for I/O.

■ If no CAPs are configured for I/O, configure at least one CAP for I/O, and retry the 
diagnostic test.

■ If at least one CAP is configured for I/O, watch the robotics unit open the CAP. Does 
it open? If not, check the latch. If it opens, replace the RLC card.

3563=DIAGNOSTIC_CAP_INFO_UNAVAILABLE

CAP Info Unavailable to Diagnostics

Suspect FRU List: firmware

Isolation Procedure: 

1. Collect the logs: print log <all>.

2. Rerun the diagnostic tests.

3. If the diagnostic tests fail, reboot the library.

4. Rerun the diagnostic test.

5. If the error persists, escalate.

3564=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_1_OPEN

CAP sensor failure: CAP 1 open

Isolation Procedure: See result code 3569.

3565=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_2_OPEN

CAP sensor failure: CAP 2 open

Isolation Procedure: See result code 3569.

3566=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_3_OPEN

CAP sensor failure: CAP 3 open

Isolation Procedure: See result code 3569.
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3567=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_4_OPEN

CAP sensor failure: CAP 4 open

Isolation Procedure: See result code 3569.

3568=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_5_OPEN

CAP sensor failure: CAP 5 open

Suspect FRU List: 1) CAP sensor   2) firmware

Isolation Procedure: See result code 3569.

3569=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_6_OPEN

CAP sensor failure: CAP 6 open

Suspect FRU List: 1) CAP sensor   2) firmware

Isolation Procedure:

1. Verify all CAP doors are closed: 
■ If one or more CAP doors are open, close them and wait for the audit to finish.
■ If all CAP doors are closed, replace the CAP sensor for the door indicated.

2. Rerun the diagnostic tests.

If the diagnostic tests pass with the new sensor, the problem is resolved.

If the diagnostic tests pass without the new sensor, a transient error condition exists. 
The CAP door may have been left open too long during the test.

If the diagnostic tests fail, there could be the message “CAP Door State is not closed, 
diagnostic tests will not start. One or more CAP doors is open or CAP Audit is in 
progress.” If an audit is in progress, wait until the audit is done and retry the 
command. If an audit is not in progress, replace the sensor indicated.

3570=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_1_CLOSED

CAP sensor failure: CAP 1 closed

Isolation Procedure: See result code 3575.

3571=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_2_CLOSED

CAP sensor failure: CAP 2 closed

Isolation Procedure: See result code 3575.

3572=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_3_CLOSED

CAP sensor failure: CAP 3 closed

Isolation Procedure: See result code 3575.
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3573=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_4_CLOSED

CAP sensor failure: CAP 4 closed

Isolation Procedure: See result code 3575.

3574=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_5_CLOSED

CAP sensor failure: CAP 5 closed

Isolation Procedure: See result code 3575.

3575=DIAGNOSTIC_CAP_SENSOR_FAILURE_CAP_6_CLOSED

CAP sensor failure: CAP 6 closed

Suspect FRU List: 1) CAP sensor   2) firmware

Isolation Procedure:

1. Rerun the diagnostic test, making sure none of the CAP doors are obstructed:
■ If the diagnostic test passes, the problem is resolved.
■ If the diagnostic test fails, continue.

2. Verify the CAP door indicated is closed:

■ If the indicated CAP door is closed, check the door latch. If it is too stiff, replace or 
adjust it.

■ If the indicated CAP door is open, replace the sensor.

3. Rerun the diagnostic tests:

■ If the diagnostic tests pass with the new sensor, the problem is resolved.

■ If the diagnostic tests pass with adjusting or replacing the latch, the problem is 
resolved.

■ If the diagnostic tests fail, collect traces.

3576=DIAGNOSTIC_POWER_SUPPLY_MODULE_1_SUPPLY_1_FAILED

Power Supply Failure: Module 1, Supply 1

Suspect FRU List: 1) power supply 2)power cord 3) firmware

Isolation Procedure: 

1. Verify the power supply cord is seated properly:
■ If it is not seated properly, connect the cord.
■ If it is seated properly, replace the power supply indicated by the result code. 

2. Verify the power supply is active.

3577=DIAGNOSTIC_POWER_SUPPLY_MODULE_1_SUPPLY_2_FAILED

Power Supply Failure: Module 1, Supply 2

Isolation Procedure: See result code 3576.
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3578=DIAGNOSTIC_POWER_SUPPLY_MODULE_2_SUPPLY_1_FAILED

Power Supply Failure: Module 2, Supply 1

Isolation Procedure: See result code 3576.

3579=DIAGNOSTIC_POWER_SUPPLY_MODULE_2_SUPPLY_2_FAILED

Power Supply Failure: Module 2, Supply 2

Isolation Procedure: See result code 3576.

3580=DIAGNOSTIC_POWER_SUPPLY_MODULE_3_SUPPLY_1_FAILED

Power Supply Failure: Module 3, Supply 1

Isolation Procedure: See result code 3576.

3581=DIAGNOSTIC_POWER_SUPPLY_MODULE_3_SUPPLY_2_FAILED

Power Supply Failure: Module 3, Supply 2

Isolation Procedure: See result code 3576.

3582=DIAGNOSTIC_POWER_SUPPLY_MODULE_4_SUPPLY_1_FAILED

Power Supply Failure: Module 4, Supply 1

Isolation Procedure: See result code 3576.

3583=DIAGNOSTIC_POWER_SUPPLY_MODULE_4_SUPPLY_2_FAILED

Power Supply Failure: Module 4, Supply 2

Isolation Procedure: See result code 3576.

3584=DIAGNOSTIC_POWER_SUPPLY_MODULE_5_SUPPLY_1_FAILED

Power Supply Failure: Module 5, Supply 1

Isolation Procedure: See result code 3576.

3585=DIAGNOSTIC_POWER_SUPPLY_MODULE_5_SUPPLY_2_FAILED

Power Supply Failure: Module 5, Supply 2

Isolation Procedure: See result code 3576.
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3586=DIAGNOSTIC_POWER_SUPPLY_MODULE_6_SUPPLY_1_FAILED

Power Supply Failure: Module 6, Supply 1

Isolation Procedure: See result code 3576.

3587=DIAGNOSTIC_POWER_SUPPLY_MODULE_6_SUPPLY_2_FAILED

Power Supply Failure: Module 6, Supply 2

Isolation Procedure: See result code 3576.

3588=DIAGNOSTIC_POWER_SUPPLY_MODULE_4_SUPPLY_1_DEGRADED

Power Supply Degraded: Module 4, Supply 1

Isolation Procedure: See result code 3576.

3589=DIAGNOSTIC_POWER_SUPPLY_MODULE_4_SUPPLY_2_DEGRADED

Power Supply Degraded: Module 4, Supply 2

Isolation Procedure: See result code 3576.
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CHAPTER 9

Library Miscellaneous Errors

This chapter describes how to use the library miscellaneous error result codes to isolate 
problems.

3700=LIBRARY_SYSTEM_RESOURCE_FAILURE

Library system resource failed

Suspect FRU List: firmware

Isolation Procedure:

1. Collect traces.

2. Reboot the library.

3701=LIBRARY_UNABLE_TO_MOVE_CARTRIDGE_TO_SOURCE

Note – This code becomes obsolete in firmware 1022.

Library unable to move cartridge to source

Suspect FRU List: 1) robotics unit 2) missing CAP magazine 3) firmware

Isolation Procedure:

1. Open the door.

2. Check the hand.

3. If the destination is a magazine, verify the magazine is correctly seated.

4. If the destination is a tape drive, check the bezel; replace it if it has fallen off.

5. Check the cartridge:

■ If the cartridge is correctly in the hand, close the door and reboot the library.

■ If the cartridge is not correctly in the hand, remove the cartridge.

6. Reboot the library.
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3702=LIBRARY_CARTRIDGE_IN_HAND

Note – This code becomes obsolete in firmware 1022.

Library cartridge in hand

Suspect FRU List: 1) robotics unit 2) magazine (not sitting correctly) 3) firmware

Isolation Procedure: 

1. Open the door.

2. If the destination is the magazine, verify the magazine is correctly seated.

3. If the destination is the tape drive, check the bezel; replace it if it has fallen off.

4. Check the cartridge:

■ If the cartridge is correctly in the hand, close the door and reboot the library.

■ If the cartridge is not correctly in the hand, remove the cartridge. 

5. Reboot the library.

3703=LIBRARY_THREAD_FAILED

Library thread failed

Suspect FRU List: firmware

Isolation Procedure: See result code 3705.

3704=LIBRARY_THREAD_WAIT_FAILED

Library thread wait failed

Suspect FRU List: firmware

Isolation Procedure: See result code 3705.

3705=LIBRARY_THREAD_CREATION_FAILED

Library thread creation failed

Suspect FRU List: firmware

Isolation Procedure:

1. Collect traces.

2. Reboot the library.
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3706=LIBRARY_UNABLE_TO_PARK_ROBOT

Note – This code becomes obsolete in firmware 1022.

Library unable to park robot

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Look for an obstruction:

■ The cartridge may be too far out.

■ The cartridge may be loose in the hand. Remove it.

3. Reboot the library.

3707=LIBRARY_INIT_FAILED__MESSAGE_TO_DIRECTOR_FAILED

Library initialization failed to send message to Director

Suspect FRU List: firmware

Isolation Procedure: 

1. Collect traces.

2. Reboot the library.

3708=LIBRARY_INIT_FAILED__DIRECTOR_RESPONSE

Note – This code becomes obsolete in firmware 1022.

Library initialization failed, Director response unsuccessful

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Look for an obstruction:

■ The cartridge may be too far out.

■ The cartridge may be loose in the hand. Remove it.

3. Reboot the library.
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3709=LIBRARY_INIT_FAILED__MODIFYING_ELEMENT_MAP

Library initialization failed modifying element map

Suspect FRU List: firmware

Isolation Procedure:

1. Collect traces.

2. Reboot the library.

3710=LIBRARY_INIT_FAILED__INIT_OF_CELLDB_FAILED

Library initialization failed, CELLDB init failed

Suspect FRU List: firmware

Isolation Procedure:

1. Verify the SCSI/Fibre interface is configured correctly.

2. Collect traces.

3. Reboot the library.

3711=LIBRARY_INIT_FAILED__MESSAGE_TO_HOST_PROCESS

Library initialization failed, message to host process failed

Suspect FRU List: 1) interface card 2) firmware

Isolation Procedure:

1. Verify the SCSI/Fibre interface is configured correctly.

2. Verify the interface card is seated.

3. Collect traces.

4. Reboot the library.

3712=LIBRARY_INIT_FAILED__AUDIT_FAILED

Note – This code becomes obsolete in firmware 1022.

Library initialization failed, audit failed

Suspect FRU List: 1) robotics unit 2) missing magazine

Isolation Procedure:

1. Open the door.

2. Verify that every CAP that is configured as storage has a magazine.

3. Visually check for obstructions:

■ A cartridge may be too far out.

■ A foreign object may be on the floor.
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4. Check the error logs for indication of a missing magazine.

5. Watch the audit. 

■ If the camera light is continuously on, replace the robotics unit.

■ If the camera light is continuously off, replace the robotics unit.

■ If the camera light blinks erratically, replace the robotics unit.

6. Collect the logs: print log <all>.

7. Reboot the library.

3713=LIBRARY_INIT_FAILED__CONFIGURATION_VERIFICATION_ 
FAILED

Library initialization failed, configuration failed

Suspect FRU List: 1) power supply 2) cables 

Isolation Procedure:

1. Open the door. 

2. Look for obstructions.

3. Remove any obstructions found.

4. Verify that all power supplies are active (no module is without power).

5. Verify that all cables are connected correctly.

6. Reboot the library.

3714=LIBRARY_INIT_FAILED__OPEN_CAPS

Note – This code becomes obsolete in firmware 1022.

Library initialization failed, open CAPs

Suspect FRU List: 1) CAP magazine 2) firmware

Isolation Procedure:

1. Open the CAP doors.

2. Insert the CAP magazine.

3. Reboot the library.
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3716=LIBRARY_INIT_FAILED__HAND_STILL_FULL

Library initialization failed, hand still full

Suspect FRU List: none

Isolation Procedure:

1. Verify an empty cell in a CAP magazine is available:

■ If none available, create one.

■ Reboot the library.

2. Check the robotics, get a cartridge out of the hand if possible.

3. Reboot the library.

3717=LIBRARY_INIT_FAILED_ROBOT_INIT_FAILED

Robot initialization failed

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. If the error persists, replace the robotics unit.

3718=LIBRARY_INIT_FAILED__LAST_ROW_POSITION_ACCESS

Robot initialization failed

Suspect FRU List: 1) robotics unit

Isolation Procedure:

1. Verify that the result code was output as an ERROR, if so proceed.

2. Check the library for obstructions; remove any obstructions.

3. Verify that the tray is level.

4. Verify that the library is level.

5. Verify that the tray reaches the bottom of the library (does not catch or snag on the 
way down).

6. If all of above conditions are good, replace the robotics unit.
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3719=LIBRARY_INIT_FAILED__PROCFS_REBUILD_FAILED

Rebuild of System Module portion of Proc File System failed

Suspect FRU List: 1) power supply  2) RLC card 3) firmware

Isolation Procedure:

1. Verify that all modules have power. 

2. If any modules are not powered on, then either add a power supply or replace the 
failed power supply.

3. Reboot the library.

4. If the condition persists, then collect logs and escalate.

3720=LIBRARY_INIT_FAILED__SENSORMGR_COMM_FAILED

Unable to communicate with Sensor Manager

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the problem persists, then collect traces and escalate.

3721=LIBRARY_FILE_SYSTEM_MOUNT_FAILED

Mount Failed: All saved data and passwords may be lost

Suspect FRU List: 1) RLC card 2) RLM card

Isolation Procedure:

1. Replace the RLC card.

2. Reboot the library.

3. If the problem persists, replace the RLM card.

4. Replace the RLC card with the original card.

5. Reboot the library.

6. If the problem persists, replace the RLC card (both RLM and RLC cards are now 
replaced).

7. Reboot the library.

8. If the problem persists, then collect traces and escalate.
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CHAPTER 10

SNMP Errors

This chapter describes how to use the SNMP error result codes to isolate problems.

3800=VSNMP_SOCKET_COMMAND_FAILURE

VSnmp Socket Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.

3801=VSNMP_BIND_COMMAND_FAILURE

VSnmp Bind Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.

3802=VSNMP_LISTEN_COMMAND_FAILURE

VSnmp Listen Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.
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3803=VSNMP_CONNECT_COMMAND_FAILURE

VSnmp Connect Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.

3804=VSNMP_SEND_COMMAND_FAILURE

VSnmp SEND Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.

3805=VSNMP_RECV_COMMAND_FAILURE

VSnmp RECV Command Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Reboot the library.

2. If the condition persists, then collect traces and escalate.
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CHAPTER 11

Service Errors

This chapter describes how to use the service error result codes to isolate problems.

3900=SERVICE_INVALID_OP_CODE

Service Invalid Op Code

Suspect FRU List: none 

Isolation Procedure:

1. Invoke help for the desired command.

2. Verify the syntax.

3. Retry the command.

3901=SERVICE_MISSING_PARAMETER

Service Missing Parameter

Suspect FRU List: none 

Isolation Procedure: 

Retry the command with the missing parameter included.

3902=SERVICE_BAD_PARAMETER

Service Bad Parameter

Suspect FRU List: none 

Isolation Procedure: 

Retry the command with the correct parameter.
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3903=SERVICE_COMMUNICATION_FAILURE

Service Communication Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Log off.

2. Log on.

3. Retry the command.

4. If the condition persists, collect traces and escalate.

3905=SERVICE_INVALID_COMMAND_IN_RESPONSE

Service Invalid Command In Response

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists, collect traces and escalate.

3906=SERVICE_RESPONSE_TIMEOUT

Service Response From Server Timeout

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists, collect traces and escalate.

3907=SERVICE_SOCKET_ERROR

Service DCI Socket Broken

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists:

a. Logoff.

b. Logon.

c. Retry the command.

3. If the condition persists, collect traces and escalate.
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3910=SERVICE_RECEIVE_CLI_SOCKET_FAILURE

Service Receive From CLI Socket Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists:

a. Logoff.

b. Logon.

c. Retry the command.

3. If the condition persists, collect traces and escalate.

3911=SERVICE_SEND_CLI_SOCKET_FAILURE

Service Send To CLI Socket Failure

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists:

a. Logoff.

b. Logon.

c. Retry the command.

3. If the condition persists, collect traces and escalate.

3912=SERVICE_CLI_SOCKET_UNAVAILABLE

Service CLI Socket Unavailable

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists:

a. Logoff.

b. Logon.

c. Retry the command.

3. If the condition persists, collect traces and escalate.
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3913=SERVICE_CLI_SNMP_RESULT_FAILURE

Service CLI Result Failure 

Suspect FRU List: 1) firmware

Isolation Procedure:

1. Retry the command.

2. If the condition persists:

a. Logoff.

b. Logon.

c. Retry the command.

3. If the condition persists, collect traces and escalate.
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CHAPTER 12

Robot Errors

This chapter describes how to use the robot error result codes to isolate problems.

The types of robot errors are servo/mechanism, scan, target, and coordinated motion 
(CMO).

Servo/mechanism Errors
5001=SRV_MECH_STALLED_ON_INIT

Mechanism stalled unexpectedly during initialization.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5004=ERR_SRV_UNKNOWN_REQUEST_TYPE

An unknown type of request was received by Servo.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5007=ERR_SRV_DEST_OUTSIDE_OPER_RANGE

The requested destination is not within the allowable operating range.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. If the error persists, replace the robotics unit.

5008=ERR_SRV_ILLEGAL_PROFILE_TYPE

An undefined profile type was requested.

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.

5009=ERR_SRV_OVERCURRENT

An overcurrent fault was detected by the hardware.

Suspect FRU List: robotics unit

Isolation Procedure: This error will be intermittent at first and then happen more 
frequently.

1. Reboot the library.

2. If the error persists, replace the robotics unit.

5010=ERR_SRV_EXCESSIVE_POSITION_ERROR

An excessive position error was detected during motion.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. If the error persists, replace the robotics unit.
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5011=ERR_SRV_TACH_PHASE_ERROR

A tachometer phase error was detected.

Suspect FRU List: robotics unit

Isolation Procedure: This error will be intermittent at first and then happen more 
frequently.

1. Reboot the library.

2. If the error persists, replace the robotics unit.

5012=ERR_SRV_CANT_START__NOT_IN_STOPLOCK

The requested motion cannot start because the mechanism is not in stoplock.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5013=ERR_SRV_ISR_REENTERED

The servo interrupt service routine was re-entered before exiting.

Suspect FRU List: none

Isolation Procedure: Internal software error. Should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5014=ERR_SRV_SATURATION_CURRENT_REQUESTED_TOO_LONG

The maximum or minimum current was requested an excessive amount of times.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. Issue: diagquery basicHealth.

6. If basic health is good, retry the operation.
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7. If the error persists, replace the robotics unit.

5015=ERR_SRV_MECH_DROPPED_OUT_OF_STOPLOCK

The mechanism has fallen outside the allowable stoplock range.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5016=ERR_SRV_MECH_FAILED_TO_SETTLE_INTO_STOPLOCK

The mechanism was unable to settle into the desired stoplock window.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. Issue: diagquery basicHealth.

6. If basic health is good, retry the operation.

7. If the error persists, replace the robotics unit.

5017=ERR_SRV_OPERATING_RANGE_OUT_OF_SPEC

The range of motion on initialization is not within specification.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. If the error persists, replace the robotics unit.
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5019=ERR_SRV_REDEFINED_LIB_CONFIG

The operating ranges found at arm initialization don't indicate known hardware.

Suspect FRU List: robotics unit

Isolation Procedure: 

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Make sure the Z mechanism flex cable is the proper length.

5. Reboot the library.

6. If the error persists, replace the robotics unit.

5020=ERR_SRV_BAD_MECH_ID_IN_ISR

The servo interrupt received a bad mechanism identifier.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5021=ERR_SRV_ILLEGAL_REQUEST_OPTION

An illegal request option for servo was requested.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5026=ERR_SRV_REQUEST_ALREADY_ACTIVE_AGAINST_MECHANISM

Motion is already active against mechanism.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5027=ERR_SRV_CANT_MOVE_ARM__HAND_IS_ACTIVE

Arm Request rejected - hand is currently active.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5028=ERR_SRV_CANT_MOVE_HAND__ARM_IS_ACTIVE

Hand Request rejected - arm is currently active.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5029=ERR_SRV_UNEXPECTED_RESP_AT_DISPATCHER

The servo dispatcher received an invalid response.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5030=ERR_SRV_CANT_GET_WITH_HAND_FULL

Fetch request rejected - hand is already full

Suspect FRU List:

Isolation Procedure: This error may be indicative of hand sensor problems.

If the hand has a cartridge in it:

1. There may have been a prior error.

2. Remove the cartridge from the hand, and place it in a slot.

3. Reboot the library.

4. Retry the operation.

5. If the error persists, replace the robotics unit.

If the hand is empty:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5031=ERR_SRV_CANT_PUT_WITH_HAND_EMPTY

Put request rejected - hand is empty.

Suspect FRU List: robotics unit

Isolation Procedure: This error may be indicative of hand sensor problems.

If hand has a cartridge in it:

1. There may have been a prior error.

2. Remove the cartridge from the hand, and place it in a slot.

3. Reboot the library.

4. Retry the operation.

5. If the error persists, replace the robotics unit.

If the hand is empty:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.
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5032=ERR_SRV_MOVE_ABORTED

The request ended in failure due to an abort request.

Suspect FRU List: none

Isolation Procedure: Not a failure. An abort was requested and the robotics unit should 
still be operational.

5033=ERR_SRV_HAND_NOT_SAFE__HAND_IS_INOPERATIVE

Hand is not safe - the hand is not operative.

Suspect FRU List: robotics unit

Isolation Procedure: This error may be indicative of hand sensor problems.

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge in the hand.

5. Remove a cartridge from the hand if found.

6. Reboot the library. 

7. Issue: diagquery basicHealth.

8. If basic health is good, retry the operation.

9. If the error persists, replace the robotics unit.

5034=ERR_SRV_HAND_NOT_SAFE__REACH_NOT_RETRACTED

Hand is not safe - reach is not retracted.

Suspect FRU List: robotics unit

Isolation Procedure: This error may be indicative of hand sensor problems.

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge in the hand.

5. Remove a cartridge from the hand if found.

6. Reboot the library. 

7. Issue: diagquery basicHealth.

8. If basic health is good, retry the operation.

9. If the error persists, replace the robotics unit.
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5035=ERR_SRV_HAND_NOT_SAFE__CARTRIDGE_IS_UNSEATED_IN_ 
GRIP

Hand is not safe - a cartridge is unseated in the grip.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5036=ERR_SRV_MECHANISM_NOT_INITIALIZED

Mechanism must be initialized prior to accepting a motion command.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5037=ERR_SRV_MECHANISM_SHUTDOWN

Mechanism has been shut down and requires re-initialization.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. Retry the operation.

6. If the error persists, replace the robotics unit.

5038=ERR_SRV_MECHANISM_NOT_OPERATIONAL

The mechanism is not operational.

Suspect FRU List: none

Isolation Procedure: No action required. The code may appear prior to recovery code 
being invoked.
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5040=ERR_SRV_CANT_CLEAR_AMP_ENABLE

Could not clear a bit in the amp enable register during fault processing.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5041=ERR_SRV_SATURATION_CURRENT_READ_TOO_LONG

The maximum or minimum current was read an excessive amount of times by the 
ADC.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5. If the error persists, replace the robotics unit.

5042=ERR_SRV_MINIMUM_INIT_MOVE_NOT_DETECTED

No motion detected by tachometer during mechanism initialization.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5043=ERR_SRV_REACH_SAFE_SENSOR_FAIL

Reach safe sensor did not report an encountered level.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5045=ERR_SRV_AMP_ENABLE_FAIL
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The mechanism amplifier could not be enabled.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.

5046=ERR_SRV_FAILED_STALL

The mechanism stall point was outside of allowable tolerances.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge in the hand.

5. Remove a cartridge from the hand if found.

6. Reboot the library. 

7. Issue: diagquery basicHealth.

8. If basic health is good, retry the operation.

9. If the error persists, replace the robotics unit.

5048=ERR_SRV_DEST_OUTSIDE_OPER_RANGE_ADJUSTED

The requested destination is not within the allowable operating range.

Suspect FRU List: robotics unit

Note – Non-fatal error (warning). The error, if it propagates, will be fatal.

Isolation Procedure:

1. Reboot the library.

2. If the error persists, replace the robotics unit.
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5051=ERR_SRV_POWER_LOW_ERROR

A low voltage condition has been detected on the servo motor power.

Suspect FRU List: 1) door sensor 2) cabling

Note – Error occurs when software detects a door open condition.

Isolation Procedure:

1. Verify the library door is closed.

2. Reboot the library.

3. Retry the operation.

4. If the error persists, check the door sensors and cabling for damage. Replace as 
needed.

5052=ERR_SRV_REQUEST_QUEUED_TIMEOUT

The servo module timed out waiting for a request to be queued.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5053=ERR_SRV_REQUEST_ACTIVE_TIMEOUT

The servo module timed out waiting for a request to complete.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5054=ERR_SRV_BAD_MECH_ID_IN_COORD

The servo coordinator received a bad mechanism identifier.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5055=ERR_SRV_SYS_MSG_ALLOC_FAIL

Servo could not allocate a sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5056=ERR_SRV_SYS_MSG_SEND_FAIL

Servo could not send a sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5057=ERR_SRV_SYS_MSG_RECV_FAIL

Servo could not receive a sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.



160 SL500 Diagnostic/Troubleshooting Guide • May 2010 Revision NA • 96153 

Oracle Confidential: Internal and Authorized Service Partner Use Only

5058=ERR_SRV_SYS_MSG_BAD_SIZE

Servo failed to validate the size of a received sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5060=ERR_SRV_SYS_MSG_SET_CONTENT_FAIL

Servo could not set the content of an allocated sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5061=ERR_SRV_SYS_MSG_RELEASE_FAIL

Servo could not release a allocated sys message.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5062=ERR_SRV_HAND_NOT_SAFE

Hand is not safe.

Suspect FRU List: none

Isolation Procedure: This error may be indicative of hand sensor problems.

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge in the hand.

5. Remove a cartridge from the hand if found.
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6. Reboot the library. 

7. Issue: diagquery basicHealth.

8. If basic health is good, retry the operation.

9. If the error persists, replace the robotics unit.

5064=ERR_SRV_COORD_SEND_MECH_REQUEST_FAILED

The servo coordinator received a bad mechanism identifier.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5065=ERR_SRV_HALL_ERROR

A motor hall error was detected.

Suspect FRU List: robotics unit

Isolation Procedure: This error will be intermittent at first and then happen more 
frequently.

1. Reboot the library.

2. If the error persists, replace the robotics unit.

5066=ERR_SRV_HDW_OVER_CURRENT_ERROR

A hardware overcurrent error was detected.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. Retry the operation.

3. If the error persists, replace the robotics unit.
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5067=ERR_SRV_HDW_UNKNOWN_ERROR

Hardware driver returned an unknown error.

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5068=ERR_SRV_EXCESSIVE_MOTOR_HEATING

The current in the motor is causing excessive heating.

Suspect FRU List: robotics unit

Note – Non-fatal error (warning). The error, if it propagates, will be fatal

Isolation Procedure:

1. Reboot the library.

2. If the error persists, replace the robotics unit.

5069=ERR_SRV_SAT_CURRENT_REQ_TOO_LONG_STALL_MIN_NOT_ 
REACHED

The maximum or minimum current was requested an excessive amount of times during 
a stall move with a minimum position not reached.

Suspect FRU List: none

Isolation Procedure:

1. Check for improperly installed cartridges, arrays, and drives and remedy if 
necessary.

2. Reboot the library.

3. Retry the operation.

4. If the error persists, replace the robotics unit.
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5071=ERR_SRV_DOOR_OPEN_ERROR

A door open condition has been detected. Amps are shutdown.

Suspect FRU List: 1)  door sensor

Isolation Procedure:  

1. If the door is closed, check the door sensor connections. If connected, then replace 
the door sensor.

2. If the door is open, then close the door and retry the command.

Scan Errors
5400=SCAN_FAULT_OPEN_FAILURE

Failure occurred opening scanner channel

Suspect FRU List: firmware

Isolation Procedure: Update firmware.

5401=SCAN_FAULT_POWER_UP_FAILURE

Failed to power up scanner

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. If the error persists, replace the robotics unit.

5403=SCAN_APP_RECEIVED_NO_MESSAGES

Scanner application received no messages from driver.

Suspect FRU List: none

Isolation Procedure: Not an error. Used to communicate that the scanner could not find 
a target/label when instructed to read one.

5404=SCAN_APP_TO_DRIVER_READ_TIMEOUT

Scanner application timed out while trying to read from driver.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.
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5405=SCAN_APP_TO_DRIVER_WRITE_TIMEOUT

Scanner application timed out while trying to write to driver.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5406=SCAN_APP_RECEIVED_LLF_NAK_FN

Scanner returned NAK on the outgoing packet's frame number.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5407=SCAN_APP_RECEIVED_LLF_NAK_CHKSUM

Scanner returned NAK on the outgoing packet's checksum.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5408=SCAN_APP_RECEIVED_LLF_BUSY

Scanner returned message indicating packets received are being ignored.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5409=SCAN_APP_RECEIVED_PACKET_WITH_BAD_CHKSUM

Scanner application received a packet with a bad checksum.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5410=SCAN_APP_RECEIVED_NR
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Scanner application received a packet with NR<CR> when expecting a label.

Suspect FRU List: none

Isolation Procedure: Not an error. Reason code is returned when the scanner does not 
see a label when asked to read one.

5411=SCAN_APP_BAD_STATUS

Scanner application failed to return valid status.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5412=SCAN_APP_PACKET_SIZE_TOO_LARGE

Scanner application attempted to return too large of packet.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5413=SCAN_APP_ASCII_TO_INT_PARSE_FAILURE

Scanner application failed while trying to parse target data.

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.

5414=SCAN_APP_LOOKING_FOR_TARGET_GOT_BARCODE

Scanner returned a barcode but the application was looking for a target.

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.
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5415=SCAN_APP_RECEIVED_LINE_STATUS_ERROR_INDICATION

Line status (Overrun, Framing, Break, or RxFIFO) error on scanner serial channel.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Power cycle the library.

2. If the error persists, replace the robotics unit.

5416=SCAN_APP_TARGETING_DATA_TOO_SHORT

Targeting packet received from scanner too short to contain valid data.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Inspect the library for obstruction, remove if found.

2. Power cycle the library.

3. If the error persists, replace the robotics unit.

5417=SCAN_FIRMWARE_DOWNLOAD_FAILURE

A firmware download of the scan engine failed

Suspect FRU List: robotics unit

Isolation Procedure:

1. Reboot the library.

2. If the error persists, replace the robot.
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Target Errors
5500=TARGET_EXCEEDED_MAX_ALLOWABLE_BARS

The camera reported more bars than are allowed in the array.

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.

5501=TARGET_NOT_RECOGNIZED

No valid target found in the target scan data from the camera.

Suspect FRU List: none

Isolation Procedure: 

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Reboot the library.

5502=TARGET_OFFSET_INVALID

Target offset checking found an invalid value.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Verify the target hardware to ensure it is properly installed.

2. Power cycle the library.

3. If the error persists, replace the robotics unit.

5504=TARGET_FAILED_TO_CALIBRATE_SCANNER

The calibration of the camera for targeting failed (possible that no target is present as 
well).

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.
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CMO Errors
5600=CMO_FAILED_CARTESIAN_LOOKUP_AUDIT

Failure getting cartesian coordinate data for audit

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5601=CMO_FAILED_CARTESIAN_LOOKUP_FETCH

Failure getting cartesian coordinate data for fetch

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5602=CMO_FAILED_CARTESIAN_LOOKUP_PUT

Failure getting cartesian coordinate data for put

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5603=CMO_FAILED_CARTESIAN_LOOKUP_TARGET

Failure getting cartesian coordinate data for targeting

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5604=CMO_FAILED_CARTESIAN_LOOKUP_NOMINAL

Failure getting cartesian coordinate data for nominal move

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5605=CMO_COULD_NOT_STORE_TARGET_CALIBRATION

Failure storing target calibration data in the database

Suspect FRU List: none

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.
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5606=CMO_REACH_NOT_SAFE_DETECTED

Reach safe sensor reports not safe.

Suspect FRU List: 1) robotics unit 2) sensors

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Verify that a cartridge is properly in the hand. If not, attempt to return the cartridge 
to the original slot location.

5. Reboot the library or open and close the library door. 

6. Retry the operation.

7. If the error persists, replace the robotics unit.

5607=CMO_HAND_EMPTY_DETECTED

Cartridge present sensor reports no cartridge.

Suspect FRU List: 1) robotics unit 2)sensors

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge not properly in the hand. 

5. Reboot the library or open and close the library door.

6. Retry the operation.

7. If the error persists, replace the robotics unit.

5608=CMO_HAND_FULL_DETECTED

Cartridge present sensor reports a cartridge.

Suspect FRU List: 1) robotics unit 2) sensors

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Check for a cartridge in the hand. If so, attempt to return the cartridge to the original 
slot location.

5. Reboot the library or open and close the library door.
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6. Retry the operation.

7. If the error persists, replace the robotics unit.

5609=CMO_FAILED_TARGET_CALIBRATION

The camera failed to find a target.

Suspect FRU List: robotics unit

Isolation Procedure:

1. Check that the robotics unit is properly installed.

2. Reboot the library or open and close the library door.

3. Retry the operation.

4. If the error persists, replace the robotics unit.

5610=CMO_FETCH_RETRY_PERFORMED

A retry was needed to perform a fetch.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.

5611=CMO_PUT_RETRY_PERFORMED

A retry was needed to perform a put.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.
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5612=CMO_CART_LABEL_MISCOMPARE

The cartridge label or media type did not match the one from the controller.

Suspect FRU List: cartridge

Isolation Procedure:

1. Verify that the cartridge is labeled correctly. Correct the label if required.

2. If labeled correctly, verify the Host information.

5616=CMO_INIT_FAILURE

Failed initialization

Suspect FRU List: robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check for obstructions.

3. Remove any obstructions found.

4. Make sure the robotics unit flex cable is extracted from the robotics unit chassis to 
the proper length (not too short, not too long).

5. Reboot the library or open and close the library door.

6. If the problem persists, replace the robotics unit.

5619=CMO_MOVE_RETRY_PERFORMED

A retry was needed to complete the move-arm request.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.

5620=CMO_INCONSISTENT_SUCCESS_ON_FETCH

At the end of a fetch, success was false even though the hand had a cartridge.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:
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1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.

5621=CMO_INCONSISTENT_SUCCESS_ON_PUT

At the end of a put, success was false even though the hand was empty.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.

5622=CMO_CELL_SCAN_USED_FOR_AUDIT

The normal audit failed to find a label, so slot scan was used as a retry.

Suspect FRU List: 

Isolation Procedure: Internal software error. It should not cause INOP condition. If it 
does:

1. Reboot the library.

2. Retry the operation.

3. If the error persists, check for a code update.

5624=CMO_USED_INITIAL_TARGETED_LOCATION

Calibration had to use the initial targeted location because the retarget at cal position 
failed.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.
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5625=CMO_AUDIT_LABEL_MIN_LENGTH_NOT_MET

Audit read a label but the minimum label length of six characters was not met.

Suspect FRU List: 1) labels 2) robotics unit

Isolation Procedure:

1. If the code occurs frequently, check for damaged labels. Replace any damaged labels.

2. If the labels look good, replace the robotics unit.

5626=CMO_FAILED_UNSET_TARGET_CALIBRATION

Failed to unset target calibration

Suspect FRU List: none

Isolation Procedure: Internal software error. Does not propagate.

5630=CMO_CALIBRATION_RETRY_PERFORMED

A retry was needed to perform a calibration.

Suspect FRU List: robotics unit

Isolation Procedure:

This code occurs occasionally as part of operation. Do nothing unless it occurs in large 
numbers.

If the code occurs in large numbers:

1. Check hardware (tape drives, arrays, CAPs) for defects.

2. Replace the robotics unit.
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13

Tape Drive Errors

This chapter describes how to use the tape drive error result codes to isolate problems.

6400=TTI_RESULT_DRIVE_CONDITION

Drive condition

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.

6401=TTI_RESULT_DRIVE_BUSY

Drive busy

Suspect FRU List: tape drive if it is continuously busy

Isolation Procedure: See result code 6408.

6402=TTI_RESULT_COMMAND_NOT_SUPPORTED

Drive command not supported

Suspect FRU List: None

Isolation Procedure: Collect traces.

6403=TTI_RESULT_FAIL_STATUS_COMMAND

Drive failed status command

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.

6404=TTI_RESULT_UPPER_RETRY_EXCEEDED

Upper retry limit exceeded

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.
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6405=TTI_RESULT_RETRY_EXCEEDED

Retries exceeded

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.

6406=TTI_RESULT_READ_TIMEOUT

A TTI read timeout occurred

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.

6407=TTI_RESULT_COMM_ERROR

Communication error occurred with the drive

Suspect FRU List: tape drive

Isolation Procedure: See result code 6408.

6408=TTI_RESULT_NO_DRIVE_ERROR

No drive

Suspect FRU List: tape drive

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

If the command fails, replace the tape drive.

4. Issue: drive <addr> info.

If the command fails, replace the tape drive.

5. Issue: drive <addr> getconfig.

If the command fails, replace the tape drive.

6. Issue: drive <addr> setconfig.

If the command fails, replace the tape drive.
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7. Issue: move <source addr> <dest addr>.

If the command fails, replace the tape drive.

8. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6409=TTI_RESULT_WRONG_PORT_NUM

Port number received in the response does not match the one in the request.

Suspect FRU List: software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

If the command fails, replace the tape drive.

4. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6410=TTI_RESULT_WRONG_PACKET_SIZE

Response packet size doesn't match the packet length specified.

Suspect FRU List: 1) tape drive firmware 2) tape drive 3) software

Isolation Procedure:

1. Collect traces.

2. If the problem persists, reboot.

6411=TTI_RESULT_FAIL_DETERMINE_INSTALLED_DRIVE

Failed to determine what type of drive is installed.

Suspect FRU List: 1) tape drive 2) software

Isolation Procedure: See result code 6414.
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6412=TTI_RESULT_FAIL_TO_SET_HOLDOFF_LOAD

Failed to set the drive to holdoff load mode

Suspect FRU List: tape drive

Isolation Procedure: See result code 6414.

6413=TTI_RESULT_FAIL_TO_SET_FILE_PROTECT 

Failed to set the drive to file protect mode

Suspect FRU List: 1) tape drive

Isolation Procedure: See result code 6414.

6414=TTI_RESULT_UNKNOWN_DRIVE

Request failed because the drive is unknown

Suspect FRU List: 1) tape drive 2) software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

If the command fails, replace the tape drive.

4. Issue: drive <addr> info.

If the command fails, replace the tape drive.

5. Issue: drive <addr> getconfig.

If the command fails, replace the tape drive.

6. Issue: drive <addr> setconfig.

If the command fails, replace the tape drive.

7. Issue: move <source addr> <dest addr>.

If the command fails, replace the tape drive.

8. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)



Oracle Confidential:  Internal and Authorized Service Partner Use Only

96153 • Revision NA Chapter 13  179

6415=TTI_RESULT_LOAD_FAIL_CART_PRESENT

The load failed and the cartridge is still present.

Suspect FRU List: 1) tape drive 2) robotics unit

Isolation Procedure:

1. Issue: drive <addr> state. 

2. If the drive state results indicate a cartridge is present,  
issue: drive <addr> load.

3. If the load fails, open the door and attempt to push the cartridge into the tape drive.

4. Issue: drive <addr> load.

5. If the load fails, attempt to manually load a different cartridge.

6. Issue: drive <addr> state.

7. If the drive state indicates a cartridge is present,  
issue: drive <addr> load.

8. If the load fails, replace the tape drive.

6416=TTI_RESULT_LOAD_FAIL_NO_CARTRIDGE

The load failed because there is no cartridge present

Suspect FRU List: 1) tape drive 2) robotics unit

Isolation Procedure:

1. Open the front door.

2. Determine the cartridge location (tape drive or hand).

If the cartridge is in the tape drive:

1. Issue: drive <addr> state.

If the command fails, replace the tape drive.

Do the results indicate that the cartridge is not present?

If an IBM tape drive:

1. Open the door.

2. Attempt to push the cartridge all the way into the tape drive.

3. Issue: drive <addr> state.

4. If the result indicates that the cartridge is present, replace the tape drive.
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If a Hewlett-Packard tape drive:

If the cartridge is sitting in the tape drive, replace the tape drive (sensor is not 
functional).

If the cartridge is not in the tape drive:

1. Check the robotic hand.

2. Manually extract the cartridge from the hand.

3. Issue: move <source addr> <dest addr>.

4. If the cartridge doesn’t load, issue: drive <addr> state.

5. If the results indicate that the cartridge is not present, check the hand.

6. If the cartridge is in the hand, replace the robotics unit.

7. If the cartridge loads, the problem is resolved.

6417=TTI_RESULT_DRIVE_INTERFACE_TYPE_UNKNOWN

Drive configuration was tried, but the interface type is unknown.

Suspect FRU List: 1) tape drive 2) drive firmware 3) software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

4. If a Hewlett-Packard tape drive, repeat steps 2 and 3, but pull the tape drive instead 
of resetting it. 

5. If the drive state command fails a second time, replace the tape drive.

6. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

Note – The log_error trace file should have an entry for Incompatible Drive Type.
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6418=TTI_RESULT_DRIVE_UNKNOWN_CART_POSITION

The drive tried to load the cart, but failed. Cart position in drive unknown

Suspect FRU List: 1) tape drive 2) robotics unit

Isolation Procedure:

1. Open the door.

2. Visually check the position of the cartridge.

a. If it is stuck, try removing it.

b. If you cannot remove it, remove the tape drive and manually remove the cartridge.

3. Issue: drive <addr> load.

4. If the load fails, replace the robotics unit.

5. Issue: drive <addr> rewindunload.

6. If the tape drive cannot rewind and unload, replace the tape drive.

6419=TTI_RESULT_INVALID_RESPONSE_PACKET

The response packet was invalid.

Suspect FRU List: 1) tape drive 2) drive firmware

Isolation Procedure:

1. Check the tape drive firmware for the correct version of STK variant firmware: 
drive <addr> info.

2. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

3. Issue: drive <addr> info.

4. If the problem persists, update firmware.

5. If the tape drive is a new type (it might not be supported by the software yet), 
replace the tape drive.

6420=TTI_RESULT_IBM_LTO_COOLING_ERROR

The IBM LTO drive reported a cooling error.

Suspect FRU List: 1) tape drive

Isolation Procedure: Replace the tape drive.
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6421=TTI_RESULT_IBM_LTO_POWER_ERROR

The IBM LTO drive reported a power error.

Suspect FRU List: tape drive

Isolation Procedure: Replace the tape drive.

6422=TTI_RESULT_IBM_LTO_CODE_ERROR

The IBM LTO drive reported a microcode error.

Suspect FRU List: drive firmware

Isolation Procedure: Replace the tape drive.

6423=TTI_RESULT_IBM_LTO_CODE_OR_DRIVE_ERROR

The IBM LTO drive reported a microcode or drive hardware error.

Suspect FRU List: 1) tape drive firmware 2) tape drive

Isolation Procedure: Replace the tape drive.

6424=TTI_RESULT_IBM_LTO_DRIVE_FAILURE

The IBM LTO drive reported a drive failure.

Suspect FRU List: tape drive

Isolation Procedure: Replace the tape drive.

6425=TTI_RESULT_IBM_LTO_DRIVE_OR_MEDIA_ERROR

The IBM LTO drive reported a drive or media error.

Suspect FRU List: 1) media 2) tape drive 

Isolation Procedure: Replace the tape drive.

6426=TTI_RESULT_CARTRIDGE_MEDIA_ERROR

The drive reported a cartridge media error. This can occur on load or unload.

Suspect FRU List: 1) media 2) tape drive

Isolation Procedure:

1. Move the cartridge to another tape drive: 

move <source addr> <dest addr>

2. If the problem persists, replace the cartridge.

3. If problem disappears, issue: drive <addr> state. 
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4. Determine if the tape drive needs cleaning from the drive state command.

If cleaning is required, do it.

If cleaning is not required, continue to the next step.

5. Move a different cartridge to the original tape drive.

6. If the error persists, replace the tape drive. 

6427=TTI_RESULT_IBM_LTO_SCSI_OR_FIBRE_ERROR

The IBM LTO drive reported a SCSI or Fibre Channel error.

Suspect FRU List: 1) tape drive 2) Fibre/SCSI connector 3) cable

Isolation Procedure: See result code 6430.

6428=TTI_RESULT_IBM_LTO_RS_422_ERROR

The IBM LTO drive reported an RS422 error.

Suspect FRU List: 1) tape drive 2) RLC card

 Isolation Procedure: See result code 6430.

6429=TTI_RESULT_IBM_LTO_DRIVE_ERROR

The IBM LTO drive reported a recoverable drive error.

Suspect FRU List: tape drive

Isolation Procedure: See result code 6430.

6430=TTI_RESULT_IBM_LTO_FIBRE_PORT_OFFLINE

The IBM LTO drive reported that the Fibre port is OFFLINE.

Suspect FRU List: 1) tape drive 2) cable 3) switch

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

Pull the tape drive out, wait 10 seconds, then put it back in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

4. If the command fails, replace the tape drive.



Oracle Confidential:  Internal and Authorized Service Partner Use Only

184 SL500 Diagnostic/Troubleshooting Guide • May 2010 Revision NA • 96153

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6431=TTI_RESULT_IBM_LTO_FIBRE_NO_LIGHT_DETECTED

The IBM LTO Drive reported NO LIGHT DETECTED on the FIBRE PORT. Fibre cable 
might not be connected.

Suspect FRU List: 1) tape drive 2) cable 3) switch port

Isolation Procedure:

1. Re-seat the cable; if the problem persists, continue.

2. Try other port; if the problem persists, continue.

3. Try a different switch port; if the problem persists, replace the tape drive.

6432=TTI_RESULT_IBM_LTO_FIBRE_AL_PA_CONFLICT

The IBM LTO Drive reported an AL_PA conflict. Two ports have the same AL_PA

Suspect FRU List: 1) configuration 2) tape drive

Isolation Procedure:

1. Try a different loop id; if the problem persists, continue.

2. Set to soft ID; if the problem persists, replace the tape drive.

6433=TTI_RESULT_INCORRECT_SEQUENCE_NUMBER

The Response Sequence Number Does Not Match the Request Sequence Number

Suspect FRU List: software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. If the command fails, issue: drive <addr> state.
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4. If a Hewlett-Packard tape drive, repeat steps 2 and 3, but pull the tape drive instead 
of resetting it. 

If the drive state command fails a second time, replace the tape drive.

If an IBM tape drive, replace it.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6434=TTI_RESULT_UNIT_CHECK_CONDITION

The Drive Returned a Unit Check Condition in the Response

Suspect FRU List: tape drive

Isolation Procedure:

1. Check the command.

2. Reissue the command.

3. If the condition persists, replace the tape drive.

6435=TTI_RESULT_SURROGATE_SCSI_TASK_ABORTED

The Drive Received an Abort Message While Processing a Surrogate SCSI Command

Suspect FRU List: software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Reissue the command.

3. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

4. Collect traces, escalate.
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6436=TTI_RESULT_UNKNOWN_STATUS

The Drive Returned an Unknown Status in the Response

Suspect FRU List: 1) tape drive 2) software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. If the command fails, issue: drive <addr> state.

4. If a Hewlett-Packard tape drive, repeat steps 2 and 3, but pull the tape drive instead 
of resetting it. 

If the drive state command fails a second time, replace the tape drive.

If an IBM tape drive, replace it.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6437=TTI_RESULT_DRIVE_NEEDS_CLEANING

The drive has indicated it needs to be cleaned

Suspect FRU List: 1) No FRU – Clean the drive

Isolation Procedure: Clean the tape drive.

6438=TTI_RESULT_FAIL_TO_RESET_HOLDOFF_LOAD

Failed to reset the drive holdoff load mode

Suspect FRU List: tape drive

Isolation Procedure:

1. Move the cartridge to another tape drive: 

move <source addr> <dest addr>

2. If the problem persists, replace the cartridge. 

3. If problem disappears, move a different cartridge to the original tape drive:

move <source addr> <dest addr>

4. If the problem persists, replace the tape drive.
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6439=TTI_RESULT_DRV_EMPTY_POSSIBLE_OVEREJECT

Drive is empty on rewindUnload: possible overeject

Suspect FRU List: tape drive

Isolation Procedure:

1. Open the door.

2. Visually inspect the cartridge.

3. Re-insert the cartridge into the tape drive manually.

4. If the cartridge doesn’t load, replace the tape drive.

5. If the cartridge loads, issue: drive <addr> rewindunload.

6. If conditions persists, replace the tape drive.

6440=TTI_RESULT_LOAD_TIMEOUT

The drive failed to load within the allotted time

Suspect FRU List: 1) tape drive 2) media

Isolation Procedure:

1. Move the cartridge to another tape drive:

move <source addr> <dest addr>

2. If the cartridge does not load, replace the cartridge. 

3. If the cartridge does load, move a different cartridge to the original tape drive: 

move <source addr> <dest addr>.

4. If the problem persists, replace the tape drive.

6441=TTI_RESULT_UNLOAD_TIMEOUT

The drive failed to unload within the allotted time

Suspect FRU List: 1) tape drive 2) media

Isolation Procedure:

1. Open the door.

2. Visually check for a stuck cartridge.

3. If no cartridge is stuck, replace the tape drive.

4. If a cartridge is stuck, issue: drive <addr> rewindunload.

5. If the cartridge remains stuck, remove the tape drive and manually eject the 
cartridge.

6. Replace the tape drive.
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6442=TTI_RESULT_HP_TIMEOUT

A Hewlett-Packard LTO Drive command Timeout occurred

Suspect FRU List: 1) tape drive 2) drive firmware 3) software 

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. If the command fails, issue: drive <addr> state.

4. If a Hewlett-Packard tape drive, repeat steps 2 and 3, but pull the tape drive instead 
of resetting it. 

If the drive state command fails a second time, replace the tape drive.

If an IBM tape drive, replace it.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6443=TTI_IBM_NACK_RECEIVED

The IBM LTO drive returned a NAK to the last command

Suspect FRU List: tape drive

Isolation Procedure: See result code 6444.

6444=TTI_IBM_SNACK_RECEIVED

The IBM LTO drive returned a SNAK to the last command

Suspect FRU List: tape drive

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

Pull the tape drive out, wait 10 seconds, put it back in. 
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Note – In a fully populated library, the wait could be up to 20 seconds.

3. If the command fails, issue: drive <addr> state.

4. If the command fails again, replace the tape drive.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6445=TTI_IBM_NO_ETX_VALUE

The IBM LTO drive didn't return an ETX value.

Suspect FRU List: 1) software 2) tape drive

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

Pull the tape drive out, wait 10 seconds, put it back in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. Issue: drive <addr> state.

4. If the command fails, replace the tape drive.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6446=TTI_IBM_IMPROPERLY_STUFFED_RESPONSE

The data packed contained an improperly stuffed response.

Suspect FRU List: 1) tape drive 2) software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

Pull the tape drive out, wait 10 seconds, put it back in.

Note – In a fully populated library, the wait could be up to 20 seconds.
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3. Issue: drive <addr> state.

4. If the command fails, replace the tape drive.

5. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)

6447=TTI_RESULT_PREVENT_MEDIA_REMOVAL

The drive reported prevent media removal set

Suspect FRU List: software

Isolation Procedure:

1. Activate traces for the tape drive in question:

■ trace drive-tti-xx on (xx is the drive id)

■ trace tti-dbg-xx on (xx is the drive id)

2. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

3. If the command fails, issue: drive <addr> state.

4. If a Hewlett-Packard tape drive, repeat steps 2 and 3, but pull the tape drive instead 
of resetting it. 

If the drive state command fails a second time, replace the tape drive.

If an IBM tape drive, replace it.

5. Issue: drive <addr> rewindunload.

6. If the drive fails to unload, remove the cartridge manually.

7. If the problem persists, replace the tape drive. 

8. Deactivate the traces for the tape drive in question:

■ trace drive-tti-xx off (xx is the drive id)

■ trace tti-dbg-xx off (xx is the drive id)
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6448=TTI_Hewlett-Packard_OFF_BUS

The Hewlett-Packard LTO drive has gone off the bus

Suspect FRU List: 1) software 2) tape drive

Isolation Procedure: 

Action Require:

1. Check the SCSI/Fibre cables.

2. Issue: drive <addr> setconfig.

3. Initialize the tape drive.

If a Hewlett-Packard tape drive, issue: drive <addr> reset.

If not a Hewlett-Packard tape drive, pull the tape drive out, wait 10 seconds, put it back 
in. 

Note – In a fully populated library, the wait could be up to 20 seconds.

4. Issue: drive <addr> getconfig.

5. Check for port enabled from getconfig results.

■ If the condition persists and the cable is Fibre, move the cable to Port B, and check 
for port enabled (as above).

■ If the condition persists and the cable is Fibre, try another switch port and check for 
port enabled (as above).

■ If the condition persists and the cable is SCSI, try another cable and check for port 
enabled (as above).

6. If the condition persists, replace the tape drive.

Note – Reset time for tape drives may be longer than 10 seconds for a fully populated 
library (20 seconds).

6449=TTI_RESULT_IBM_DRIVE_POST_PROCESSING

The IBM LTO Drive is in POST Processing.

Suspect FRU List: none

Isolation Procedure:  No action required - informational only

6452=TTI_RESULT_IBM_UNLOAD_RETRY_WARNING

An IBM drive unload failed, but the retry succeeded

Suspect FRU List: none

Isolation Procedure:  No action required - informational only
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6453=TTI_RESULT_CLEANING_CARTRIDGE_EXPIRED

Load failed due to expired cleaning cartridge.

Suspect FRU List: cleaning cartridge

Isolation Procedure: 

1. Replace the cleaning cartridge.

2. Retry the tape drive cleaning.
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14

Sensor Errors

This chapter describes how to use the sensor error result codes to isolate problems.

Enviromentals for power supplies:

8000=SM_MODULE_POWER_SUPPLY_INSTALLED

Module power supply installed

Suspect FRU List: none

Isolation Procedure:  No action required - informational

8001=SM_MODULE_POWER_SUPPLY_REMOVED

Module power supply removed

Suspect FRU List: none

Isolation Procedure:  No action required - informational

8002=SM_MODULE_POWER_SUPPLY_WORKING

Module power supply working

Suspect FRU List: none

Isolation Procedure: No action required - informational

8003=SM_MODULE_POWER_SUPPLY_FAILED

Module power supply failed

Suspect FRU List: 1) power supply 2) firmware

Isolation Procedure: 

Replace the failed power supply.
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Environmentals for fans

8010=SM_MODULE_FAN_WORKING

Module fan working

Suspect FRU List: none

Isolation Procedure: No action required - informational

8011=SM_MODULE_FAN_FAILED

Module fan failed

Suspect FRU List: 1) module fan

Isolation Procedure: 

Replace the failed module fan.

8012=SM_DRIVE_FAN_WORKING

Drive fan working

Suspect FRU List: none

Isolation Procedure: No action required - informational

8013=SM_DRIVE_FAN_FAILED

Drive fan failed

Suspect FRU List: 1) tape drive assembly 2) firmware

Isolation Procedure: 

Replace the failed tape drive assembly.

Environmentals for temperature sensors

8020=SM_MODULE_TEMP_WARNING_LEVEL

Module temperature sensor has exceed the warning level

Suspect FRU List: 1) module fan

Isolation Procedure: 

1. Verify that the module fans are spinning.

2. Check the logs for indications of a module fan failure.

3. Replace any module fan indicated as failed.

4. Verify that the library environment is within the normal operating parameters.
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8021=SM_MODULE_TEMP_SHUTDOWN_LEVEL

Module temperature sensor has reached the shutdown level

Suspect FRU List: 1) module fans

Isolation Procedure: 

1. Verify that the module fans are spinning.

2. Check the logs for indications of a module fan failure.

3. Replace any module fan indicated as failed.

4. Verify that the library environment is within the normal operating parameters.

8022=SM_DRIVE_TEMP_WARNING_LEVEL

Drive temperature sensor has exceed the warning level

Suspect FRU List: 1) tape drive assembly

Isolation Procedure: 

1. Verify that the drive fan is spinning. If not, then replace the tape drive assembly.

2. Check the logs for indications of a drive fan failure.

3. Replace any drive fan indicated as failed.

4. Verify that the library environment is within the normal operating parameters.

8023=SM_DRIVE_TEMP_SHUTDOWN_LEVEL

Drive temperature sensor has reached the shutdown level

Suspect FRU List: 1) tape drive assembly

Isolation Procedure: 

1. Verify that the drive fan is spinning. If not, replace the fan.

2. Check the logs for indications of drive fan failure.

3. Replace the tape drive assembly if the drive fan is indicated as failed.

4. If the condition persists, verify that the library environment is within normal 
operating parameters.
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15

Initialization

This chapter describes the initialization sequence. If the sequence does not complete, 
use the previous chapters to resolve the problem.

Note – If, when you power-on the library, the X table does not lower after a few 
minutes, the main pulley gear might be too tight to allow the solenoid to release the 
pawl. To fix this problem, with power applied, reach into the back right hand corner of 
the robotics unit and move the lever toward the gear.

Initialization occurs when the library is powered-on or when the front door is opened 
and closed. During initialization:

1. The RLC card applies voltage to the motors (gripper, reach, wrist, and Z drive) to 
obtain the motors’ ranges of motion.

2. The robotic components’ ranges of motion are tested.

3. The targets and labels are read for calibration purposes.

4. The slots are audited for cartridge volume serial numbers. This information is stored 
on the RLC card.

Note – In the following discussion, robot refers to the robotic components in general, X 
components are components that move along the X axis (horizontally), and Z 
components are components that move along the Z axis (vertically).

The initialization sequence can start with the robot fully retracted into the robotics unit 
(parked) or with the robot outside of the robotics unit (not parked).
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The robot is parked
The firmware tells the robotic components to:

1. Move the gripper to the open and then the closed positions.

2. Move the reach components to the extended end stop, then to the retracted end stop.

3. Move the wrist to the counterclockwise end stop, then to the clockwise end stop.

4. Lower the Z components from the top end stop to the bottom end stop.

5. Move the Z components off the floor a few inches (a clicking noise is normal during 
this move).

6. Move the X components to the front end stop, then to the back end stop.

7. Move the X components to the center position so the wrist can be initialized.

8. Move the wrist to the counterclockwise end stop, then to the clockwise end stop.

9. Move the wrist to point at the back of the rack (parallel with the X axis).

10. If no cartridge is present, move the reach components to the extended end stop, 
then to the retracted end stop.

11. If no cartridge is present, move the gripper to the closed end stop, then to the open 
end stop.

12. Scan the library for module configuration labels.

13. Begin the calibration and audit, using the hand assembly bar-code scanner:

a. Use the target on each array to determine fine positioning. 

b. Scan each slot to determine the volume serial number of any cartridge present. 
The RLC card's volatile memory stores the information.

14. If a cartridge is present, place the cartridge in an empty CAP slot if available. If no 
CAP slot is available, place the cartridge in the next available slot within the library. 

If no slot is available, the initialization fails, and a message appears on the 
StreamLine Library Console saying that the cartridge needs to be removed from the 
hand or a CAP slot needs to be made available.

15. After the cartridge is dropped off, point the wrist in the tape drive direction.

16. Move the reach components to the extended end stop, then to the retracted end 
stop.

17. Move the gripper to the open and then the closed positions.
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The robot is not parked
When the library is powered-on, the firmware does not know the position of each of the 
robotic components. The firmware must determine, one at a time, when each 
component can be moved from end stop to end stop.

Note – The actual steps might vary, depending on component positions, but generally 
occur in the following order.

The firmware tells the robotic components to:

1. Check for a cartridge present in the hand. If a cartridge is present, make sure that the 
cartridge is gripped securely.

2. Make sure that the reach components are fully retracted.

3. Move the wrist to the counterclockwise end stop, then to the clockwise end stop.

4. Move the wrist to the Column 1 position (perpendicular to the X axis).

5. Move the X components to the back end stop, then to the front end stop.

6. Move the X components to the home position, in front of the X table.

7. Lower the Z components from the top end stop to the bottom end stop.

8. Move the Z components off the floor a few inches (a clicking noise is normal during 
this move).

9. Move the wrist to point at the back of the rack (parallel with the X axis).

10. If no cartridge is present, move the reach components to the extended end stop, 
then to the retracted end stop.

11. Scan the library for module configuration labels.

12. If no cartridge is present, move the gripper to the closed end stop, then to the open 
end stop. 

13. Move the gripper to the open position.

14. Begin the calibration and audit, using the hand assembly bar-code scanner:

a. Use the target on each array to determine fine positioning.

b. Scan each slot to determine the volume serial number of any cartridge present. 
The RLC card's volatile memory stores the information.

15. If a cartridge is present, place the cartridge in an empty CAP slot if available. If no 
CAP slot is available, place the cartridge in the next available slot within the library.

If no slot is available, the initialization fails, and a message appears on the 
StreamLine Library Console saying that the cartridge needs to be removed from the 
hand or a CAP slot needs to be made available. 
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APPENDIX A

SNMP

This appendix provides the implementation of the Simple Network Management 
Protocol (SNMP) for the SL500 library. It contains information and procedures for using 
the command line interface (CLI) and StorageTek Library Console.

Overview
SNMP allows systems administrators to query the library for configuration, operation, 
and statistical information. SNMP also allows the library to inform the systems 
administrator of potential problems.

Note – By default, the SNMP agent is turned off. Activate it through the command line 
interface (CLI). 

Work with your customer to set up SNMP. Keep the security of proprietary information 
as your first consideration.

Systems administrators and network managers use SNMP to monitor and receive status 
from the library, such as:
■ Operational state of the library, such as firmware level, serial number, online/offline 

status
■ Other variables defined in the database 

SNMP is an application-layer protocol that performs network management operations 
over an Ethernet connection using a User Datagram Protocol (UDP/IP). SL500 libraries 
support the following versions:

■ SNMPv2c is the simple network management protocol for machine status queries; 
the information transmitted is read-only and not secure.

■ SNMPv3 is reserved for proprietary information, because it supports encryption and 
strong user identification. SNMPv3 is the preferred protocol for proprietary data and 
is both read and write. 
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FIGURE A-1 illustrates a simple network block diagram that identifies the locations of the 
SNMP software application. This figure also identifies the IP addresses and other 
components involved in that configuration, such as Ethernet connections and the 
location of the MIB within the library controller card (RLC).

FIGURE A-1 SNMP Block Diagram Example

1. SNMP software application that implements the role of manager. Examples are Oracle’s SunNet Manager, 
HP OpenView, and IBM NetView.

2. The Management Information Base (MIB), copied from the library controller card.
3. Ethernet connection (ENET) for the library (public port on the RLC card).
4. SNMP agent is a process running on the library controller card. 
5. MIB data can be read by v2c users; read/write access is only available to v3 users (see “Access Control” on 

page 204). MIB data is read by the customer through the StorageTek Library Console (see “Copying the 
MIB Text File” on page 206).
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SNMP Terms
SNMP uses a manager/agent structure, a database, and a small set of commands to 
exchange information. SNMP terms include: 

■ Advanced Encryption Standard (AES) – An NIST-standard cryptographic cipher 
that uses a block length of 128 bits and key lengths of 128, 192, or 256 bits. AES uses 
the Rijndael algorithm, officially replacing the Triple DES Method. AES encryption 
can be done in one pass instead of three and its key size is greater than Triple Des’s 
168 bits. One of two privacy encryption protocols, AES is a stronger form of 
encryption than DES (see also “Data Encryption Standard”). (source: The Internet 
Society, RFC 3664)

■ Agent – A module that resides in a managed device. The agent responds to requests 
from the manager and sends traps to a recipient to inform the systems administrator 
of potential problems.

■ Community String – Applications that use community strings for access control. 
The manager includes the community string in its SNMP messages to an agent. The 
agent can accept or reject the operation. A maximum of 31 alphanumeric characters 
are permitted.

■ Data Encryption Standard (DES) – An NIST-standard cryptographic cipher that 
uses a 56-bit key. DES has been replaced by AES as an official standard. DES is a 
symmetric block cipher that processes 64-bit blocks in four different modes of 
operation (electronic code book [ECB] being the most popular). Triple DES added 
security by providing several, multiple-pass techniques. As an example, Triple DES 
encrypts with one key, decrypts the results with a different key, and then encrypts 
with a third. These extra passes add considerable time, DES, however, is still used 
for applications that do not require the strongest security. DES is one of two privacy 
encryption protocols (see also “Advanced Encryption Standard”). (source: The 
Internet Society, RFC 1829)

■ EngineId – An administratively unique identifier of an SNMP v3 engine used for 
identification, not for addressing (Source; The Internet Society, RFC 3411). SNMP v3 
authentication and encryption keys are generated based upon the associated 
passwords and the engine ID.

■ Host keyword – Currently, the host keyword is limited to the machine’s IP address 
(DNS is not available at this time). The maximum keyword length is 31 
alphanumeric characters.

■ Managed device – A device that hosts the services of an SNMP agent that provides 
monitored information and controlled operations using SNMP. SL500 libraries are 
managed devices.

■ Management Information Base (MIB) – A collection of information stored in a 
database that contains configuration and statistical information for a managed 
device. For SL500 libraries, a copy of the MIB is loaded with firmware and stored on 
the controller card. See “Management Information Base” on page 205 for more 
information about the MIB. 

■ Manager – Provides the communication link between the systems administrator and 
the managed devices on the network. A manager station or server allows the 
systems administrator to get information about the device through the MIB and to 
receive traps from an agent.
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■ Message Digest 5 (MD5) – A popular one-hash function that is used to create a 
message digest for digital signatures. MD5 is faster than Secure Hash Algorithm, but 
is considered less secure (see also “Secure Hash Algorithm”). (source: The Internet 
Society, RFC 1321)

■ Recipient – A location on a manager where the SNMP agent sends traps. This 
location is defined by the combination of either the IP address or DNS name and the 
port number. The default recipient port number is 162.

■ Secure Hash Algorithm (SHA-1/SHA) – A popular one-hash algorithm used to 
create digital signatures; it is more secure, but slightly slower than MD5 (see also 
“Message Digest 5”). (source: The Internet Society, RFC 3174)

■ Trap/Notification – A message that reports a problem, error, or significant event that 
occurred within the device.

■ Trap Level String – The list of trap levels that are filtered (see TABLE A-4). The 
maximum length is 31 alphanumeric characters.

SNMP Commands
SNMP offers commands that follow a simple request/response exchange to 
communicate between the manager and the agent.

The manager issues request such as:
■ Get – A request for information of a specific variable.
■ GetNext – A request for the next specific variable.
■ Set – A request to change the value of a specific variable.

The agent responds with:

Get-Response – A response to the manager’s Get and GetNext commands.

The agent sends out asynchronous events:

Trap – An asynchronous message to the recipients about an event.

SNMP “walks” are also functional. Refer to the SNMP software documentation for 
additional information.

Access Control
Because community strings provide a form of access control in SNMP, the embedded 
agent will not rely on the private community string in order to accept changes to the 
library’s configuration. The MIB can be viewed with v3/v2 get/getnext. The 
library properties can only be changed with the v3 set command.

The administrative password provides access control and authorization for Set 
operations. Consequently, the embedded agent uses only one community string for 
both Get and Set operations.

Traps can be sent to recipients using v2c/v3-based PDUs. Different community strings 
can be specified while adding entries to the Trap Recipient List.
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Management Information Base
The MIB is a viewable document that contains descriptions about the characteristics for 
a managed device. These characteristics are the functional elements for that device 
which can be monitored using SNMP software.

Note – SL500 libraries implement only MIB extensions defined in the SLSERIES-TAPE-
LIBRARY-MIB under the private (4) section as shown in FIGURE A-2.

FIGURE A-2 Management Information Base Hierarchy

MIB Tree Root 
Object Name = StreamLine-Tape-Library-MIB::streamlineTapeLibrary == 
1.3.6.1.4.1.1211.1.15
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Copying the MIB Text File
The MIB text resides within the library controller card. Users must copy this file using 
the Transfer File utility available with version 2.91 (2.26.00) or higher of StorageTek 
Library Console.

To copy the MIB file:

1. Log on to the library using StorageTek Library Console.

2. Choose Tools ⇒ Diagnostics.

3. Choose the TransferFile tab.

4. Click the Transfer button next to the 
STREAMLINE_TAPE_LIBRARY_MIB_TEXT.text file.

5. In the Save dialog box, choose a Save in folder.

6. Type in a file name.

7. Click Save.

MIB-2 Support
The SL500 agent supports the MIB data listed in TABLE A-1.

TABLE A-1 MIB Data Supported

Number Title Description

1.3.6.1.2.1.1 mib-2.system Device description, location and contact

1.3.6.1.2.1.2 mib-2.interfaces Network interface table

1.3.6.1.2.1.3 mib-s.at Network address translation table

1.3.6.1.2.1.4 mib-s.ip IP protocol statistics

1.3.6.1.2.1.5 mib-s.icmp ICMP protocol statistics

1.3.6.1.2.1.6 mib-s.tcp TCP protocol statistics

1.3.6.1.2.1.7 mib-s.udp UDP protocol statistics

1.3.6.1.2.1.11 mib-s.snmp SNMP protocol statistics
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Network Auto-Discovery and Mapping
For auto-discovery to include the SL500 library, the SNMP agent provides the basic 
StorageTek Tape Library MIB variables listed in TABLE A-2.

TABLE A-2 StorageTek Tape Library MIB Variables—Basic

Variable Title Description

1.3.6.1.4.1.1211.1.15.3.1 slLibStkBaseModel SL500

1.3.6.1.4.1.1211.1.15.3.2 slLibSerialNumber 516xxxxxxxxx

1.3.6.1.4.1.1211.1.15.3.3 slLibWWNNumber xx:xx:xx:xx:xx:xx:xx:xx

1.3.6.1.4.1.1211.1.15.3.4 slLibraryTopLevelCondition normal(0), degraded(1), 
notoperative(2)

1.3.6.1.4.1.1211.1.15.3.10.1 slLibLocatContact <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.2 slLibLocatStreet <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.3 slLibLocatState <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.4 slLibLocatZip <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.5 slLibLocatCountry <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.6 slLibLocatDescr <assigned by site admin>

1.3.6.1.4.1.1211.1.15.3.10.7 slLibLocatCity <assigned by site admin>
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SNMP Default Settings
The SL500 comes configured with the default settings listed in TABLE A-3.

TABLE A-3 SNMP Default Settings

Setting Default Description

Port ID Disabled Agent trap requests are sent and received on the LAN Port (RLC 
card, public port)

Socket Number 161 Agent requests are sent and received on this enabled port. The 
port must be enabled to pass through a customer’s firewall.

Socket Number 162 Traps are sent on this socket on the enabled port. The port must 
be enabled to pass through a customer’s firewall.

v2c users string Public Community String Public Agent Community. This field is used 
only to read the MIB data. There can be a maximum of 20 v2c 
users. This field can be changed or deleted.

v3 users string Empty Community String Public Agent Community. This field is used to 
read/write the MIB data. There can be a maximum of 20 v3 users. 
This field can be changed or deleted.

Trap Recipients Empty This list supports up to 20 v2c and v3 recipients with no duplicate 
entries. Users must add themselves to the recipients list for traps 
to be sent to them.

SNMP (agent) Disabled Enabled or Disabled through CLI command only.
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SNMP Traps/Notifications
You must add users to the recipients list and configure the traps required to give them 
access to the information. 

Trap/Notification Levels
Trap or notification levels are generally filtered to include only those traps that a user 
wishes to monitor. These levels are specified when entering the trap information.

Trap Data
SNMP traps provide data that are derivations of SL500 log entries, such as:

■ Severity, such as error, warning, information

■ Result codes, such as 0000 = success, 5010 = robot excessive posn error

■ Activity string, such as CLI version print)

■ A descriptive text string

Other information might include:

■ Date and time

■ Device address associated with the event

■ User name associated with the activity, such as advsrv

■ The interface-specific request identifier, such as HLI000001

TABLE A-4 Trap/Notification Levels 

Trap Level  Number Description

Error 1 Error/System Log entries

Warning 2 Warning Log entries
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Severity Codes
SMNP traps are grouped into the categories listed in TABLE A-5. Other categories might 
be added in the future.

Configuration - Using CLI
Work with the customer’s system administrators to obtain the information they require, 
make the necessary entries, and then enable SNMP. 

TABLE A-5 Trap Severity Codes

Group Type Summary Description

Category 1 Error Errors critical to library 
operation. Provide all 
machine analysis 
information.

Device inoperable refers to the entire 
system. Failure of a sub-unit or redundant 
component is not a Category 1.

Category 2 Warning Conditions that might 
require attention.

Device degraded refers to recoverable 
failures that might allow the system to 
remain in use, but only in a degraded 
mode.

SL500> help snmp 

snmp> addTrapRecipient

trapLevel <trapLevelString>

host <hostName | hostAddr>

version < v2c community communityString> |

v3 name <trapUserName>

   auth <MD5 | SHA>

   authPass <authPassPhrase>

   [priv <DES | AES>  
   privPass <privPassPhrase>] 
   [engineId <engineIdString>]>

where <trapLevelString> is a single digit or a comma separated

list of digits 1,2,3,4,.....or * (see cautionary note below)

and <host Address | hostName> need to be fully qualified.

The engine ID shall be a string of at most 31 hex characters,

preceded with 0x. NOTE: ‘community’ is a reserved word and 

can not be used for input strings.
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snmp> addUser

version <v2c community <communityString>

|

v3 name set <UserName>

   auth <MD5 | SHA>

   authPass <authPassPhrase>

   [priv <DES |AES>

   privPass <privPassPhrase>]

NOTE: ‘community’ is a reserved word and can not be used for 
input strings.

snmp> deleteTrapRecipient

<id <index>

  |

  host <hostName | hostAddr>

  version <v2c community <communityString>

          |

         v3 name <trapUserName>>>

NOTE: ‘community’ is a reserved word and can not be used for 
input strings. The <hostAddress|hostName> must be fully 
qualified.

snmp> deleteUser

<id <index> 
 | 
version < 
        v2c community <communityString> 
        |v3 name <userName>>>

NOTE: ‘community’ is a reserved word and can not be used for 
input strings.

snmp> disable port<port ID>

disable SNMP for <portID>

snmp> enable port<port ID>

enable SNMP for <portID>

where <portID> is 1A | 1B | 2A | 2B

NOTE: port 2A is the private interface 
      port 2B is the public interface

Author’s note: 
Ports 2A/2B are public access ports; Port 2A is 
currently inactive. 
Ports 1A/1B are private ports and are not used by 
customers.
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The embedded SNMP agent can distinguish trap recipients (based upon the trap 
numbers for which they register) and filter the traps for which they listen.

Entries must be made exactly as displayed within the CLI SNMP screens. As an 
example, an entry of authpass instead of authPass will result in a parsing error.

Configuration Sequence
To configure SNMP, the following steps must be performed:

1. Have the administrator retrieve the MIB from the library controller card. 

This is done through StorageTek Library Console, using the Transfer File Function (see 
“Copying the MIB Text File” on page 206).

2. Obtain the trap/notification destinations from the administrator:

■ IP address of the hosts receiving the traps

■ EngineId of the hosts receiving the traps (if using SNMP v3)

■ Authentication protocol/authPassPhrase (MD5 or SHA /  
auth PassPhrase string) for users / hosts receiving traps (if using SNMP v3)

■ Authentication privacy protocol/Privacy PassPhrase (DES or AES / PrivPassphrase 
string) for users / hosts receiving the traps (if using SNMP v3)

■ User names / hosts receiving the traps (if using SNMP v3)

3. Login to the CLI with the service user ID.

4. Add users (SNMP> addUser command)

5. Configure trap recipients (SNMP> addTrapRecipient command)

6. Double check the information was entered correctly  
(SNMP> listTrapRecipients and listUsers commands)

7. Enable the agent (SNMP> enable port<portID> command)

8. SNMP traps are now enabled and the agent can respond to gets from the clients.

Adding a Trap Recipient
A CLI entry for SNMP Version 2c (no proprietary safeguards) to monitor for error 
conditions (machine inoperable) and warnings for a library would be:

SL500> snmp addTrapRecipient trapLevel 1,2,3 host 192.168.85.81 version v2c 
community public

snmp> listTrapRecipients

snmp> listUsers

COMPLETED

Note – Use of “*” allows all levels to be trapped.
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A CLI entry for the same error conditions, but within the secure SNMP Version 3 
protocol, at an IP address of 129.168.1.1.162, using a security name of stkTrapV3, the 
mixed level of security, with SHA authentication, and DES encryption would be:

SL500> snmp addTrapRecipient trapLevel 1,2,3 host 192.168.1.1 version v3 name 
stkTrapV3 auth SHA authPass SHAPassPhrase priv DES privPass privPassPhrase 
engineId 0x12345678901234567890

Note – The engineId is required on v3 traps.

Adding a User
Adding an SNMP Version 2c user to a public community string would be:

SL500> snmp addUser version v2c community public

Adding a user with a security name of stkAgentV3, the mixed level of security, MD5 
authentication and DES encryption would be:

SL500> snmp addUser version v3 name stkAgentV3 auth MD5 authPass 
MD5PassPhrase priv DES privPass DESPassPhrase

Deleting a Trap Recipient
Deleting an SNMP Version 2c user (uniquely identified by the recipient’s host) from a 
public community string would be:

SL500> snmp deleteTrapRecipient host 192.168.1.1 version v2c community public

Deleting an SNMP Version 3 trap recipient of the same type, but with a trap user name 
would be:

SL500> snmp deleteTrapRecipient host 192.168.1.1 version v3 name stkAgentV3

Note – Recipients can be deleted by Id.
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Deleting a User
Deleting an SNMP v2c named user would be:

SL500> snmp deleteUser host 192.168.1.1 version v2c community public

Deleting an SNMP v3 user would be:

SL500> snmp deleteUser host 192.168.1.1 version v3 name stkUserV3

Note – Users can be deleted by Id.

Configuration - Using Library Console

Note – SL500 library firmware must be version 1067 or higher.  
StorageTek Library Console software must be version FRS_2.95 or higher.

TABLE A-3 lists menu options for configuring SNMP using StorageTek Library Console.

TABLE A-6 SNMP Menu Options

Select Tab To

SNMP > General View details of the SNMP users and trap recipients. 

SNMP > Add Users Set up SNMP users.

SNMP > Delete Users Delete SNMP users 

SNMP > Add Trap Recipients Set up trap recipients

SNMP > Delete Trap Recipients Delete trap recipients

SNMP > Port Control Set up port ID 
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Adding an SNMP User
To add an SNMP user

1. Select Tools > System Details > SNMP.

2. Select the Library folder from the device tree. 

3. Select SNMP > Add Users and enter the following details:

4. Select the Apply tab at the top right corner of the screen.

The indexed SNMP users list is displayed at the bottom of the screen. There can be a 
maximum of 20 users.

Access Control

SNMPV2c community strings can provide a form of access control in SNMP. Because of 
this, the StorageTek embedded agent will not allow community strings to make 
changes to the library's configuration.

The MIB can be retrieved with either SNMPv2c or SNMPv3; however, because SNMPv3 
provides encryption capabilities and a stronger user identification, library properties 
can be changed only with the SNMPv3 set command.

Using an administrative password also provides access control and authorization for 
set command operations.

Traps, however, can be sent to recipients using either SNMPv2c or SNMPv3 by adding 
entries to the Trap Recipient List.

TABLE A-7 SNMP User Details

Field Description

Version Version of the SNMP standard (SNMPv2c or SNMPv3).

Community (v2c only) Applications use community strings for access control. The manager includes the 
community string in its SNMP messages to an agent. The agent consequently can 
accept or reject the operation. This can be a maximum of 31 alphanumeric characters.

UserName (v3 only) SNMP user ID.

Auth (v3 only) Authentication protocol type (MD5 or SHA) string for users and hosts receiving 
traps. One of the two primary SNMPv3 security protocols designed to reliably 
identify the integrity of the originating party.

AuthPass (v3 only) Authentication password of the user.

Priv (v3 only) Privacy protocol type (DES or AES): The other two primary SNMPv3 security 
protocols are designed to protect information 

PrivPass (v3 only) Encryption password that is the private key for encryption.
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Trap Level 

SNMP traps provide data that are a source of log entries, containing:

■ Severity (indications such as error or warning)

■ Result codes

■ Activity string

■ A descriptive text string

■ Date and time

■ Other information might include:

■ Device address associated with the event

■ User name associated with the activity

■ The interface-specific request identifier

Trap levels are generally filtered to include only those traps that you wish to monitor. 
These levels are specified when entering the trap information.

Note – You can also set combinations of trap levels. For example, "1,2", "1,11", "1,2,11").

Deleting a Trap Recipient
To delete a trap recipient

1. Select Tools > System Details > SNMP.

2. Select the Library folder from the device tree. 

3. Select SNMP > Delete Trap Recipients.

4. Enter the Index number of the trap recipient from the list.

5. Select the Apply tab at the top right corner of the screen. 

Verify the trap recipients list and make sure that the trap is deleted. 

TABLE A-8 Trap Levels

Trap Level Number Description

Error 1 Error/System Log entries. Errors critical to library 
operation. For example, Device inoperable: refers to 
the entire system. Failure of a redundant component is 
not a Category 1.

Warning 2 Warning Log entries. Conditions that require attention. 
For example, Device degraded: Refers to recoverable 
failures that may allow the system to remain in use, 
but only in a degraded mode.

11 11 SNMP Agent Start Up
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Setting up Port Control
To set up port control

1. Select Tools > System Details > SNMP.

2. Select the Library folder from the device tree. 

3. Select SNMP > Port Control.

4. Enter the following information.

5. Select the Apply tab at the top right corner of the screen. 

Typically, SNMP uses user datagram protocol (UDP) ports:

■ 161 for the agent

■ 162 for the manager

UDP, like TCP, runs on top of IP networks and is one of the core protocols in the 
Internet protocol suite. UDP allows networked-based devices to send short messages 
faster and more efficiently for many lightweight and time-sensitive applications.

The basic protocol for communications between manager and agent is:

■ The manager can send requests from any available port to the agent at port 161. The 
agent then responds to that source port, to the requesting manager.

■ The agent generates traps or notifications and sends them from any available port to 
the manager at port 162.

TABLE A-9 Port Control Details

Trap Level Description

Port Select the Port. Port 1B is the public access port; other 
ports are unavailable for SL500.

Command Disable: Default. Agent trap requests are sent/received 
on the LAN port:
Enable: SNMP traps are enabled and the agent 
responds to gets from the clients.
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Ethernet
DNS, 203
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SNMP, 201
etiqueta de los productos de láser, xxii
etiqueta, productos de láser, xxii
event log, 87

clearing, 88
types, 87

event monitoring, StorageTek Library Console, 30
events

communication, 87
error, 87
warning, 88

F
FAULT indicator, 43
fault isolation log entries, 88
fault isolation questions, library faults, 47
fault symptom codes, 87
fiber-optic cables

connectors, xxvii
handling, xxviii
installating, xxvii

Fibre Channel troubleshooting, 5
firmware

download, 77
event logging, 87

FRU faults, 48

G
grace period, SNMP, 204
grounding

for safety, xvii
kit, xxv
procedures, xxvi

H
hand safety, xviii
hardware activation, for features, 58
hyperterminal, protocol setup, 55

I
indicator

ACTIVE, 43
EJECT OK, 43
FAULT, 43
Library Active, 45
Open CAP, 45
Open Door, 45
Service Required, 45
Service Robot, 45
STANDBY, 43

indicators
keypad, 43
RLC card, 43

information (3) log severity level, 50

initialization sequence, 197
installing

fiber-optic cables, xxvii
interface, Fibre Channel troubleshooting, 5
interface, SCSI troubleshooting, 4

K
keypad buttons and indicators, 44
kit, grounding, xxv
known service plan (KSP), 87

L
label, laser product, xxi
laser product label, xxi
Library Active indicator, 45
library, capacity, 37, 214, 216, 217
lifting procedures, xviii
lifting safety, xviii
loading firmware

putty and pscp, 83
StorageTek Library Console, 78

logs
fault isolation, 88
severity levels, 50

M
Management Information Base. See MIB
MIB

described
hierarchy, illustrated, 205

monitoring events, StorageTek Library Console, 30
montaje en bastidor

seguridad, xxiv

N
network, SNMP, 201
non-diagnostic operations, information, 65

P
part number, StorageTek Library Console CD, 14
password, activation, 9
power

measuring line voltage, 3
troubleshooting, 2

power supply indicators, 43
precaución

precauciones de seguridad, xix
precauciones

seguridad, xix
precautions

ESD, xxv
handling fiber-optic cables, xxviii
rack-mounting, xxviii
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safety, xvii
prevent ESD, xxv
procedimientos de levantamiento, xx
puesta a tierra

por seguridad, xix
putty and pscp, loading firmware, 83

R
rack-mounting

precautions, xxviii
safety, xxiii

reports, StorageTek Library Console, 26
result codes, 87
result codes list, 92
RLC card indicators, 43
robotic functions tested, 53

S
safety

arm, xviii
fiber optics, xxi
general, xvii
grounding, xvii
laser product label, xxi
lifting, xviii
rack-mounting, xxiii

SCSI troubleshooting, 4
seguridad

al levantar, xx
brazo, xx
de las manos, xx
de las muñecas, xx
de los brazos, xx
de los codos, xx
de los hombros, xx
etiqueta de los productos de láser, xxii
fibras ópticas, xxii
general, xix
levantar, xx
montaje en bastidor, xxiv
puesta a tierra, xix

self tests, StorageTek Library Console, 41
Service Required indicator, 45
Service Robot indicator, 45
shoulder safety, xviii
SNMP, 210

access control, 204
commands, 204
configuration, 210
configuration (through CLI port), 210
grace period, 204
operation, 201

Solaris, loading StorageTek Library Console, 14
STANDBY indicator, 43

StorageTek Library Console
auditing the library, 34
auto clean, 36
cartridges through CAP, 38
CD part number, 14
cleaning cartridges, 37
configuring SNMP, 214
copying MIB text file, 206
installing, 14
loading firmware, 78
logging on, 19
monitoring events, 30
performing self tests, 41
reports, 26
requesting activation password, 9
reviewing system detail information, 20
tape drives, 37
transferring files from RLC, 40
troubleshooting, 7

T
tape drives, troubleshooting, 6
troubleshooting

Fibre Channel, 5
power, 2
SCSI, 4
StorageTek Library Console, 7
tape drives, 6

W
warning

eye hazard from laser, xxi, xxii
installaing rack equipment in library, xxiii
radiation from laser, xxi

warning (2) log severity level, 50
warning events, 88
warnings

measuring line voltage, 3
Web sites, list, xv
Windows, loading StorageTek Library Console, 14
wrist safety, xviii
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